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About the book

At a Glance

Document Scope This user manual is intended to help you create a user program with Concept. It 
provides authoritative information on the individual program languages and on 
hardware configuration.

Validity Note The documentation applies to Concept 2.5 for Microsoft Windows 98, Microsoft 
Windows 2000 and Microsoft Windows NT 4.x.

Related 
Documents

User Comments We welcome your comments about this document. You can reach us by e-mail at 
TECHCOMM@modicon.com

Note: Additional up-to-date tips can be found in the Concept README file.

Title of Documentation Reference Number

Concept Installation Instructions 840 USE 492 00

Concept IEC Block Library 840 USE 494 00

Concept EFB User Manual 840 USE 495 00

Concept LL984 Block Library 840 USE 496 00
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Appendices

At a Glance

Overview Additional information that is not necessarily required for an understanding of the 
documentation.

What’s in this 
appendix?

The appendix contains the following chapters:

Chapter Chaptername Page

A Tables of PLC-dependent Performance Attributes 639

B Windows interface 659

C List of symbols and short cut keys 679

D IEC conformity 707

E Configuration examples 733

F Convert Projects/DFBs/Macros 837

G Concept ModConnect 841

H Convertion of Modsoft Programs 849

I Modsoft and 984 References 855

J Presettings when using Modbus Plus for startup 859

K Presettings when using Modbus for startup 873

L Startup when using Modbus with the EXECLoader 879

M Startup when using Modbus with DOS Loader 899

N Startup when using Modbus Plus with the EXECLoader 913

O Startup when using Modbus Plus with DOS Loader 933

P EXEC files 949

Q Settings in the CONCEPT.INI 953
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A
Tables of PLC-dependent 
Performance Attributes

Introduction

Overview The performance attributes of the different hardware platforms (Quantum, Compact, 
Momentum and Atrium) can be found in the following tables.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Performance of Quantum 640

Performance Attributes of Compact 645

Performance Attributes of Momentum 649

Performance Attributes of Atrium 653
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Performance of Quantum

IEC and LL984 
Support

Availability of IEC and LL984 support:

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

LL984 only x - - - - -

IEC only (Stripped Exec) x x x - - -

IEC and LL984 - x x x x x

x = available
- = not available
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Special 
Performance 
Attributes

Availability of special performance attributes:

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

LL984 Hot Standby x x x x x x

IEC Hot Standby - - - - x x

Interrupt processing with 
HLI (LL984 only)

x x x x x x

Split memory (LL984 only 
with separate software

- - - - - -

Support for XMIT 
loadable (LL984 only)

x x x x x x

Support for XMIT EFB 
(IEC only)

- - - - - -

Support for XXMIT EFB 
(IEC only)

x x x x x x

Upload of the user 
program

x x x x x x

Support of the Modbus 
function codes 42 (IEC 
only)

x x x x x x

Password protection of 
connection structure with 
PLC

- - - - - -

PCMCIA support - - - - - -

Flash memory for 
program and 
configuration

- - - - x x

Remote Terminal Unit 
(RTU) configuration 
extension

- - - - - -

Profibus DP configuration 
extension

x x x x x x

Cyclical data exchange 
for configuration 
extension

x x x x x x

Code generation options: 
Include diagnosis 
information

x x x x x x
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Buses Availability of the buses:

Code generation options: 
Fastest code

- - x x x x

MMS Ethernet 
configuration extension

x x x x x x

ASCII Messages x x x x x x

Peer Cop x x x x x x

RIO (Remote I/O) x x x x x x

DIO (Distributed I/O) x x x x x x

SYMAX I/O x x x x x x

800 I/O x x x x x x

LonWorks x x x x x x

A120 I/O - - - - - -

x = available
- = not available

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

Modbus x x x x x x

Modbus Plus x x x x x x

Ethernet (TCP/IP) x x x x x x

Ethernet (SY/MAX) x x x x x x

Interbus x x x x x x

Interbus: PCP loadable 
(LL984 only)

x x x x x x

Interbus: PCP-EFB (IEC 
only)

x x x x - -

LonWorks (Echelon) using 
NOA 
611 xx 
and 
LL984

using 
NOA 
611 xx 
and 
LL984

using 
NOA 
611 xx 
and 
LL984

using 
NOA 611 
xx and 
LL984

using 
NOA 611 
xx and 
LL984

using 
NOA 611 
xx and 
LL984

MVB (MultiVehicleBus) - - - - - -

x = available
- = not available
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Block Libraries Availability of the block libraries:

Utilities Availability of utilities:

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

AKFEFB (IEC only) x x x x x x

ANA_IO (IEC only) x x x x x x

COMM (IEC only) x x x x x x

CONT_CTL (IEC only) x x x x x x

DIAGNO (IEC only) x x x x x x

EXPERTS (IEC only) x x x x x x

EXTENDED (IEC only) x x x x x x

FUZZY (IEC only) x x x x x x

HANDTABLEAU (IEC 
only)

x x x x x x

IEC (IEC only x x x x x x

LIB984 (IEC only) x x x x x x

SYSTEM (IEC only) x x x x x x

LL984 (LL984 only) x x x x x x

x = available
- = not available

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

Concept DFB x x x x x x

Concept EFB x x x x x x

Concept SIM x x x x x x

Concept PLCSIM32 x x x x x x

Concept security x x x x x x

Concept EXECLoader x x x x x x

Concept-Converter x x x x x x

Modsoft converter x x x x x x

ModConnect tool x x x x x x

x = available
- = not available
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Runtime System Runtime System

Available 
Memory for User 
Program

Available memory for user program

Different 
Performance 
Attributes

Availability of different performance attributes:

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

16 bit CPU x x x x - -

32 bit CPU - - - - x x

x = available
- = not available

Performance
CPU type

113 02 113 03 213 04 424 0x 434 12 534 14

IEC only runtime system 125k 375k 612k - - -

IEC and LL984 runtime 
system

- 160k 330k 460k 800k 2500k

LL984 only runtime 
system

- - - - - -

x = available
- = not available

Performance
CPU type

113 02 113 03 213 04 424 0x 534 14 534 14

Battery adapter required 
for backing up IEC 
programs

- - - - - -

Floating point processor - - x x x x

Floating point emulation 
(IEC)

x x - - - -

x = available
- = not available
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Performance Attributes of Compact

IEC and LL984 
Support

Availability of IEC and LL984 support:

Special 
Performance 
Attributes

Availability of special performance attributes:

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

LL984 only - - - -

IEC only (Stripped Exec) - - - -

IEC and LL984 x x x x

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

LL984 Hot Standby - - - -

IEC Hot Standby - - - -

Interrupt processing with HLI 
(LL984 only)

- - - -

Split memory (LL984 only with 
separate software

x x x x

Support for XMIT loadable 
(LL984 only)

x x x x

Support for XMIT EFB (IEC 
only)

- - - -

Support for XXMIT EFB (IEC 
only)

x x x x

Upload of the user program x x x x

Support of Modbus function 
code 42 (IEC only)

x x x x

Password protection of 
connection structure with PLC

x x x x

PCMCIA support - - x x

Flash memory for program and 
configuration

x x x x

Remote Terminal Unit (RTU) 
configuration extension

x x x x
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Buses Availability of the buses:

Profibus DP configuration 
extension

- - - -

Cyclical data exchange for 
configuration extension

- - - -

Code generation options: 
Include diagnosis information

x x x x

Code generation options: 
Fastest code

x x x x

MMS Ethernet configuration 
extension

- - - -

ASCII Messages - - - -

Peer Cop - x x x

RIO (Remote I/O) - - - -

DIO (Distributed I/O) - - - -

SYMAX I/O - - - -

800 I/O - - - -

LonWorks - - - -

A120 I/O x x x x

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Modbus x x x x

Modbus Plus using 
BridgeModul
e

x x x

Ethernet (TCP/IP) using 
BridgeModul
e

using 
BridgeModul
e

using 
BridgeMod
ule

using 
BridgeModul
e

Ethernet (SY/MAX) - - - -

Interbus using BKF 
xxx

using BKF 
xxx

using BKF 
xxx

using BKF 
xxx
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Block Libraries Availability of block libraries:

Utilities Availability of utilities:

Interbus: PCP loadable (LL984 
only)

- - - -

Interbus: PCP-EFB (IEC only) - - - -

LonWorks (Echelon) - - - -

MVB (MultiVehicleBus) x x x x

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

AKFEFB (IEC only) x x x x

ANA_IO (IEC only) x x x x

COMM (IEC only) - x x x

CONT_CTL (IEC only) x x x x

DIAGNO (IEC only) x x x x

EXPERTS (IEC only) x x x x

EXTENDED (IEC only) x x x x

FUZZY (IEC only) x x x x

HANDTABLEAU (IEC only) x x x x

IEC (IEC only) x x x x

LIB984 (IEC only) x x x x

SYSTEM (IEC only) x x x x

LL984 (LL984 only) x x x x

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Concept DFB x x x x

Concept EFB x x x x

Concept SIM x x x x
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Runtime System Runtime system

Different 
Performance 
Attributes

Availability of different performance attributes:

Concept PLCSIM32 x x x x

Concept Security x x x x

Concept EXECLoader x x x x

Concept-Converter x x x x

Modsoft converter x x x x

Concept-ModConnect - - - -

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

16 bit CPU - - - -

32 bit CPU x x x x

x = available
- = not available

Performance
CPU type

258 (512k) 265 (512k) 275 (512k) 285 (1M)

Battery adapter required for 
backing up IEC programs

- - - -

Floating point processing - - - -

Floating point emulation x x x x

x = available
- = not available
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Performance Attributes of Momentum

IEC and LL984 
Support

Availability of IEC and LL984 support:

Special 
Performance 
Attributes

Availability of special performance attributes:

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

LL984 only x x x x x

IEC only - x x - x

IEC and LL984 - - - - -

x = available
- = not available

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

LL984 Hot Standby - - - - -

IEC Hot Standby - - - - -

Interrupt processing with HLI 
(LL984 only)

- - - - -

Split memory (LL984 only with 
separate software

- - - - -

Support for the XMIT blocks 
(LL984 only)

x x x x x

Support for XMIT EFB (IEC 
only)

- - - - -

Support for XXMIT EFB (IEC 
only)

x x x x x

Upload of the user program x x x x x

Support of Modbus function 
code 42 (IEC only)

- x x - x

Password protection of 
connection structure with PLC

- - - x x

PCMCIA support - - - - -
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Flash memory for program and 
configuration (LL984)

x x x x x

Flash memory for program and 
configuration (IEC)

- - x - x

Remote Terminal Unit (RTU) 
configuration extension

- - - - -

Profibus DP configuration 
extension

- - - - -

Cyclical data exchange for 
configuration extension

- - - - -

Code generation options: 
Include diagnosis information

- - - - -

Code generation options: 
Fastest code

- - - - -

MMS Ethernet configuration 
extension

- - - - -

ASCII Messages - - - - -

Peer Cop x x x x x

RIO (Remote I/O) - - - - -

DIO (Distributed I/O) - - - - -

TIO (Terminal I/O x x x x x

SYMAX I/O - - - - -

800 I/O - - - - -

LonWorks - - - - -

A120 I/O - - - - -

x = available
- = not available

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30
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Buses Availability of the buses:

Block Libraries Availability of the block libraries:

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

Modbus (with ring card) x x x x x

Modbus Plus (with ring card) x x x x x

Ethernet (TCP/IP) - - - x (LL984 
only)

x

Ethernet (SY/MAX) - - - - -

Interbus x x x x x

Interbus: PCP loadable (LL984 
only)

- - - - -

Interbus: PCP-EFB (IEC only) - - - - -

LonWorks (Echelon) - - - - -

MVB (MultiVehicleBus) - - - - -

x = available
- = not available

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

AKFEFB (IEC only) - x x - x

ANA_IO (IEC only) - x x - x

COMM (IEC only) - - - - x

CONT_CTL (IEC only) - x x - x

DIAGNO (IEC only) - x x - x

EXPERTS (IEC only) - - - - x

EXTENDED (IEC only) - x x - x

FUZZY (IEC only) - x x - x

HANDTABLEAU (IEC only) - - - - x

IEC (IEC only) - x x - x

LIB984 (IEC only) - x x - x

SYSTEM (IEC only) - x x - x
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Utilities Availability of utilities:

Runtime System Runtime System

LL984 (LL984 only) x x x x x

x = available
- = not available

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

Concept DFB - x x - x

Concept EFB - x x - x

Concept SIM - x x - x

Concept PLCSIM32 - x x - x

Concept security - x x - x

Concept EXECLoader x x x x x

Concept-Converter x x x x x

Modsoft converter x x x x x

Concept-ModConnect x x x x x

x = available
- = not available

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

16 bit CPU x x x x x

32 bit CPU - - - - -

x = available
- = not available
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Different 
Performance 
Attributes

Availability of different performance attributes:

Performance Attributes of Atrium

IEC and LL984 
Support

Availability of IEC and LL984 support:

Performance
CPU type

700 00
700 10
780 00

760 00 760 10
780 10

960 20
980 20

960 30
980 30

Battery adapter required for 
backing up IEC programs

- x - - -

Floating point processor - - - - -

Floating point emulation (IEC) - x x - x

x = available
- = not available

Performance
CPU type

121 01 (2M)
241 01 (4M)
241 01-S908 (4M)

LL984 only -

IEC only (Stripped Exec) -

IEC and LL984 x

x = available
- = not available
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Special 
Performance 
Attributes

Availability of special performance attributes:

Performance
CPU type

121 01 (2M)
241 01 (4M)
241 01-S908 (4M)

LL984 Hot Standby -

IEC Hot Standby -

Interrupt processing with HLI (LL984 only) -

Split memory (LL984 only with separate software -

Support for XMIT loadable (LL984 only) -

Support for XMIT EFB (IEC only) -

Support for XXMIT EFB (IEC only) 121 01 (2M): -
241 01 (4M): x
241 01-S908 (4M): -

Upload of the user program x

Support of Modbus function code 42 (IEC only) x

Password protection of connection structure with PLC -

PCMCIA support -

Flash memory for program and configuration -

Remote Terminal Unit (RTU) configuration extension -

Profibus DP configuration extension -

Cyclical data exchange for configuration extension -

Code generation options: Include diagnosis information -

Code generation options: Fastest code -

MMS Ethernet configuration extension -

ASCII Messages -

Peer Cop x

RIO (Remote I/O) -

DIO (Distributed I/O) x

SYMAX I/O -

800 I/O -

LonWorks -

A120 I/O -

x = available
- = not available
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Buses Availability of the buses:

Block Libraries Availability of block libraries:

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

Modbus -

Modbus Plus x

Ethernet (TCP/IP) -

Ethernet (SY/MAX) -

Interbus x
x
-

Interbus: PCP loadable (LL984 only) -

Interbus: PCP-EFB (IEC only) -

S908 I/O Bus -
-
x

LonWorks (Echelon) -

MVB (MultiVehicleBus) -

x = available
- = not available

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

AKFEFB (IEC only) x

ANA_IO (IEC only) x

COMM (IEC only) -

CONT_CTL (IEC only) x

DIAGNO (IEC only) x

EXPERTS (IEC only) x

EXTENDED (IEC only) x

FUZZY (IEC only) x

HANDTABLEAU (IEC only) x

IEC (IEC only) x
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Utilities Availability of utilities:

Runtime System Runtime system

LIB984 (IEC only) x

SYSTEM (IEC only) x

LL984 (LL984 only) x

x = available
- = not available

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

Concept DFB x

Concept EFB x

Concept SIM x

Concept PLCSIM32 x

Concept Security x

Concept EXECLoader x

Concept-Converter x

Modsoft converter x

Concept-ModConnect -

x = available
- = not available

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

16 bit CPU -

32 bit CPU x

x = available
- = not available
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Different 
Performance 
Attributes

Availability of different performance attributes:

Performance
CPU type

121 01 (2M)
241 01 (2M)
241 01-S908 (4M)

Battery adapter required for backing up IEC programs -

Floating point processor -
x
x

Floating point emulation x
-
-

x = available
- = not available
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B
Windows interface

At a Glance

Overview The chapter describes the most important properties of Concept’s Windows 
interface. Further information can be found in the Microsoft Windows manuals.

What’s in this 
chapter?

This chapter contains the following Sections:

Section Topic Page

B.1 Window 661

B.2 Menu commands 666

B.3 Dialog boxes 668

B.4 Generating a project symbol 671

B.5 Online help 673
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B.1 Window

At a Glance

Overview This section describes the types of windows and window elements in Windows.

What’s in this 
section?

This section contains the following topics:

Topic Page

Window Types 662

Elements of a window 663
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Window Types

Introduction In Windows there are two types of windows:
l Application Window
l Document Window
Types of window: 

Application 
Window

When Concept is started the application window is opened on your desktop. The 
application window can be moved to any position on the desktop. Alternatively it can 
be minimized to a button on the task bar.

A project can be opened or created in this application window. The name of the 
project then appears in the title bar of the application window.

Concept [TESTPRJ]

File View Objects Project Online Options Window HelpEdit

- Step sets ACT1, ACT1 is mapped to I/O but not read by any logic. Has a delay time of 2 sec. NOT CONNECTED.

PLC configuration

PLC Selection
PLC Memory Partition
Loadables
Specials
Config. Extensions
I/O Map
Segment Scheduler
Modbus port settings
ASCII

Dialog to be opened Help

Type:

PLC

Disable IEC library
140 CPU 113 02 Available Logic Area;

Coils:

PLC Memory Partition

Discrete Inputs:
000001 - 001536

Input words:
Output/marker words:

100001 - 101872
300001 - 300512
400001 - 401872

Battery coil:

Specials

Timer Register:
..

Time of day:
..

..

Data protection:

Config. Extensions

Peer Cop:
Disable

Hot Standby:
Ethernet:
Profibus DP:

Disable
Disable
0
0

Number installed:

Loadables

0

Segments:

Segment Scheduler

32

Number of messages:

ASCII

Message Area Size:
0

Number of ports:
0
0

8191

SFC

1

2

3

4

5

6

7

1 2 3 4 5 6 7 8

S_SFC_0001

S_SFC_0002

S_SFC_0003

S_SFC_0004

S_SFC_0102

S_SFC_0103

S_SFC_0104

S_SFC_0103

S_SFC_0104

S_SFC_0302

T3

T2

T1

T7

T6

T8

T9

Application window (project)

Document window (PLC configuration, section)
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Document 
Window

After opening or creating a project you can open different document windows. 
Document windows are, for example, sections in which a user program is created or 
the document window of the PLC configuration.

Several document windows can be open simultaneously, but only one of these can 
be active. An active document window can be recognized by the color of the title bar. 

Depending on the active document window the menu commands change in the pull 
down menus and the tool bar of the application window.

Elements of a window

At a Glance This section describes the Concept specific elements of a window.
Elements of a window: 

Concept [TESTPRJ]

File View Objects Project Online Options Window HelpEdit

- Step sets ACT1, ACT1 is mapped to I/O but not read by any logic. Has a delay time of 2 sec. NOT CONNECTED.

FBD

.1.1 (1)

AND_BOOL

LampTest2
LampTest1

.1.4 (4)

OR_BOOL

%0:00017

.1.5 (5)

OR_BOOL

%0:00018

.1.6 (6)

OR_BOOL

%0:00019

.1.7 (7)

OR_BOOL

%0:00020

.1.8 (8)

OR_BOOL

%0:00021

FBI 1 2 (3)

LIGHTS

S
01
02
03
04
05

.1.3 (2)

AND_BOOL

ACT4
Manual1

SFC

1

2

3

4

5

6

7

1 2 3 4 5 6 7 8

S_SFC_0001

S_SFC_0002

S_SFC_0003

S_SFC_0004

S_SFC_0102

S_SFC_0103

S_SFC_0104

S_SFC_0103

S_SFC_0104

S_SFC_0302

T3

T2

T1

T7

T6

T8

T9

Toolbar

Status bar

Menu bar Title bar (project) Title bar (section)
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Title bar A project’s title bar shows the name of the active application (i.e. Concept) and the 
name of the project. When coupled with a PLC the node address of the PLC is 
indicated in angled brackets (<>). If this PLC is on another network the routing path 
is also indicated.

If a document window (e.g. a section) is enlarged to full screen, i.e. the section takes 
up the entire application window, the name of the document window (e.g. the section 
name) appears in the title bar.

Document windows which are not enlarged to full screen have their own title bar in 
which the name of the document window is indicated.

Menu Bar The menu bar of the application window contains various main menus. The contents 
of the menu bar depend on the active document window.

Toolbar The toolbar consists of buttons which correspond to a menu command on the pull-
down menus. The range and content of the toolbar depend on which window is 
active.

There are three different ways a button can be represented:
l grayed

The command is currently unavailable. One or more other commands must be 
executed before the desired button can be used.

l unpressed
The command can be selected.

l pressed
The command is active.

Status bar The appearance of the status bar depends on whether the project is open and the 
programming language used in the section.

In the first part of the status bar various information is displayed depending on the 
selected object.
l If a dialog box is open or a menu command or button has been selected some 

help will be given about it. To display the help select a menu command or a button 
with the left mouse button and hold it down. A short description of the menu 
command or button appears in the status bar. To execute the menu command/
button release the mouse button. If execution of the menu command/button is not 
required, move the pointer away from the active area (the description in the status 
bar disappears) and then release the mouse button.

l If an FFB, a parameter to an input/output, a step or a transition has been selected, 
a comment about the selected object is displayed. With parameters and 
transitions the assigned direct address (only in case of located variables) is also 
displayed.
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The second part of the status bar (status of the active section) indicates whether the 
section is in animation mode or the section is disabled.
l ANIMATED

The section is animated.
l INHIBITED

The section is inhibited and will not be processed.

The third part of the status bar indicates the status of the PLC.
l NOT CONNECTED.

The programming device is not coupled with a PLC.
l STOPPED

The program on the PLC is suspended.
l RUNNING: CHANGE CONFIG

The program on the PLC is running and was connected with the access Change 
Configuration.

In the fourth part of the status bar the program status between the PLC and 
programming device is displayed. This display only appears if a project is open and 
the programming device with PLC is online.
l EQUAL

The program on the programming device and the PLC is consistent.
l UNEQUAL

The program on the programming device and the PLC is not consistent. To 
establish consistency use the menu command Online → Download....

l MODIFIED
The program on the programming device was modified. The modifications can be 
made online in the PLC with the menu command Online → Download changes.

Status bar: 

T1 AT %1:00001 Transition T1 EQUALANIMATED RUNNING:CHANGE CONFIG
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B.2 Menu commands

Menu commands

At a Glance The titles of the individual menus are displayed in the menu bar. The menu 
commands are listed in the pull-down menus. As in Windows, each Concept window 
and dialog box has a system menu. This menu is opened using the small box in the 
top left-hand corner of the window.

A pull-down menu is opened by left-clicking on the title of the menu. To go directly 
to a menu command, drag the mouse pointer down the menu and then release the 
mouse button.

The menu can be closed by clicking on the title of the menu or anywhere outside of 
the menu.

Typical pull-down menu: 

Underlined letter A main menu (menu title) and subsequently a menu command can be selected by 
holding down Alt and simultaneously entering the underlined letter in the menu title 
and then that of the menu command. If, for instance, from the menu Project you 
want to execute the menu command Search... press Alt+P to open the menu and 
then Alt+S to execute the menu command.

Properties...

PLC Configuration

Project Browser

Execution sequence...
Variable declaration...
ASCII reports...

Search...
Trance
Find Next
Search results...
References used...

Analyze section
Analyze program

Options for code generation...

F8

F3
SHIFT+F3
F6
F5

ALT+F9

Project Online Options Window Help
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Grayed out menu 
command

The command is currently unavailable. One or more other commands must be 
executed before the desired menu command can be executed.

Suspension 
points (…) after 
the menu 
command

On execution of this menu command a dialog box appears with options, which must 
be selected before execution.

Check mark (√) 
before the menu 
command

The menu command is active. If the menu command is selected the check mark 
disappears and the menu command is inactive. The check mark is mostly used to 
identify active modes (e.g. normal display, dial in mode etc.).

Shortcut keys The key combinations (e.g. F8, Alt+F9, Ctrl+R) after the menu command are 
shortcut keys for executing this menu command. Using this key or key combination 
the menu command can be selected, without having to open the menu.
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B.3 Dialog boxes

Dialog boxes

At a Glance In Concept dialog boxes are displayed if additional information is required from you 
in order to perform a particular task. Potentially necessary information is also 
communicated in this way.

Most dialog boxes contain options which can be selected, textboxes, in which text 
can be entered, and buttons which can be pressed.

Grayed out options are currently not available. One or more other commands must 
be executed, or options selected or deselected, before the desired option can be 
activated.

Concept specific basics of a window: 

Step properties

Cancel HelpOK

S_3_5 Comment…Initial stepStep name

Action

Time
LiteralVariableCdet:

None

Action
Variable Direct address

Look up Variable declaration Authorize section

Accept

New

Delete

Up

Down

Mon. times and delay time
Literals’SCFSTEP_TIMES’ variable

Maximum

Delay

Minimum

To selected variable…

ACT5

None ACT5

t#2S

One line list List Control box

Text box Option button Command button
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Command 
buttons

Command buttons are used to initiate actions immediately, e.g. executing or 
aborting a command. Command buttons include e.g. OK, Abort and Help.

Command buttons followed by suspension points (…), open a further dialog box. A 
command button with a "greater than" sign (>>) extends the active dialog box.

The standard setting is identified by a dark margin. This command button can be 
selected by pressing Enter. 

To close a dialog box without executing a command select the command button 
Cancel.

Text boxes Information (text) is entered into a text box.

If you enter an empty text box an insertion point appears in the far left of the box. 
The entered text begins at this insertion point. If text is already present within the 
respective box, it will be selected and replaced by the new text automatically. The 
text can, however, also be deleted by pressing Delete or Backspace.

Lists In a list the available selection possibilities are listed. If more possibilities are 
available than fit into the list, the scrollbar or the arrow keys can be used to move 
within the list.

As a rule only a single entry can be chosen form the list. There are, however, some 
cases in which several entries can be chosen, e.g. when opening sections.

One line lists A single line list box initially appears as a rectangular box, in which the current 
selection (the default value) is selected. If the arrow in the right of the box is selected, 
a list of the available selection possibilities opens. If more possibilities are available 
than fit into the list, then the scrollbar or arrow keys can be used to move around the 
list.

Option buttons Option buttons represent mutually exclusive options. In each case only one option 
can be chosen.

The selected option button is identified by a black dot.

If the option name contains an underlined letter, the option button can be activated 
from any position in the dialog box by holding down Alt and entering the underlined 
letter.
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Check box A check box next to an option means that the option can be activated or deactivated. 
Any number of check box options can be activated.

Activated options are identified by an X or a check mark (√).

If the option name contains an underlined letter, the check box can be activated or 
deactivated from any position in the dialog box by holding down Alt and entering the 
underlined letter.
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B.4 Generating a project symbol

Generating a project symbol

At a Glance Once a project symbol has been generated, a project can be immediately loaded on 
opening Concept.  In this way one or more program groups can be created, which 
e.g. contain all the projects in a system, allowing them to be started immediately. 

Generating a 
symbol for 
projects

The procedure for generating a project symbol is as follows:

Note: A symbol can only be generated for an existing project. Otherwise an error 
message appears on starting.

Step Action

1 Via Start → Settings → Taskbar... open the dialog Taskbar Properties.

2 In the register Start Menu Programs select the command button Add....

3 In the dialog Create Shortcut select the command button Browse....

4 In the dialog Browse move into the Concept installation path and double-click on 
the file CONCEPT.EXE.

Reaction: The dialog Browse is closed and the file CONCEPT.EXE, with its 
path, is entered in the text box Command line: e.g. 
C:\CONCEPT\CONCEPT.EXE.

5 Now add the project path and project name to the command line, e.g. 
C:\CONCEPT\CONCEPT.EXE C:\PROJECTS\PLANT1.PRJ and confirm the 
details using Next >.

6 In the dialog Program group select an existing program group for the symbol or 
create a new one using New folder.... 
Confirm the change using the command button Next>.

7 In the dialog Select program designation select the project name and confirm 
using the command button Finish.

8 Close the dialog Taskbar Properties using OK.
Reaction: The properties dialog is closed and the project symbol is available in 
the selected folder.

9 Start the project by clicking on the project symbol.
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Generating a 
symbol for DFBs

In this way  symbols can likewise be generated for DFBs. To do this select the file 
CCEPTDFB.EXE in step 4 and add the DFB name and path instead of the project 
name and path to the command line in step 5.
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B.5 Online help

At a Glance

Overview This section describes use of online help.

What’s in this 
section?

This section contains the following topics:

Topic Page

At a Glance 674

How the Online Help is set out 675
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At a Glance

General 
information

The online help is used to quickly and easily obtain information about the task being 
performed, the use of an unfamiliar command or the functions, Function Blocks and 
modules.

The online help is available throughout Concept.

Starting the 
online help

There are several methods of calling up the online help:
l Invoking the contents)

There are two methods of invoking the online help contents:
l To invoke the online help contents, select the menu command Help → 

Contents.
l In the program group Concept open the help symbol.

l Help with the execution of a menu command
There are two methods of invoking help with a menu command:
l using the mouse)

To obtain an explanation select the menu command with the left mouse 
button, hold down the mouse button, press F1, and then release the mouse 
button.

l using the keyboard)
To obtain an explanation of a menu command, select it and then press F1.

l Help with a dialog
There are two methods of invoking help with a dialog:
l To obtain an explanation of a dialog, click on the command button Help in the 

dialog itself.
l To obtain an explanation of a dialog, press F1in the dialog itself.

l Help with operating an EFB
To obtain an explanation of the operation of the EFB, click on the command 
button Help with type within the dialog with the EFB properties.

l Help with the operation of a module
In the dialog I/O module selection click on the command button Help with 
module, to obtain an explanation of the operation of a module.

Note: The option Use polygon acceleration may not be used if the graphics card 
has hardware acceleration functions. Use of these may still lead to the graphics in 
the online help being incomplete. A detailed description of how to switch off the 
acceleration function will be found in the graphics card’s user manual.
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How the Online Help is set out

Introduction If you start the online help, the Windows Help system opens, containing either
l a table of contents (if you started with Help → Contents or the icon), 
l or containing a description of the dialog (if you started with the Help command 

button), 
l or containing a description of an EFB (if you started with the Help on Type 

command button), 
l or containing a description of a module (if you started with the Module Help 

command button),

This section describes the Concept specific basics of the online help window.

Online help window: 

Title Bar The title bar contains the active help file names, or in other words the help project.

Menu Bar A description of the standard menu bar can be found in the respective Microsoft 
Windows manual.

Concept User Manual

Contents 
File Edit Bookmark Options ?

Contents Back Print << >> History

Concept User Manual+

PLC Configuration+

Unconditional Configuration+

I/O Map+

Introduction
In the I/O map configure the drops with the
used modules. Next carry out the I/O addressing and
the parameterization of the configured modules .

Configuring the Backplane Expander
To extend the backplane the module 140 XBE 100 00
is required. This enables you to connect a second backplane
and obtain an additional 13 slots.

A more detailed description of the configuration of the extended
backplane with the 140 XBE 100 00 module can be found in
the chapter Configuring the Backplane Expander.

Title bar

Menu bar

Toolbar

Navigator

Topic title

Popup

Jump

?
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Toolbar The following buttons are available in Concept:
l Contents

This button is used to invoke the online help contents directory. 
Details about this function can be found in the corresponding Windows Manual.
Note: If you jump (See Jump, p. 676) between different help projects and click 
the Contents button, the contents of the invoked help project (rather than the 
current one) is displayed. This is a Microsoft error. The Navigator is available to 
allow you to navigate within the current help project (related topics Navigator, 
p. 676). 

l Index
This button is used to invoke an index for finding help texts.
Details about this function can be found in the corresponding Windows Manual.
Note: If you want to carry out a search of the whole text, press the Index 
command button, select the Search index card, choose the desired search 
function and type in the term you’re looking for.

l Back
This button is used to invoke the previously read help text.

l Print
This button is used to print out the current topic (the current help topic).

l <<
This button is used to "browse" the previous help text. This button is used to read 
the online help like a book. When you have reached the first "page" of the online 
help (contents directory), the button is hidden.

l >>
This button is used to "browse" to the next help text. This button is used to read 
the online help like a book. When you have reached the last "page" of the online 
help, the button is hidden.

l History
When you use this button a window opens which displays all of the help topics 
that are already open.

Title of Topic The topic title refers to the title of a chapter from paper documentation. This topic 
title always remains visible, even if, in the case of long documents, the text is moved 
in the window.

Navigator The Navigator is in the topic title. It serves as a navigator inside the help projects.

Jump A jump can be recognized by the fact it is written in green and is underlined. When 
you click on a jump, the help text corresponding to this key word/ topic appears. 
Jumps correspond to "related topics" entries in paper documents, the pages are 
however removed for your convenience. The invoked help text is then replaced by 
a new help text.
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Popup A popup can be recognized by the fact it is written in green and has a dotted line 
under it. When you click on a popup, the help text corresponding to this key word 
appears. Popups correspond to glossary entries in paper documents, however, the 
pages here are removed for your convenience. To display the text, a popup window 
is opened. This popup window may contain further popups. The popup window is 
cleared by re-clicking on it or pressing any key. This does not replace the present 
help text.
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C
List of symbols and short cut keys

At a Glance

Description Each editor and the PLC configuration have their own list of symbols available. This 
facilitates access to frequently used functions. It is also possible to call up many 
functions with short cut keys instead of menu commands.

What’s in this 
chapter?

This chapter contains the following Sections:

Section Topic Page

C.1 Icon bar 681

C.2 Short cut keys 691



List of symbols and short cut keys

680 840 USE 493 02 May 2001



List of symbols and short cut keys

840 USE 493 02 May 2001 681

C.1 Icon bar

At a Glance

Description This section describes the icon bar icons. In the icon bars there are editor 
independent and editor dependent icons.

What’s in this 
section?

This section contains the following topics:

Topic Page

General icon bar 682

Icon bar in the FBD editor 683

Icon bar in the SFC-Editor 684

Icon bar in the LD editor 686

List of Symbols in the IL and ST Editor 687

List of Symbols in the LL984-Editor 688

Icons in PLC Configuration 689

Toolbar in the RDE Editor 690
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General icon bar

Symbols The table below shows the available symbols and their corresponding menu entry 
commands:

Symbol Menu entry command executed

File → Open...

File → New section... / New DFB section...

File → Section open...

File → Save

Project → Variable declaration...

Project → Search…

Online → Online control...

Online → Download changes...

Edit → Reverse: Delete

Edit → Cut

Edit → Copy

Edit → Insert
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Icon bar in the FBD editor

Symbols The table shows the additional icons available in the FBD editor and the 
corresponding menu entry commands (see also General icon bar, p. 682):

Symbol Menu entry command executed

View → Enlarge

View → Reduce

Objects → Select mode

Objects → Link

Objects → FFB: Last Type

Objects → Invert Input/Output

Objects → Text

Objects → Select FFB...

Online → Animate selection

Online → Animate binary values
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Icon bar in the SFC-Editor

Symbols The table shows the additional icons available in the SFC editor and the 
corresponding menu entry commands (see also General icon bar, p. 682):

Symbol Menu entry command executed

View → Enlarge

View → Reduce

Objects → Selection mode

Objects → Select column structure

Objects → Select row structure

Objects → Step

Objects → Transition

Objects → Parallel branch

Objects → Parallel merge

Objects → Alternative branch

Objects → Alternative merge

Objects → Jump

Objects → Link

Objects → Step transition sequence

Objects → Structured parallel chain

Objects → Structured alternative chain
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Objects → Transition step sequence

Objects → Text

Online → Animation

Online → Animation control command

Symbol Menu entry command executed
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Icon bar in the LD editor

Symbols The table shows the additional symbols available in the LD editor and the 
corresponding menu entry commands (please also refer to the General icon bar, 
p. 682):

Symbol Menu entry command executed

View → Enlarge

View → Reduce

Objects → Select Mode

Objects → Link

Objects → Direct Link

Objects → Vertical Link

Objects → FFB: Last Type

Objects → Invert Input/Output

Objects → Text

Objects → Select FFB...

Objects → Coil

Objects → Coil Negative

Objects → Contact - on

Objects → Contact – off

Online → Animate selection

Online → Animate binary values
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List of Symbols in the IL and ST Editor

Symbols The table shows the additional symbols available in the IL and ST editor and the 
corresponding menu entry commands (see also General icon bar, p. 682):

Symbol Menu Entry Command Executed

Objects → Add FFB

Online → View Selections

Online → Animate binary values
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List of Symbols in the LL984-Editor

Symbols The table shows the additional symbols available in the LL984 editor and the 
corresponding menu entry commands (see also General icon bar, p. 682):

Symbol Menu Entry Command Executed

Objects → Select Mode

Objects → Coil

Objects → Coil - buffered

Objects → Horizontal Link

Objects → Vertical Link

Objects → Contact – N.O.

Objects → Contact – Open.

Objects → Contact – Positive Edge.

Objects → Contact – Negative Edge.

Objects → Instruction: Last Type

Objects → Select instruction...
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Icons in PLC Configuration

Icons The table shows the icons also available in PLC configuration and their allocated 
menu commands (related topics: General icon bar, p. 682):

Icon Executed menu command

PLC configuration → PLC Type...

PLC configuration → Memory Partitions...

PLC configuration → ASCII Setup...

PLC configuration → Loadables...

PLC configuration → Config. Extension...

PLC configuration → Segment scheduler...

PLC configuration → I/O Map...

PLC configuration → Data Access Protection...

PLC configuration → Peer Cop...

PLC configuration → Ethernet / I/O Scanner...

PLC configuration → Hot Standby...

PLC configuration → ASCII Port Settings...

PLC configuration → Modbus Port Settings...

PLC configuration → Specials...
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Toolbar in the RDE Editor

Icons The table shows the icons also available in the RDE Editor and their allocated menu 
commands (see also General icon bar, p. 682):

Icon Executed menu command

Template → New Template...

Template → Open Template...

Template → Save Template

Online → Animate

Online → Download Reference Data

Online → Get CSL

Online → Delete CSL
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C.2 Short cut keys

At a Glance

Description This section describes the available short cut keys. There are editor independent 
and editor dependent short cut keys.

What’s in this 
section?

This section contains the following topics:

Topic Page

General Short Cut Keys 692

Short Cut Keys in the IL, ST and Data Type Editor 693

Short Cut Keys in the FBD and SFC Editor 695

Shortcut keys in the LD-Editor 699

Short Cut Keys in the LL984-Editor 705
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General Short Cut Keys

Short Cut Keys The table shows the short cut keys available and the corresponding menu entry 
command:

Short Cut Keys Menu Entry Command Executed

F1 Calls the context-sensitive online help. Use this key to call up an 
explanation of the menu entry command or dialog chosen. In 
dialogs, this key corresponds to the menu entry command Help.

Ctrl+F4 System menu (for the document window) → Close document 
window

Ctrl+F6 System menu (for the document window) → Next

Ctrl+S Data file → Save project/save DFB

Alt+F4 Data file → Quit the application window (Concept-Application)

F8 Project → Address Declaration...

F3 Project → Search

Shift+F3 Project → Trace

F5 Project → Search results

F6 Project → Advanced search

Alt+F9 Project → Analyze section

Ctrl+P Online → Online-Control...

F9 Online → Trigger single cycle

Ctrl+R Online → Reference Data Editor

Shift+F5 Window → Overlapping

Shift+F4 Window → Adjacent
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Short Cut Keys in the IL, ST and Data Type Editor

Calling up menu 
command 
entries

The table shows the short cut keys available in the IL, ST and Data Type Editor and 
the corresponding menu entry commands (see also General Short Cut Keys, 
p. 692):

Moving insertion 
marks in the text

Moving insertion marks in the text:

Key Menu Entry Command Executed

Ctrl+Z Edit → Reverse: Delete

Ctrl+X Edit → Cut

Ctrl+C Edit → Copy

Ctrl+V Edit → Add

Del Edit → Delete

Ctrl+G Edit → Go to line...

Ctrl+J Edit → Go to opposite part...

Ctrl+E Edit → Expand instruction

Alt+F8 Edit → Search for variables

Ctrl+F Edit → Advanced search

Ctrl+H Edit → Replace...

Ctrl+Y Online → Animate binary values

Ctrl+I Online → Check Selections

Ctrl+W Online → View Selections

Key Moving

Down Onto the next line

Up Onto the previous line

Ctrl+G Onto a specific line

End To the end of the line

Home To the beginning of the line

Picture up Into the next window

Picture up Into the previous window

Ctrl+Right To the next word

Ctrl+Left To the previous word

Ctrl+End To the end of the document

Ctrl+Home To the beginning of the document
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Deleting text Deleting text:

Marking text Marking text:

Key Function

Backspace Key (Delete backwards) Deleting a mark (or deleting marked text) to 
the left of the insertion mark.

Del Deleting a character (or deleting marked 
text) to the right of the insertion mark.

Ctrl+Backspace key (Delete backwards) Deleting a line

Key Extending the marking

Shift+Right to the next character

Shift+Left to the previous character

Ctrl+Shift+Right to the next word

Ctrl+Shift+Left to the previous word

Shift+Down to the next line

Shift+Up to the previous line

Shift+End to the end of the line

Shift+Home to the beginning of the line

Shift+Picture down to a window underneath

Shift+Picture up to a window above

Ctrl+Shift+Picture down to the end of the current window

Ctrl+Shift+Picture up to the beginning of the current window

Ctrl+Shift+End to the end of the document

Ctrl+Shift+Home to the beginning of the document
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Editing text Editing text:

Short Cut Keys in the FBD and SFC Editor

At a Glance Concept supports the work with the keyboard in the graphic editors. Although the 
mouse is a more appropriate input tool, it is nevertheless possible to operate 
Concept with the keyboard alone – especially in machine environments. The editors 
behave in the same way regardless of whether they are operated with the mouse or 
with the keyboard.

Rules The following general rules need to be observed:
l The space bar corresponds to the left mouse button, i.e. the space bar is used for 

selecting and moving.
l The enter key corresponds to the double click with the left mouse button – for 

example, the input key is used to call up the properties dialog of objects.
l The shift key is used in conjunction with the keyboard exactly as it is with the 

mouse – for example, the shift key is used to extend an object selection or to 
reselect a few objects from a number which have already been selected.

Key Function

Ctrl+X Deleting marked text and saving in the 
clipboard

Ctrl+C Copying marked text and saving in the 
clipboard

Entering the new text Replacing marked text

Del Deleting marked text without saving in the 
clipboard

Ctrl+V Replacing marked text with text from the 
clipboard.

Ctrl+F Searching for text

Ctrl+R Replacing text
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Calling up menu 
command 
entries

The table shows the short cut keys available in the FBD and SFC editor and the 
corresponding menu entry commands (see also General Short Cut Keys, p. 692):

Moving the 
cursor

Moving the cursor:

Key Menu Entry Command Executed

Ctrl+A Edit → Select All

Ctrl+Z Edit → Reverse: Delete

Ctrl+X Edit → Cut

Ctrl+C Edit → Copy

Ctrl+V Edit → Add

Del Edit → Delete

Ctrl+O Display → Overview

Ctrl+N Display → Normal

Ctrl+E Display → Expanded (only in SFC)

Ctrl++ Display → Enlarge

Ctrl+- Display → Reduce

Ctrl+Y In the FBD Editor: Online → Animate binary values
In SFC-Editor: Online → Animation

Ctrl+W Online → Selection animate (in FBD)

Key Function

Cursor keys The cursor keys move the cursor inside the document window. The 
cursor is moved further around a Pixel. If the cursor is at the edge of 
the document window, pressing the cursor keys again will page the 
document window in the corresponding direction.

Ctrl+Cursor Keys When the Strg key is pressed, the cursor keys move the cursor 
inside the document window. The cursor is moved further around a 
logical unit (depending on the active editor). If the cursor is at the 
edge of the document window, pressing the cursor keys again will 
page the document window in the corresponding direction

Home The Pos1 key moves the cursor to the left-hand edge of the document 
window.

End The End key moves the cursor to the right-hand edge of the 
document window.
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Scrolling Scrolling:

Edit Edit

Key Function

Ctrl+Home When the Ctrl key is pressed, the Pos1 key moves the document 
window to the upper left-hand corner of the section.

Ctrl+End When the Ctrl key is pressed, the End key moves the document 
window to the lower right-hand corner of the section.

Picture up The picture up key scrolls the document window one screen page 
upwards, while the cursor remains in the same position in the 
document window.

Picture down The picture down key scrolls the document window one screen page 
downwards, while the cursor remains in the same position in the 
document window.

Ctrl+Picture up When the Ctrl key is pressed, the Picture up key scrolls the 
document window one page to the left while the cursor remains in the 
same place in the document window.

Ctrl+Picture 
down

When the Ctrl key is pressed, the Picture down key scrolls the 
document window one page to the right while the cursor remains in 
the same place in the document window.

Key Function

Space bar In select mode, the object at the cursor position is selected and all other 
objects are deselected. 
In placing mode the corresponding object is placed where the cursor is.

Shift key+Space 
bar

In selection mode, when the Shift key is pressed, objects which have not 
previously been selected in the cursor position are selected, or vice 
versa. The selection of all other objects is not affected.
In placing mode the corresponding object is placed where the cursor is.

Space 
bar+Cursor Keys

In selection mode – if there is no selected object where the cursor is – 
the cursor moves and a selection rectangle is displayed. If a selected 
object is in the cursor position, all objects will be shifted according to how 
the cursor is moved.
The number of inputs of an FFB with a variable input number can be 
changed in the FB Editor’s Selection Mode by placing the cursor on the 
rectangle in the middle of the lower edge of the selection frame, which 
holds down the Space bar and presses the Up or Down keys.
The width of the branches or connections can be changed in the SFC 
Editor’s Selection Mode by placing the cursor on the rectangle of the 
selection frame, which holds down the Space bar and presses the Right 
or Left keys. 
In Link Mode, a link is produced by dragging the mouse.
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Allocating 
variables onto an 
FFB

To allocate variables onto an FFB, do the following:

Changing 
variables onto an 
FFB

To change variables onto an FFB, do the following:

Changing the 
number of 
inputs/outputs

To change the number of inputs/outputs with extendable FFBs, do the following:

Shift key+Space 
bar+Cursor keys

In Selection Mode, this key combination creates a selection frame as 
described above, and the selection of all other objects is retained.

Key Function

Step Action

1 Use the cursor keys or Shift+cursor keys to move the cursor to the input/
output of the FFB.

2 Press Enter.

Reaction: The link FFB dialog for the selected input/output opens.

Step Action

1 Use the cursor keys or Shift+cursor keys to move the cursor to the FFB 
variables to be changed.

2 Press Enter.

Reaction: The link FFB dialog for the selected input/output opens.

Step Action

1 Use the cursor keys or Shift+cursor keys to move the cursor to the centre of 
the lower edge of the FFB’s block frame.

2 Press Space bar+Down cursor key to generate further inputs/outputs.
Press Space bar+Up cursor key to hide further inputs/outputs.

Reaction: The number of inputs/outputs is changed.
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Shortcut keys in the LD-Editor

At a Glance Concept supports the work with the keyboard in the graphic editors. Although the 
mouse is a more appropriate input tool, it is nevertheless possible to operate 
Concept with the keyboard alone – especially in machine environments. The Editors 
behave in the same way regardless of whether they are operated with the mouse or 
with the keyboard.

Rules The following general rules need to be observed:
l The space bar corresponds to the left mouse button, i.e. the space bar is used for 

selecting and moving.
l The Enter key corresponds to the double click with the left mouse button – for 

example, the input key is used to call up the properties dialog of objects.
l The Shift key is used in conjunction with the keyboard exactly as it is with the 

mouse – for example, the Shift key is used to extend an object selection or to 
reselect a few objects from a number which have already been selected.

l Pressing a key only once only affects the element in the center of the current cell.
l Pressing a key together with Ctrl affects the right side of the current cell..
l Striking a key together with Shift afects the left side of the current cell
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Calling up menu 
command

The table shows the additional shortcut keys and their corresponding menu 
commands avialable in LD Editor (see also General Short Cut Keys, p. 692):

Key Menu Entry Command Executed

Ctrl+A Edit → Select All

Ctrl+Z Edit → Reverse: Delete

Ctrl+X Edit → Cut

Ctrl+C Edit → Copy

Ctrl+V Edit → Add

Del Edit → Delete

Ctrl+O Display → Overview

Ctrl+N Display → Normal

Ctrl++ Display → Enlarge

Ctrl+- Display → Reduce

Esc Objects → Select Mode

Shift+H Objekts → Link

H Objects → Direct Link

V Objects → Vertical Link

F Objects → FFB: Last Type

I Objects → Invert Input/Output

T Objects → Text

Shift+F Objects → select FFB...

C Objects → Contact N.O.

L Objects → Contact – Open.

P Objects → Contact Positive Flank

N Objects → Contact Negative Flank

Shift+C Objects → Coil

Shift+L Objects → Coil Negative

Shift+S Objects → Coil Set

Shift+R Objects → Coil Reset

Shift+P Objects → Coil Positive Flank

Shift+N Objects → Coil Negative Flank

Ctrl+Y Online → Animate binary values

Ctrl+W Online → Animate selection
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Placing objects In order to place objects in the LD Editor by using the keyboard, please carry out the 
following steps:

Moving the gray 
field (selecting a 
field)

Moving the gray field (selecting a field)

Step Action

1 Move the field with a gray background onto the field where the object is to be 
placed (move gray field (selecting a field)).

2 Strike the key assigned to the object (see Creating objects, p. 704).

Reaction: Adjoining boolean objects are automatically connected.

3 Links between non-adjoining objects and non-boolean in/outputs have to be 
made with the mouse pointer (see Moving the mouse pointer, p. 703).

4 The mouse pointer must also be used to invert in/outputs (see Moving the mouse 
pointer, p. 703).

Key Function

Up Moves the gray field up by one field

Down Moves the gray field down by one field

To the right Movesthe gray fields to the right by one field

To the left Moves the gray fields to the left by one field

Home Moves the gray field to the left margin

Shift+Home Moves the gray field to the left margin

End Moves the gray field to the right margin

Shift+End Moves the gray field to the right margin

Ctrl+Home Moves the gray field to the top left-hand 
corner

Ctrl+End Moves the gray field to the top right-hand 
corner
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Selecting objects Selecting objects

Moving a 
selected object

Moving a selected object

Allocating 
variables onto an 
FFB

To allocate variables onto an FFB, do the following:

Key Function

Space character Selects object in the middle of the gray field

Ctrl+Space character Selects object on the right-hand side of the 
gray field

Shift+Space character Selects object on the left-hand side of the 
gray field

Enter In select mode: Selects object in the middle 
of the gray field and opens its Select dialog (if 
available)

Ctrl+Enter In select mode: Selects object from the right-
hand side of the gray field and opens its 
Select dialog (if available)

Shift+Enter In select mode: Selects object from the left-
hand side of the gray field and opens its 
Select dialog (if available)

Key Function

Shift+Up Moves the selected object up by one field

Shift+Down Moves the selected object down by one field

Shift+Right Moves the selected object to the right by one 
field

Shift+Left Moves the selected object to the left by one 
field

Step Action

1 Move the gray field onto the cell containing the in/output.

2 To allocate variables to inputs, press Ctrl+Enter.
To allocate variables to outputs press Ctrl+Enter.

Reaction: The Dialog connect FFB of the selected in/output is opened.
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Changing 
variables onto an 
FFB

To change variables onto an FFB, do the following:

Deleting vertical 
links

To delete vertical variables, carry out the following step:

Moving the 
mouse pointer

Moving the mouse pointer

Scrolling Scrolling:

Step Action

1 Move the gray field onto the cell containing the variable to be changed.

2 To select the variable press Shift+Enter.

Reaction: The Dialog connect FFB of the selected in/output is opened.

Step Action

1 Move the gray field onto the cell running through the vertical link.

2 Press Ctrl+Delete.

Reaction: The vertical link is deleted.

Key Function

Ctrl+Up Moving the mouse pointer up by one step

Ctrl+Down Moving the mouse pointer down by one step

Ctrl+Right Moving the mouse pointer to the right by one 
step

Ctrl+Left Moving the mouse pointer to the left by one 
step

Key Function

Picture up Scrolls the display sector one page up

Shift+Picture up Scrolls the display sector one page up

Picture down Scrolls the display sector one page down

Shift+Picture down Scrolls the display sector one page down

Ctrl+Picture up Scrolls the display sector one page to the 
right

Ctrl+Picture down Scrolls the display sector one page to the 
right
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Creating objects Creating objects

Creating links Creating links

Activating the 
different modes

Activating the different modes

Key Function

C Creates a N.O. in the gray field

L Creates an opener in the gray field

P Creates a contract for the recognition of 
positive flanks in the gray field

N Creates a contract for the recognition of 
negative flanks in the gray field

Shift+C Creates a coil in the gray field

Shift+L Creates a negated coil in the gray field

Shift+S Creates a coil set in the gray field

Shift+R Creates a reset coil in the gray field

Shift+P Creates a coil for the recognition of positive 
flanks in the gray field

Shift+N Creates a coil for the recognition of negative 
flanks in the gray field

Shift+F Opens FFB selection dialog

F Creates current FFB in the gray field

Key Function

H Activates the link mode

V Creates a vertical link in the right-hand 
bottom corner of the gray field (and then 
moves the gray field to the right by one field)

Shift+V Creates a vertical link in the bottom left-hand 
corner of the gray field.

Key Function

Space character Activates the selection mode

Esc Activates the selection mode

H Activates the link mode

I Activates the mode for inverting in/outputs

T Activates the text mode
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Short Cut Keys in the LL984-Editor

Short Cut Keys The table shows the additional short cut keys available in the LL984 editor and the 
corresponding menu entry commands (see also General Short Cut Keys, p. 692):

Short Cut Keys Menu Entry Command Executed

Ctrl+Z Edit → Reverse: Delete

Ctrl+X Edit → Cut

Ctrl+C Edit → Copy

Ctrl+V Edit → Add

Del Edit → Delete

Ctrl+D Edit → DX Zoom...

Ctrl+H Edit → Offset References...

Ctrl+O Display → Overview

Ctrl+N Display → Normal

Ctrl+E Display → Expand

Ctrl++ Display → Enlarge

Ctrl+- Display → Reduce

( Objects → Coil

Ctrl+L Objects → Coil - buffered

" Objects → Contact – N.O.

/ Objects → Contact – Open.

P Objects → Contact – Positive Edge.

N Objects → Contact – Negative Edge.

= Objects → Horizontal Link

I Objects → Vertical Link

Ctrl+F Objects → Instruction by name...

Ctrl+G Network → Go to...

Ctrl+I Networks → Add

Ctrl+Q Networks → Add formula

Ctrl+A Networks → Attach

Ctrl+U Networks → Attach formula

Ctrl+K Networks → Delete

Picture up Networks → Next

Picture up Networks → Previous

Ctrl+M Networks → Commentary
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Ctrl+T Online → Trace

Ctrl+B Online → Retrace

Short Cut Keys Menu Entry Command Executed
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D
IEC conformity

At a Glance

Overview This Chapter contains the standards tables required by IEC 1131-1. 

What’s in this 
chapter?

This chapter contains the following Sections:

Section Topic Page

D.1 What is the IEC 1131-3 standard? 709

D.2 IEC standards tables 712

D.3 Expansions of IEC 1131-3 730

D.4 Text language syntax 731
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D.1 What is the IEC 1131-3 standard?

At a Glance

Overview This section contains general information about IEC 1131-3 and the implemented 
IEC conformity test.

What’s in this 
section?

This section contains the following topics:

Topic Page

General information about IEC conformity 710

IEC Conformity Test 711
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General information about IEC conformity

At a Glance The IEC standard 1131-3 (compare chapter 1.4) specifies the syntax and semantics 
of a standardized series of programming languages for Programmable Logic 
Controls (PLC). These include the two text languages IL (Instruction List) and ST 
(Structured Text) and the two graphical languages LD (Ladder Diagram) and FBD 
(Function Block Diagram).

It also defines the elements of the sequential function chart (SFC) language for 
structuring the internal organization of PLC programs and Function Blocks. 
Configuration elements, used for installing PLC programs onto PLC systems, are 
also defined.

Furthermore, it defines methods to enable communication between the PLC and 
other automated system components.

Concept 
standard 
accordance

In accordance with the standard, the present version of the programming system 
Concept supports a subset of language elements, which are defined in the standard. 

In this context, accordance with the standard means the following:
l The standard allows the individual implementing an IEC program system to select 

or deselect certain language properties or even complete languages from the 
selection tables, which represent an integrated part of the standard 
specifications. A system, which itself accords with the standard, may only 
implement the selected properties exactly as they are given in the standard.

l In addition, the standard enables the individual implementing to introduce defined 
language elements into an interactive programming environment. As the 
standard expressly emphasizes that the specification of such environments lies 
outside of its area of application, the person implementing has a certain degree 
of freedom to offer optimized forms of display and implementation mechanisms 
for the benefit of the user.

l Concept uses these degrees of freedom e.g. when introducing the term "Project" 
to implement the IEC language elements "Configuration", "Resource" and 
"Program" all together (Concept only supports one single cyclically running 
program within a single resource within the configuration). Apart from this, it uses 
them, for example, with implementation mechanisms made available for 
declaring variables and authorizing Function Blocks.

Note: Concept uses the English acronyms for the programming languages.
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IEC standards 
tables

Information on which properties are supported and other implementation specific 
details can be found in the following statements on standard fulfilment and the 
associated standards tables.

IEC Conformity Test

Testing the 
Import/Export 
Interface

An interface for importing standard IEC programs and DFBs from ASCII files (menu 
File → Import) and exporting these programs into graphical languages in ASCII 
format (menu File → Export) is available in Concept. The conformity of this interface 
can be tested using files which can be obtained from IFAK (Institut für Automation 
und Kommunikation e.V. Magdeburg). 

IEC conformity test scripts:
(c) 1994, IFAK Institut für Automation und Kommunikation e.V.
Magdeburg 
Steinfeldstraße 3
D-39179 Barleben

Notes The following points must be considered with regard to the conformity of the import 
interface:
l In Concept, IL operators are permitted as identifiers. 

R, S, LD, S1 and R1 are possible parameter names. Therefore, there will be no 
changes made to the standard functions/function blocks. Concept requires no 
change in the IEC table 54 with S to SET, R to RESET, S1 to SET1, R1 to 
RESET1.

l All IL operators not in conflict with functions are permitted as variable names in 
Concept (N, S, R, S1, R1, CLK, CU, CD, PV, IN, PT) – contrary to IEC table 54.

l Counter EFBs must be typified in Concept, e.g. CTU must become CTU_INT.
l Function block instances cannot be called up more than once; a restriction that is 

self-evident if IEC table 53, property 3 is required.
l An overflow of time span variables (e.g. t#100s) is not detected. The system 

calculates the time correctly, so that detection of an overflow is not necessary.
l IEC IL comments are only permitted as the last element in a line. Concept allows 

comments to be made everywhere.
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D.2 IEC standards tables

At a Glance

Overview This system fulfils the requirements of the IEC 1131-3 in the following properties of 
the language.

What’s in this 
section?

This section contains the following topics:

Common elements

IEC standards 
table

IEC standards table for common elements:

Topic Page

Common elements 712

IL (AWL) language elements 719

ST language elements 721

Common graphic elements 722

LD (KOP) language elements 723

Implementation-dependent parameters 725

Error causes 728

Table 
number

Property 
number

Property description

1 1 For required character set – see Chapter 2.1.1 of 1131-3

1 2 Lower case characters

1 3a Hash key (#)

1 4a Dollar sign ($)

1 5a Vertical line (|)

1 6a Left and right square brackets "[ ]"

2 1 Upper case character and numbers

2 2 Upper and lower case characters, numbers, embedded 
underscore

2 3 Upper and lower case characters, numbers, leading and 
embedded underscore

3 1 Comments
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4 1 Integer (whole number) literals

4 2 Real literals

4 3 Real literals with exponents

4 4 Base 2 literals

4 5 Base 8 literals

4 6 Base 16 literals

4 7 Boolean zero and one

4 8 Boolean FALSE and TRUE

7 1a Time span without underscores: short prefix

7 1b Time span without underscores: long prefix

7 2a Time span with underscores short prefix

7 2b Time span with underscores long prefix

10 1 BOOL: Boolean

10 3 INT: Integer

10 4 DINT: Double integer

10 7 UINT: Signed integer

10 8 UDINT: Signed double integer

10 10 REAL: Floating point number

10 12 TIME: Time span

10 17 BYTE: Bit sequence 8

10 18 WORD: Bit sequence 16

12 4 Data types for fields

12 5 Data types for structures

15 1 I: Input (Note 1, p. 717)

15 2 Q: Output (Note 2, p. 717)

15 4 X: Bit size (Note 2, p. 717, Note 1, p. 717)

15 5 no prefix: Bit size (Note 2, p. 717, Note 1, p. 717)

15 6 B: Byte size (Note 2, p. 717, Note 1, p. 717)

15 7 W: Word size (Note 2, p. 717, Note 1, p. 717)

15 8 D: Double word size (Note 2, p. 717, Note 1, p. 717)

17 2 Declaration of directly displayed buffered variables (Note 5, 
p. 718, Note 9, p. 718)

17 3 Declaration of storage locations with symbolic variables (Note 
5, p. 718)

Table 
number

Property 
number

Property description
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17 4 Assignment of storage locations with fields (Note 5, p. 718, 
Note 11, p. 718)

17 5 Automatic storage allocation for symbolic variables (Note 5, 
p. 718)

17 7 Declaration for buffered fields (Note 5, p. 718, Note 11, 
p. 718)

17 8 Declaration for structured variables (Note 5, p. 718)

18 2 Initialization of directly displayed buffered variables (Note 5, 
p. 718, Note 9, p. 718, Note 10, p. 718)

18 3 Assignment of storage locations and start values for 
fields(Note 5, p. 718)

18 4 Assignment of storage locations and start values for fields 
(Note 5, p. 718, Note 11, p. 718)

18 5 Initialization of symbolic variables (Note 5, p. 718)

18 7 Declaration and initialization of buffered variables (Note 5, 
p. 718, Note 11, p. 718)

18 8 Initialization of structured variables (Note 5, p. 718)

18 9 Initialization of constants

19 1 Negated input

19 2 Negated output

20 1 Use of "EN" and "ENO" - REQUIRED for LD (Note 6, p. 718)

20 2 Use of "EN" and "ENO" – OPTIONAL for FBD

20 3 FBD without "EN" and "ENO"

21 2 Standardized functions (Note 3, p. 717)

22 1 (*-TO-**) Type conversion functions (Note 4, p. 718

22 2 Truncation towards zero: TRUNC (Note 3, p. 717))

23 1 ABS: Absolute value

23 2 SQRT: Square root

23 3 LN: Natural logarithm

23 4 LOG: Base 10 logarithm

23 5 EXP: Exponential function

23 6 SIN: Sine, input in radians

23 7 COS: Cosine, input in radians

23 8 TAN: Tangent, input in radians

23 9 ASIN: Arc sine, principal value

Table 
number

Property 
number

Property description
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23 10 ACOS: Arc cosine, principal value

23 11 ATAN: Arc tangent, principal value

24 12 ADD: Add

24 13 MUL: Multiply

24 14 SUB: Subtract

24 15 DIV: Divide

24 16 MOD: Modulo

24 17 EXPT: Exponentiation

24 18 MOVE: Assignment

25 1 SHL: move to the left

25 2 SHR: Move to the right

25 3 ROR: Rotate to the right

25 4 ROL: Rotate to the left

26 5 AND: LLogical And

26 6 OR: Logical Or

26 7 XOR Logical exclusive Or

26 8 NOT: Negation

27 1 SEL: Binary selection

27 2a MAX: Extendable maximum

27 2b MIN: Extendable minimum

27 3 LIMIT: Limit

27 4 MUX: Extendable multiplexer

28 5 GT: Falling sequence

28 6 GE: Monotonic sequence (decreasing)

28 7 EQ: Equality

28 8 LE: Monotonic sequence (increasing)

28 9 LT: Rising seqence

28 10 NE: Inequality

30 1 ADD: Adding TIME to TIME

30 4 SUB: Subtracting TIME from TIME

30 10 MUL: Multiplying TIME by ANY_NUM

30 11 DIV: Dividing TIME by ANY_NUM

33 1 RETAIN identifier for internal variables (Note 5, p. 718)

33 2 RETAIN identifier for output variables (Note 5, p. 718)

Table 
number

Property 
number

Property description
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33 3 RETAIN identifier for internal Function Blocks (Note 5, p. 718)

34 1 Bistable Function Block (set priority)

34 2 Bistable Function Block (reset priority)

35 1 Detecting the rising edge

35 2 Detecting the falling edge

36 1 Up counter

36 2 Down counter

36 3 Up/Down counter

37 1 TP: Pulse (timer)

37 2a TON: Switch-on delay

37 3a TOF: Switch-off delay

39 1 RETAIN identifier for internal variables (Note 5, p. 718)

39 2 RETAIN identifier for output variables (Note 5, p. 718)

39 3 RETAIN identifier for internal Function Blocks (Note 5, p. 718)

39 14 Assignment of storage locations with fields (Note 5, p. 718)

39 18 Assignment of storage locations and start values for 
fields(Note 5, p. 718)

39 19 Use of directly displayed variables (Note 2, p. 717, Note 1, 
p. 717)

40 1 Step/Start step – graphical form with directional links

40 2 Step/Start step – text form without directional links (Note 8)

40 3a Step marker – general form

40 4 Step time elapsed – general form

41 1 Transition condition in ST language within the graphic (Note 
8, p. 718)

41 5 Transition condition in ST language – textual reference (Note 
9, p. 718)

41 6 Transition condition in IL language – textual reference (Note 
9, p. 718)

41 7 Use of the transition name

41 7b Transition condition in FBD language

41 7c Transition condition in IL language

41 7d Transition condition in ST language

42 1 Each Boolean variable can be an action

43 1 Action block

Table 
number

Property 
number

Property description



IEC conformity

840 USE 493 00 September 2001 717

Note 1 Modicon TSX Quantum Präfix 3 is used in the prefix IB, ID position in all graphical 
languages.

Note 2 Modicon TSX Quantum Präfix 4 is used in the prefix QB, QD position in all graphical 
languages.

Note 3 The following functions are overloaded with reference to the data which is selected, 
multiplexed or assigned; the type statement refers to the selection parameters.

List of overloaded functions:
l SEL
l MUX
l MOVE
All other functions are standardized, e.g. REAL_TRUNC_INT.

43 2 Concatenated action blocks

43 3 Step body in text form (Note 8, p. 718)

44 1 Identifier

44 2 Action name

45 1 Not saved (no identifier)

45 2 N: not saved

45 3 R: Overriding reset

45 4 S: Set (saved)

45 5 L: Time limited

45 6 D: Delayed

45 7 P: Pulse

45 9 DS: Delayed and saved

46 1 Simple string

46 2a Branching in string selection (priority from left to right)

46 3 Merging a string selection

46 4 Parallel strings - branch and merge

46 5a String jump (priority from left to right)

46 6a String loop (priority from left to right)

Table 
number

Property 
number

Property description
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Note 4 List of type conversion functions:
l BOOL_TO_BYTE, BOOL_TO_DINT, BOOL_TO_INT, BOOL_TO_REAL, 

BOOL_TO_TIME, BOOL_TO_UDINT, BOOL_TO_UINT, BOOL_TO_WORD,
l BYTE_TO_BOOL, BYTE_TO_DINT, BYTE_TO_INT, BYTE_TO_REAL, 

BYTE_TO_TIME, BYTE_TO_UDINT, BYTE_TO_UINT, BYTE_TO_WORD,
l DINT_TO_BOOL, DINT_TO_BYTE, DINT_TO_INT, DINT_TO_REAL, 

DINT_TO_TIME, DINT_TO_UDINT, DINT_TO_UINT, DINT_TO_WORD, 
l INT_TO_BOOL, INT_TO_BYTE, INT_TO_DINT, INT_TO_REAL, 

INT_TO_TIME, INT_TO_UDINT, INT_TO_UINT, INT_TO_WORD, 
l REAL_TO_BOOL, REAL_TO_BYTE, REAL_TO_DINT, REAL_TO_INT, 

REAL_TO_TIME, REAL_TO_UDINT, REAL_TO_UINT, REAL_TO_WORD, 
l TIME_TO_BOOL, TIME_TO_BYTE, TIME_TO_DINT, TIME_TO_INT, 

TIME_TO_REAL, TIME_TO_UDINT, TIME_TO_UINT, TIME_TO_WORD, 
l UDINT_TO_BOOL, UDINT_TO_BYTE, UDINT_TO_DINT, UDINT_TO_INT, 

UDINT_TO_REAL, UDINT_TO_TIME, UDINT_TO_UINT, UDINT_TO_WORD, 
l UINT_TO_BOOL, UINT_TO_BYTE, UINT_TO_DINT, UINT_TO_INT, 

UINT_TO_REAL, UINT_TO_TIME, UINT_TO_UDINT, UINT_TO_WORD, 
l WORD_TO_BOOL, WORD_TO_BYTE, WORD_TO_DINT, WORD_TO_INT, 

WORD_TO_REAL, WORD_TO_TIME, WORD_TO_UDINT, WORD_TO_UINT
The consequences of each conversion are described in the block library and the 
help texts, which are available for the library of IEC standard functions.

Note 5 The RETAIN identifier is implicitly required; no language elements displayed in non-
buffered memory areas are supported.

Note 6 "EN" and "ENO" are offered as standard; they can, however, be hidden and any 
other input or output of data type BOOL can be used for links.

Note 7 Expressions are restricted to individual simple Boolean variables.

Note 8 Only available on import of IEC text form in graphical SFC representation.

Note 9 Only available in textual declaration in IL or ST sections.

Note 10 Initialization only possible for non Boolean outputs.

Note 11 Declaration of field variables only possible when using previously defined field data 
type names.
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IL (AWL) language elements

IEC standards 
table

IEC standards table for IL (AWL) language elements:

Note 1 Jumps are only allowed within sections, not across section boundaries.

Table 
number

Property 
number

Property description

52 1 LD operator: sets the current result to that of the operand

52 2 ST operator: saves the current result to the operand address

52 3 S operator: sets Boolean operands to "1" 
R operator: sets Boolean operands to "0"

52 4 AND operator

52 6 OR operator

52 7 XOR operator

52 8 ADD operator

52 9 SUB operator

52 10 MUL operator

52 11 DIV operator

52 12 GT operator: Comparison >

52 13 GE operator: Comparison >=

52 14 EQ operator: Comparison =

52 15 NE operator: Comparison <>

52 16 LE operator: Comparison <=

52 17 LT operator: Comparison <

52 18 JMP operator: Jump to tag (Note 1, p. 719)

52 19 CAL operator: Calls Function Block

52 21 Closing bracket ")": Editing deferred operations

53 1 CAL operator with list of input parameters

53 2 CAL operator with loading/saving of input parameters
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Note 2 The following keywords are not available:
l TYPE...END_TYP
l VAR_INPUT...END_VAR
l VAR_OUTPUT...END_VAR
l VAR_IN_OUT...END_VAR
l VAR_EXTERNAL...END_VAR
l FUNCTION...END_FUNCTION
l FUNCTION_BLOCK...END_FUNCTION_BLOCK
l PROGRAM...END_PROGRAM
l STEP...END_STEP
l TRANSITION...END_TRANSITION
l ACTION...END_ACTION
l SEGMENT_SCHEDULER
l RET
l &
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ST language elements

IEC standards 
table

IEC standards table for ST language elements:

Table 
number

Property 
number

Property description

55 1 Placing in brackets: ( Expression )

55 2 Function calls: Function name ( list of arguments )

55 3 Exponentiation: **

55 4 Negation: -

55 5 Complement: NOT

55 6 Multiplication: *

55 7 Division: /

55 8 Modulo: MOD

55 9 Addition: +

55 10 Subtraction: -

55 11 Comparison: <, >, <=, >=

55 12 Equality: =

55 13 Inequality: <>

55 14 Boolean AND: &

55 15 Boolean AND: AND

55 16 Boolean exclusive OR: XOR

55 17 Boolean OR: OR

56 1 Assignment

56 2 Function Block calls and use of FB outputs

56 4 IF instruction

56 5 CASE instruction

56 6 FOR instruction

56 7 WHILE instruction

56 8 REPEAT instruction

56 9 EXIT instruction

56 10 Empty instruction
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Note 1 The following keywords are not available:
l TYPE...END_TYP
l VAR_INPUT...END_VAR
l VAR_OUTPUT...END_VAR
l VAR_IN_OUT...END_VAR
l VAR_EXTERNAL...END_VAR
l FUNCTION...END_FUNCTION
l FUNCTION_BLOCK...END_FUNCTION_BLOCK
l PROGRAM...END_PROGRAM
l STEP...END_STEP
l TRANSITION...END_TRANSITION
l ACTION...END_ACTION
l SEGMENT_SCHEDULER
l RETURN

Common graphic elements

IEC standards 
table

IEC standards table for common graphic elements:

Table 
number

Property 
number

Property description

57 2 Horizontal lines: Graphic or semi-graphic

57 4 Vertical lines:  Graphic or semi-graphic

57 6 Horizontal/vertical connection: Graphic or semi-graphic

57 8 Line intersection without connection: Graphic or semi-graphic

57 10 Connected and unconnected corners: Graphic or semi-
graphic

57 12 Blocks with connecting lines: Graphic or semi-graphic
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LD (KOP) language elements

IEC standards 
table

IEC standards table for LD (KOP) language elements:

Table 
number

Property 
number

Property description

59 1 Left power rail (with linked horizontal connection)

60 1 Horizontal connection

60 2 Vertical connection (with linked horizontal connections)

61 1 Closer

61 3 Opener

61 5 Contact for detection of positive transition

61 7 Contact for detection of negative transition

62 1 Coil (Note 1, p. 724)

62 2 Negative coil (Note 1, p. 724)-{}-

62 3 SET coil (Note 1, p. 724)

62 4 RESET coil (Note 1, p. 724)

62 8 Coil for detection of positive transition

62 9 Coil for detection of negative transition
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Note 1 In start behavior of PLCs there is a distinction between cold starts and warm starts:
l Cold start

Following a cold start (loading the program with Online → Load) all variables 
(irrespective of type) are set to "0" or, if available, their initial value.

l Warm start
In a warm start (stopping and starting the program or Online → Load changes) 
different start behaviors are valid for located variables/direct addresses and 
unlocated variables:
l Located variables/direct addresses

In a warm start all 0x, 1x and 3x registers are set to "0" or, if available, their 
initial value. 
4x registers retain their current value (storage behavior).

l Unlocated variables
In a warm start all unlocated variables retain their current value (storing 
behavior).

This varying behavior in a warm start leads to peculiarities in the warm start behavior 
of set and reset functions.
l Set and Reset in LD and IL

Warm start behavior is dependent on the variable type used (storage behavior in 
use of unlocated variables; non storage behavior in use of located variables/
direct addresses)

l SR and RS Function Blocks in FBD, LD, IL and ST
These Function Blocks work with internal unlocated variables and therefore 
always have a storage behavior.
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Implementation-dependent parameters

IEC standards 
table

IEC standards table for implementation-dependent parameters:

Parameters Threshold values/behavior

Error-handling procedure See Error causes, p. 728 & EFB help

National characters used All characters in the Windows ANSI character set 
are supported.

Maximum length of identifiers Program name: 8
Formal parameter names: 8
DFB type names: 8
EFB type names: 17
Data type names: 24
all others: 32

Maximum comment length: Limited only by Windows resources

Range of values for time span literals 0s to 49d_17h_2m_47.295s

Range of values for variables of type 
TIME 0s to 49d_17h_2m_47.295s

Accuracy of the seconds display with 
types TIME_OF_DAY and 
DATE_AND_TIME

not applicable

Maximum number of field indices Practically no limit

Maximum field size 64 kB

Maximum number of structure 
elements

Only limited by Windows or PLC resources

Maximum structure size 64 kB

Maximum number of variables per 
declaration

Only limited by Windows or PLC resources

Maximum number of enumerated 
values

not applicable

Default maximum length of STRING 
variables

not applicable

Maximum authorized length of 
STRING variables

not applicable

Maximum number of  hierarchy tiers 1

Configured or physical illustration Configured illustration, physical illustration through 
separate I/O projection

Parameters Threshold values/behavior

Maximum number of indices Practically no limit



IEC conformity

726 840 USE 493 00 September 2001

Maximum range of index values Range of data type INT

Maximum number of structure levels Only limited by Windows or PLC resources

Initialization of system inputs System zero; no user-definable start values

Maximum number of variables per 
declaration

Only limited by Windows or PLC resources

Information for the determination of 
execution times of program 
organization units

In preparation

Methods of function display (names or 
symbols)

Names

Maximum number of function 
specifications

not applicable

Maximum number of inputs for 
extendable functions 

32

Type conversion accuracy See EFB help

Accuracy of functions of a variable INTEL floating point processor or emulator

Arithmetic function implementation INTEL floating point processor or emulator

Maximum number of Function Block 
specifications

Only limited by Windows or PLC resources

Maximum number of Function Block 
authorizations

512 per section; number of sections per program 
organization unit is only limited by Windows or PLC 
resources

Pvmin, Pvmax of counters Limited by rangess of the INT or DINT data types

Effect of a change in the value of a PT 
input during a time measurement 
operation

Directly affects the timer’s default time 

Program size limits Only limited by available PLC memory

Time behavior and porting effects of 
the execution control elements

The execution of SFC networks in different sections 
occurs sequentially, in the order given in these 
sections.

Accuracy of elapsed step time 10 ms

Maximum number of steps per SFC Limited by the available area for entering 
characters within the section; number of sections 
per program organization unit only limited by 
Windows or PLC resources; the upper limit for the 
total number of objects per SFC is 2000

Parameters Threshold values/behavior

Parameters Threshold values/behavior
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Maximum number of transitions per 
SFC and per step

Limited by the available area for entering 
characters within the section; number of sections 
per program organization unit only limited by 
Windows or PLC resources; the upper limit for the 
total number of objects per SFC is 2000

Action control mechanism Functionally equivalent to the specification in the 
standard

Maximum number of actions per step Only limited by Windows or PLC resources

Graphical display of the step situation Green = active
Red = inactive

Transition switch time Of the magnitude of 10 ms

Maximum width of branches/
connections

Limited by the available area for entering 
characters 32

Contents of the RESOURCE libraries See EFB libraries & help

Maximum number of tasks 1

Task interval resolution not applicable

Pre-justified and non pre-justified 
schedules

not applicable

Maximum length of expressions Practically no limit

Partial evaluation of Boolean 
expressions

no partial evaluation

Maximum length of instructions Practically no limit

Maximum number of CASE selections Practically no limit

Value of the control variables on 
completion of FOR loops

undefined

Graphic/semi-graphic display Graphic

Network topology restrictions no restrictions

Evaluation sequence of feedback loops Within a network, the starting point of the FFB 
execution sequence is determined by the "single" 
available feedback variable

Means of specifying the network 
execution sequence

1: Execution sequence of program organization unit 
sections 
2: The network execution sequence can be 
changed within sections; this is done by using a 
menu command to switch between the execution 
sequences of two selected FFB items  

Parameters Threshold values/behavior
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Error causes

IEC standards 
table

IEC standards table for error causes:

Error cause Handling (see Note 1, p. 729)

Variable value exceeds the specified range not applicable

Initialization list length and number of field 
elements do not agree

2) Error message during programming

Incorrect use of directly displayed or external 
variables in functions

not applicable

Type conversion error 4) Error message during execution

Numerical result exceeds the range for data 
type

4) Error message during execution

Division by zero 4) Error message during execution

Mixed input data types in a selection function 2) Error message during programming

Selector (K) outside MUX function range 4) Error message during execution

Invalid character position not applicable

Result exceeds maximum sequence length not applicable

Numerical result exceeds the range for data 
type

4) Error message during execution

Zero or more than one starting step in SFC 
network

3) Error message during analysis/loading/
connection

User program attempting to change step 
situation or step time

2) Error message during programming

Simultaneously completed transitions without 
priority in a selection branch 

not applicable

Side effects of evaluation of a transition 
condition 

3) Error message during analysis/loading/
connection

Action control error 1) Error not reported

Unsafe or unreachable SFCs 3) Error message during analysis/loading/
connection

Data type conflict in VAR_ACCESS not applicable

Tasks demanding too many processor 
resources

3) Error message during analysis/loading/
connect

Scan time overrun 4) Error message during execution

Error cause Handling (see note 1)

Further task schedule conflicts not applicable
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Note 1 Identification for the handling of error causes according to IEC 1131-3, chapter 
1.5.1, d):
l 1) Error not reported
l 2) Error message during programming
l 3) Error message during analysis/loading/binding
l 4) Error message during execution

Numerical result exceeds the range for data 
type

4) Error message during execution

Division by zero 4) Error message during execution

Invalid data type for operation 3) Error message during analysis/loading/
binding

Return from function without assigned value not applicable

Occurrence arrives at no outcome 4) Error message during execution

The same identifier as connector tag and 
element name use 

not applicable

Non-initialized feedback variable (initialized 
with system zero)

1) Error not reported

Error cause Handling (see Note 1, p. 729)
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D.3 Expansions of IEC 1131-3

Expansions of IEC 1131-3

At a Glance The Concept programming environment makes the construct of the so-called 
section available in all programming languages permitting the subdivision of a 
program organization unit. This construct provides the opportunity to mix several 
languages in the body of a POU (e.g. FBD sections, SFC sections), a property, 
which, if used for this purpose, represents an expansion of the IEC syntax.  Sections 
do not generate their own name space; the name space for all language elements 
is the POU.
Sections appearing in the body of a POU written only in the FBD language are not 
to be viewed as an expansion, rather as a permitted means of specifying the 
execution sequences of several FBD networks furnished with tags, as specified in 
the corrigendum to 1131-3.

Purpose of 
sections

Sections serve various purposes
l Sections permit the functional division of an expansive POU body: The body of a 

POU can be divided into sensible functional parts. The section list represents a 
kind of functional table of contents for a large, otherwise unstructured POU body. 

l Sections permit the graphical division of an expansive POU body: in accordance 
with an intentionally graphic form of representation, sub-structures of an 
expansive body can be established. Smaller or larger partial structures may be 
chosen.

l The division of an expansive POU body enables faster online changes: the 
section serves as the unit for online changes in Concept. If the POU body is 
changed in various places during the program runtime, all sections affected by 
the changes are taken into account if explicitly initiated reloading occurs.

l Sections permit the execution sequence to influence particular marked parts of 
the POU body: the section name serves as a marking for the part of the body 
contained in the section, and the execution sequence of the sections can be 
changed by ranking the sections (see also the last part of the "implementation-
dependent parameters" table for information on the execution sequence of 
networks in the FBD language).

l Sections permit the parallel use of different languages in the same POU: this 
property is a considerable expansion of the syntax of the IEC 1131-3 standard, 
which only permits the use of a single IEC language for a POU body. Only the 
SFC language also provides the opportunity to formulate parts of the body in 
different languages, because transitions and actions can be expressed in any 
language, in as far as the corresponding properties are supported by the 
programming system.
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D.4 Text language syntax

Text Language Syntax

Description The programming system Concept supports the complete language syntax, as 
specified in appendix B of the IEC language standard 1131-3, with the following 
exceptions:
l Syntax productions in appendix B of 1131-3, belonging to properties, which 

according to the IEC standards tables in IEC standards tables, p. 712 in this 
document are not supported by Concept, are not implemented.

l The use of some Concept supported properties is, according to the associated 
remarks in the IEC standards table, only possible in a restricted or modified form. 
The associated syntax productions are therefore only occasionally or somewhat 
differently implemented.

l Concept supports the NOT Operator for inverting Boolean battery content in IL.
l The implementation of some faulty syntax productions in appendix B of 1131-3, 

improved upon either in the corrigendum to 1131-3 or in the planned amendment 
to 1131-3, uses the suggestions in these documents for orientation. 
The improved productions are implemented in Concept as follows (chapter 
numbers refer to appendix B of 1131-3):
l B.1.3.3:

array_initialization ::= ’[’ array_initial_elements {’,’ 
array_initial_elements} ’]’

initialized_structure ::= structure_type_name [’:=’ 
structure_initialization]

l B.2.1:
il_operand_list ::= il_operand [’,’ [EOL] il_operand]

il_fb_call ::= (’CAL’ | ’CALC’ | ’CALCN’) fb_name ’(’ 
il_operand_list ’)’

l B.2.2:
il_operator ::= ’LD’ | ’LDN’ | ’ST’ | ’STN’ | ’S’ | ’R’
| (’AND’ | ’ANDN’ | ’OR’ | ’ORN’ | ’XOR’ | ’XORN’) [’(’]
| (’ADD’ | ’SUB’ | ’MUL’ | ’DIV’) [’(’] 
| (’GT’ | ’GE’ | ’EQ’ | ’NE’ | ’LT’ | ’LE’) [’(’]
| ’JMP’ | ’JMPC’ | ’JMPCN’ | ’)’ | function_name 
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E
Configuration examples

At a Glance

Overview This section contains various configuration examples, given as step-by-step 
instructions.

What’s in this 
chapter?

This chapter contains the following Sections:

Section Topic Page

E.1 Quantum Example - Remote Control with RIO 735

E.2 Quantum Example - Remote control with RIO (series 800) 743

E.3 Quantum Example - Remote Control with DIO 754

E.4 Quantum Example – INTERBUS Control 763

E.5 Quantum Example - SY/MAX Controller 769

E.6 Quantum Example - Profibus DP Controller 777

E.7 Quantum-Example - Peer Cop 791

E.8 Compact Example 799

E.9 Atrium Example – INTERBUS Controller 804

E.10 Momentum Example - Remote I/O Bus 813

E.11 Momentum Example - Ethernet Bus System 821
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E.1 Quantum Example - Remote Control with RIO

Introduction

Overview This Chapter contains the step-by-step process for the configuration of remote 
control with RIO (Remote I/O).

What’s in this 
section?

This section contains the following topics:

Topic Page

Editing local drop 736

Editing Remote Drop 740
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Editing local drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of all drops. 
When editing the first (local) drop the modules must be set with their I/O references 
before the individual modules can be parameterized.
Quantum – remote controller with RIO 

1 Local Quantum drop 1

2 RIO master module

3 RIO slave module

4 RIO drop 2

C
P
S

C
P
U

D
D
I

D
D
O

C
R
A

D
D
I

D
D
O

A
V
I

1 32

A
V
I

A
V
O

S908

A
V
O

4

I/O
C
R
P
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the Head Setup command button.
Response: The Head Setup dialog is opened.

5 Enter a 7 in RIO Slot and quit the dialog using OK.
Response: The CRP-93x-00 module is automatically inserted in the component 
list (in slot 7) of the selected drop. In the Go To list box, the Local/RIO (Slot 7) 
network link is displayed.

6 Select the last line in the table.
Select the Insert command button.
Response: The second drop is entered in the Type column.
Note: The number of drops to be inserted is defined in the segment scheduler 
dialog. The default predetermines a maximum number of 32.
Dialog display 

7 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

Drop

1

Remote I/O...

Go To 

Delete Insert 

Copy Paste 

Quantum I/O

Type
Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

2 Quantum I/O 3 0 0 Edit…

To insert at the end of the list, select this line

Cut 

144

RIO (slot 4)

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the  CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Quantum Drop dialog:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2    CPU 1xMB+

DDI-353-00  1000011-3 100032 DC IN 24V 4x8

DDO-353-00   0000321-4  000001  DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

CPR-93x-00  1-7   RIO Head S908

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

None

Step Action

1 From the Rack Slot column select the 1-3 line.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: Parameters are not set for the CPS-214-00 and CPU-x13-0x modules.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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Editing Remote 
Drop

Editing of the I/O st. (Drop) defined second takes place in the dialog RIO (Slot 7) - 
Quantum I/O-St. 2.
This dialog can be reached in two ways:
l In the I/O Map dialog, using the Edit.... command button, or
l in the Local Quantum Drop dialog, using the Next command button.

Editing Remote Drop

Introduction This section describes the configuration of the second (remote) drop. The drop has 
already been defined in Editing the First (local) Drop (See Editing local drop, p. 736).
To edit the second (remote) drop, the modules must be specified with their I/O 
references before parameters for the individual modules can be set.
Quantum – remote controller with RIO 

1 Local Quantum drop 1

2 RIO master module

3 RIO slave module

4 RIO drop 2
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Mapping 
Modules and 
Specifying I/O 
References

To allocate the modules and specify the address ranges use the dialog RIO (slot 7) 
- Quantum I/O-St. 2 and proceed as follows:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column select the  CRA-93x-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see dialog representation 
RIO (Slot 7) Quantum Drop 2).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for individual modules use the dialog RIO (slot 7) - Quantum 
I/O-St. 2 and proceed as follows:

Input bits:

RIO (slot 7) - Quantum Drop 2

Drop

Cancel HelpOK

Module Detected In Ref

CRA-93x-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

RIO DROP S908

DDI-353-00  100033 1-2 100064   DC IN 24V 4x8

DDO-353-00  1-3 000033 DC OUT 24V 4x8

AVI-030-00  300033 1-4 300041   AN IN 8CH BIPOLAR

AVO-020-00   1-5  400033 400036 AN OUT 4CH VOLT

...  1-6   

...  1-7   

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

5

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

000064 

None

Step Action

1 From the Rack Slot column select the 1-2 line.
Response: The 1-2 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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E.2 Quantum Example - Remote control with RIO 
(series 800)

Introduction

Overview This Chapter contains the step-by-step process for the configuration of remote 
control with RIO (Remote I/O) and series 800 modules.

What’s in this 
section?

This section contains the following topics:

Topic Page

Editing Local Drop 744

Editing Remote Drop 748

Editing Remote Drop 751



Configuration examples

744 840 USE 493 00 September 2001

Editing Local Drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of all drops. 
When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set forindividual modules.
Quantum – remote controller with RIO (Series 800) 

1 Local Quantum drop 1

2 RIO master module

3 RIO slave module

4 RIO drop 2

5 Adapter module

6 RIO drop 3 with series 800 modules
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the Head Setup command button.
Response: The Head Setup dialog is opened.

5 Enter a 7 in RIO Slot and quit the dialog using OK.
Response: The CRP-93x-00 module is automatically inserted in the I/O map (in 
slot 7) of the selected drop. In the Go To list box, the Local/RIO (Slot 7) network 
link is displayed.

6 Select the last free row in the table, and insert the second drop with the 
command button Insert.
Response: The second drop is entered in the Type column of the table.
Note: The number of drops to be inserted is defined in the segment scheduler 
dialog. The default predetermines the maximum number of 32, so that settings 
are not necessary.

7 Select the last free row in the table again, and insert the third drop with the Insert 
command button.
Response: The second drop is entered in the Type column of the table.

8 Select the third drop and open the list box in the Type column. 
Select the 800 I/O option.
Dialog display 

I/O Map

Reserve for expansion:

Cancel HelpOK

144

Drop

1

Remote I/O...

Go To 

Delete Insert 

Copy Paste 

Quantum I/O

Type
Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

2 Quantum I/O 3 0 0 Edit…

3 800 I/O 3 0 0 Edit…

To insert at the end of the list, select this line

Cut Local/ RIO (slot 7) 

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

9 Select the first drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

Step Action

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Quantum Drop dialog:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2    CPU 1xMB+

DDI-353-00  1000011-3 100032 DC IN 24V 4x8

DDO-353-00   0000321-4  000001  DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

CPR-93x-00  1-7   RIO Head S908

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

None

Step Action

1 From the Rack Slot column select the 1-3 line.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: Parameters are not set for the CPS-214-00 and CPU-x13-0x modules.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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Editing Remote 
Drop

Editing of the I/O st. (Drop) defined second takes place in the dialog RIO (Slot 7) - 
Quantum I/O-St. 2.
This dialog can be reached in two ways:
l In the I/O Map dialog, using the Edit... command button, or
l in the Local Quantum Drop dialog, using the Next command button.

Editing Remote Drop

Introduction This section describes the configuration of the second (remote) drop. The drop has 
already been defined in Editing the First (local) Drop (See Editing Local Drop, 
p. 744).
To edit the second (remote) drop, the modules must be specified with their I/O 
references before parameters for the individual modules can be set.
Quantum – remote controller with RIO (Series 800) 

1 Local Quantum drop 1

2 RIO master module

3 RIO slave module

4 RIO drop 2

5 Adapter module

6 RIO drop 3 with series 800 modules
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Mapping 
Modules and 
Specifying I/O 
References

To allocate the modules and specify the address ranges use the dialog RIO (slot 7) 
- Quantum I/O-St. 2 and proceed as follows:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column select the  CRA-93x-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see dialog representation 
RIO (Slot 7) Quantum Drop 2).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for individual modules use the dialog RIO (slot 7) - Quantum 
I/O-St. 2 and proceed as follows:

Input bits:

RIO (slot 7) - Quantum Drop 2

Drop

Cancel HelpOK

Module Detected In Ref

CRA-93x-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

RIO DROP S908

DDI-353-00  100033 1-2 100064   DC IN 24V 4x8

DDO-353-00  1-3 000033 DC OUT 24V 4x8

AVI-030-00  300033 1-4 300041   AN IN 8CH BIPOLAR

AVO-020-00   1-5  400033 400036 AN OUT 4CH VOLT

...  1-6   

...  1-7   

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

5

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

000064 

None

Step Action

1 From the Rack Slot column select the 1-2 line.
Response: The 1-2 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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Editing Remote 
800 Drops

The third defined drop is edited in the RIO (Slot 7) - 800 Drop 3 dialog.
This dialog can be reached in two ways:
l In the I/O Map dialog, using the Edit.... command button, or
l in the RIO (Slot 7) - Quantum Drop 2 dialog using the Next command button.

Editing Remote Drop

Introduction This Section describes the configuration of the third (remote) drop. The drop has 
already been defined in Editing the First (local) Drop (See Editing Local Drop, 
p. 744).
To edit the third (remote) drop, the modules must be specified with their I/O 
references before the individual modules can be parameterized.

Quantum – remote controller with RIO (Series 800) 

1 Local Quantum drop 1

2 RIO master module

3 RIO slave module

4 RIO drop 2

5 Adapter module

6 RIO drop 3 with series 800 modules

Note: The J890 adapter module must be mounted in the rack of the third drop. 
However, this module is not visible either in the software or in the dialogs.
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges go to the RIO (slot 7) - 800 
drop 3 dialog and proceed as follows:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column select the B810 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see dialog representation 
RIO (slot 7) 800 drop 3).

5 In the Out Ref. column, enter the start references for the output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference of the available address range (Out End column) 
is entered automatically.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for individual modules go to the RIO (slot 7) - 800 drop 3 dialog 
and proceed as follows:

Input bits:

RIO (slot 7) - 800 drop 3

Drop

Cancel HelpOK

Module Detected In Ref

B810   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

000065 

Out End Description

8-OUT ISO

B804   1-2  400065 16-OUT

...  1-3

...   1-4     

...   1-5     

...  1-6   

...  1-7   

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   2-1  

...   2-2     

...   2-3     

Poll 

2

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

0
24

 

000072 

400065 

None

Step Action

1 From the Rack Slot column select the 1-1 line.
Response: The 1-1 text box has a dark background, i.e. the B810 module has 
been selected for editing.

2 Select the Params command button.
Response: The B810 dialog is opened.

3 Select the option button Discrete
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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E.3 Quantum Example - Remote Control with DIO

Introduction

Overview This Chapter contains the step-by-step process for the configuration of  remote 
control with DIO (Distributed I/O).

What’s in this 
section?

This section contains the following topics:

Topic Page

Editing Local Drop 755

Editing Local Drop 759
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Editing Local Drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of the drop. 
When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set forindividual modules.
Quantum – remote controller with DIO 

1 Local Quantum drop 1

2 DIO master module

3 DIO slave module

4 DIO drop 2
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Defining the 
Drop

To define the drop use Configure from the main menu and proceed as follows:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the Head Setup command button.
Response: The Head Setup dialog is opened.

5 Enter a 7 in NOM Slot 1 and quit the dialog using OK.
Response: The NOM module NOM-2xx-00 is automatically inserted in the I/O 
map (in slot 7) of the selected drop. In the Go to list box, the network link Local/
RIO (Slot ?) is displayed.
Dialog display 

6 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

144

Drop

1

Remote I/O...

Go To Local/RIO (slot ?)

Delete Insert 

Copy Paste 

Quantum I/O

Type
Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

To insert at the end of the list, select this line

Cut 

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the  CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Quantum Drop dialog:

Editing Remote 
Drop

To edit the remote drop with DIO, you must return to the I/O Map dialog and define 
the drop.

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

4272

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2  CPU 1xMB+

DDI-353-00  1000011-3 DC IN 24V 4x8

DDO-353-00   1-4  000001 000032 DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

NOM-2xx-00  1-7   MN1 MB+

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

 

 

 

100032

None

Step Action

1 From the Rack Slot column select the 1-3 line.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: Parameters are not set for the CPS-214-00 and CPU-x13-0x modules.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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Editing Local Drop

Introduction This section describes the configuration of the second (remote) drop. The 
processing sequence begins first of all with the definition of the drop. 
To edit the second (remote) drop, the modules must be specified with their I/O 
references before parameters for the individual modules can be set.

Quantum – remote controller with DIO 

1 Local Quantum drop 1

2 DIO master module

3 DIO slave module

4 DIO drop 2

Note: To link to the remote network, the coupling module CRA-21x-x0 must be 
entered during module mapping.
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Defining the 
Drop

To define the drop go to the I/O map dialog and proceed as follows:

Step Action

1 From the Go to list box, select the DIO 1 (Slot 7) network link.
Response: The drop entered in the table is no longer displayed.

2 Select the Insert command button.
Response: In the Type column, the Read/Write type is entered.
Dialog display 

3 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

144

Drop

1

Remote I/O...

Go To 

Delete Insert 

Copy Paste 

Read/Write

Type
Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

To insert at the end of the list, select this line

Cut DIO1 (slot ?)

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges use the DIO 1 (slot 7) - 
Drop 1 dialog and proceed as follows:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column select the CRA-21x-x0 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see dialog representation 
DIO (slot 7) Quantum drop 1).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for individual modules use the DIO 1 (slot 7) - Drop 1 dialog and 
proceed as follows:

Input bits:

RIO (slot 7) - Quantum Drop 2

Drop

Cancel HelpOK

Module Detected In Ref

CRA-21x-x0   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

DIO DROP MB+

DDI-353-00  100033 1-2 100064   DC IN 24V 4x8

DDO-353-00  1-3 000033 DC OUT 24V 4x8

AVI-030-00  300033 1-4 300041   AN IN 8CH BIPOLAR

AVO-020-00   1-5  400033 400036 AN OUT 4CH VOLT

...  1-6   

...  1-7   

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

5

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

000064 

None

Step Action

1 From the Rack Slot column select the 1-2 line.
Response: The 1-2 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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E.4 Quantum Example – INTERBUS Control

Introduction

Overview This Chapter contains the step-by-step process for the configuration of INTERBUS 
control with the Quantum.

What’s in this 
section?

This section contains the following topics:

Topic Page

General Information 764

Editing Local Drop 765
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General Information

Introduction INTERBUS control using Quantum occurs via module NOA-611-10. During this 
process the module collects the words of all remote bus nodes and creates a 
telegram with status information and I/O words. The telegram is then transferred to 
the CPU, so that the NOA behaves like an I/O module.

Parameterization Command sequence parameterization (restart procedure) occurs in the CMD Tool, 
produced by the PHÖNIX firm (see also " NOA 611 1 restart procedure" with an 
example for parameterizing the command sequence in CMD Tool).

Note: Using branch interfaces in the remote bus, remote bus branches with further 
remote bus nodes (TIOs) can be constructed. However, the branch interfaces can 
only be inserted in the remote bus, not in the remote bus branch.
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Editing Local Drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of the drop. 
When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set for individual modules.

Quantum - INTERBUS controller 

1 Local Quantum Drop

2 INTERBUS master module

3 Remote bus without branch interface

Note: When the NOA-611-00 module is entered in the I/O map, the loadable ULEX 
is automatically installed.
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Note: The configuration of remote bus nodes does not take place in Concept and 
is therefore not apparent in the I/O map. To edit the remote bus nodes, you must 
use the CMD tool produced by the PHÖNIX firm (Configuration Monitoring and 
Diagnostic Software).

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Use OK return to the PLC 
Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.
Dialog display 

4 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

144

Drop

1

Remote I/O...

Go To 

Delete Insert 

Copy Paste 

Quantum I/O

Type Supervision Time

3

In bits

0

Out bits

0

Status Edit

Edit…

To insert at the end of the list, select this line

Cut Local/RIO (slot ?)
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the  CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Quantum Drop dialog:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

4272

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2  CPU 1xMB+

DDI-353-00  1000011-3 DC IN 24V 4x8

DDO-353-00   1-4  000001 000032 DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

NOA-611-00  3000101-7 300276 400005 400268 IBS-Head (Mode2)

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

 

 

 

100032

None

Step Action

1 From the Rack Slot column select the 1-3 line.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: Parameters are not set for the CPS-214-00 and CPU-x13-0x modules.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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E.5 Quantum Example - SY/MAX Controller

Introduction

Overview This Chapter contains the step-by-step process for the configuration of a SY/MAX 
controller.

What’s in this 
section?

This section contains the following topics:

Topic Page

Editing Local Drop 770

Editing Remote Drop 774
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Editing Local Drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of all drops. 
When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set forindividual modules.
Quantum – SY/MAX controller 

1 Local Quantum drop 1

2 RIO master module

3 SY/MAX drop 2
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the Head Setup command button.
Response: The Head Setup dialog is opened.

5 Enter a 7 in RIO Slot and quit the dialog using OK.
Response: The CRP-93x-00 module is automatically inserted in the I/O map (in 
slot 7) of the selected drop. In the Go To list box, the Local/RIO (Slot 7) network 
link is displayed.

6 Select the last line in the table.
Select the Insert command button.
Response: The second drop is entered in the Type column.
Note: The number of drops to be inserted is defined in the segment scheduler 
dialog. The default defines a maximum number of 32.

7 Select the second drop and in the Type column, open the list box.
Select the SY/MAX option.
Dialog display 

8 Select the first drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for expansion:

Cancel HelpOK

144

Drop

1

Remote I/O...

Go To 

Delete Insert 

Copy Paste 

Quantum I/O

Type Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

2 SY/MAX 3 0 0 Edit…

To insert at the end of the list, select this line

Cut Local/RIO (slot 7)

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the  CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Quantum Drop dialog:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2    CPU 1xMB+

DDI-353-00  1000011-3 100032 DC IN 24V 4x8

DDO-353-00   0000321-4  000001  DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

CPR-93x-00  1-7   RIO Head S908

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

None

Step Action

1 From the Rack Slot column select the 1-3 line.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: Parameters are not set for the CPS-214-00 and CPU-x13-0x modules.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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Editing Remote 
Drop

Editing the drop defined second takes place in the dialog RIO (slot 7) – SY/MAX 
I/O-St. 2.
This dialog can be reached in two ways:
l In the I/O Map dialog, using the Edit.... command button, or
l in the Local Quantum Drop dialog, using the Next command button.

Editing Remote Drop

Introduction This section describes the configuration of the second (remote) drop. The drop has 
already been defined in Editing the First (local) Drop (See Editing Local Drop, 
p. 770).
To edit the second (remote) drop, the modules must be specified with their I/O 
references before parameters for the individual modules can be set.

Quantum – SY/MAX controller 

1 Local Quantum drop 1

2 RIO master module

3 SY/MAX drop 2

Note: To link to the remote network, the coupling module CRM-931-RG must be 
entered during module mapping.
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the 
RIO (slot 7) – SY/MAX I/O-St. 2 dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column select the CRM-931-RG module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see dialog representation 
RIO (Slot 7) SY/MAX Drop 2).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.
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Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To parameter the individual modules use the dialog RIO (slot 7) – SY/MAX 
I/O-St. 2 and proceed as follows:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CRM-931-RG   1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End Description

REG RMT IF

RIM-101/361  100033 2 100048  16 IN AC/DC

ROM-121  3 400005 4 OUT ANLG

SIM-116  100049 4 100064   16 IN SIM

...   5     

...  6   

...  7   

...   8   

...   9  

...   10     

...  11   

...   12  

...   13     

...   14     

Poll 

4

Previous Next 

ASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

32
64

400008 

 

 

None

Step Action

1 In the Slot column, select line 2.
Response: The 2 text box has a dark background, i.e. the RIM-101/361 module 
has been selected for editing.

2 Select the Params command button.
Response: The 8030-RIM-101/361 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes set with different parameters. Help with this 
can be obtained from the corresponding help texts in the parameter dialog.
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E.6 Quantum Example - Profibus DP Controller

Introduction

Overview This Chapter contains the step-by-step process for the configuration of a Profibus 
DP controller with the Quantum.

What’s in this 
section?

This section contains the following topics:

Topic Page

General Information 778

Example 7 - Profibus DP Export Settings in SyCon 778

Editing Local Drop 780

Importing Profibus DP Configuration 784
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General Information

Introduction Configuring Profibus DP is done using the SyCon (System Configurator) software 
produced by Hilscher GmbH. It is initially stored there as a file (*.CNF). This 
generated file is loaded into Concept and is visible in the I/O map of the configurator.
Before the Profibus DP nodes (max. 32) can be imported, a bus controller (CRP 811 
00) must be mapped in the drop (Quantum I/O). Depending on the CPU selection in 
the Select Extensions dialog box, a maximum of two to six bus controllers can be 
inserted.

Example - Profibus DP Export Settings in SyCon

Introduction SyCon is used to configure Profibus DP. The procedure for this is to be found in the 
user manual provided by the manufacturer. The settings for the export of the *.CNF 
file are explained in the following step-by-step instructions.

Preconditions For CRP-811-00 diagnostics the serial interface of the host computer and the 
diagnostic interface of the bus controller must be linked with a V24 cable.
To display this diagnostic data, terminal emulation software must be started (e.g. 
PROCOMM using the settings: 19.2 kBd, 8 data bits, 1 stop bit, no parity).

Defining the 
Destination 
Directory

Firstly, specify the destination directory in which all files are to be saved:

Step Action

1 Select in the main menu Settings → Search Path....
Response: The Search Path dialog is opened and is pre-set with the SyCon 
directory path as the project directory (e.g. C:\HILSCHER 
GMBH\SYCON\FIELDBUS\PROFIBUS).

2 Enter the path of the Concept directory (e.g. C:\CONCEPT\PROFIBUS) in the 
Project Directory text box.
Note: You can also accept the default.
Response: Execution of the Save and Export menu commands (in the File 
main menu) saves all files in the entered Concept directory.
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Generating an 
Export File

To generate an export file (*.CNF) proceed as follows:

Note about 
Saving

The configuration must always be saved as a database file *.PB first, only then can 
an ASCII file be generated from the saved *.PB file. Every change must therefore 
also be saved as a *.PB file first, before an ASCII file can be generated for export. 
The files *.PB and *.CNF should always be saved in the same project directory.

Profibus DP 
Configuration in 
Concept

After the Profibus DP nodes have been configured in SyCon, the Profibus DP 
configuration is imported into the Concept I/O map.
An example of configuration and import is described in the chapter "Editing a Local 
Drop (See Editing Local Drop, p. 780)".

Step Action

1 Select in the main menu File → Save → *.PB.
Response: The configuration is stored as a database file *.PB in the specified 
directory.

2 Select in the main menu File → Export → ASCII.
Response: The configuration is stored as an ASCII file *.CNF in the specified 
directory.

3 Exit SyCon and start Concept.
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Editing Local Drop

Introduction This section describes the configuration of the first (local) drop.
For Profibus DP configuration the CRP-811-00 coupling module must be registered 
in the I/O map. The configuration defined in SyCon is loaded into Concept as the 
generated *.CNF file is imported into the parameter dialog of the CRP-811-00 
coupling module.

When editing the first (local) drop the modules must be set with their I/O references 
before the individual modules can be parameterized.
Quantum – Profibus DP controller 

1 Device data base for CRP-811-00 (load onto SyCon)

2 Host computer for Concept and SyCon

3 V24 cable

4 Local Quantum drop 1

5 RIO master module

6 Profibus DP configuration (External modules)

Note: For an error free transfer of the Profibus DP configuration, it should be 
ensured that sufficient memory is available. To optimize storage occupancy open 
the dialog PLC Memory Partition (PLC Configuration → PLC Memory 
Partition).
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC Selection dialog is opened.

2 Select the Quantum PLC family and a CPU x113 xx. Using OK return to the 
PLC Configuration window.

3 Select Config. Extensions → Select Extensions list.
Response: The Select Extensions dialog is opened.

4 In the Profibus DP list box select the 1 option.
Response: The coupling module then appears in the I/O Module Selection 
dialog and can be used in the I/O map.

5 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.
Dialog Representation 

6 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

144

Drop

1

Head setup... 

Go To Local/RIO (slot ?)

Delete Insert 

Copy Insert 

Quantum I/O

Type
Supervision

3

In bits

0

Out bits

0

Status Edit

Edit…

To insert at the end of the list, select this line

Cut 

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the  CPS-214-00 module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference of the available address range (In End or Out 
End column) is entered automatically.
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Dialog 
Representation

Following module mapping and I/O reference specification, the dialog looks like this: 

Parameter-
ization of 
Modules

To parameterize the individual modules, proceed as follows in the Local Quantum 
Drop dialog:

Input bits:

Local Quantum Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPS-214-00   1-1

Delete

Modules:

Module

0

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

DC SUMMABLE PS 2

CPU-x13-0x   1-2    CPU 1xMB+

DDI-353-00  1000011-3 100032 DC IN 24V 4x8

DDO-353-00   0000321-4  000001  DC OUT 24V 4x8

AVI-030-00  300001 1-5 300009   AN IN 8CH BIPOLAR

AVO-020-00  1-6 400001 400004 AN OUT 4CH VOLT

CRP -811 -00  1-7   PROFIBUS DP

...   1-8   

...   1-9  

...   1-10     

...  1-11   

...   1-12  

...   1-13     

...   1-14     

Poll 

7

Previous Next 

NoneASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

176
96

Step Action

1 From the Rack Slot column, select line 1-3.
Response: The 1-3 text box has a dark background, i.e. the DDI-353-00 module 
has been selected for editing.
Note: The CPS-214-00 and CPU-x13-0x modules are not parameterized.

2 Select the Params command button.
Response: The 140-DDI-353-00 dialog is opened.

3 Select the Discrete option button.
Response: You return to the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example.
Note: The modules are sometimes parameterized differently. Help with this can 
be obtained from the corresponding help texts in the parameter dialog.
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Importing a 
Profibus DP 
Configuration

Importing configured Profibus DP nodes occurs in the parameter dialog of the CRP-
811-00 coupling module. This dialog opens when you select the CRP-811-00 row 
from the I/O map and press the Params command button.

Importing Profibus DP Configuration

Introduction This section describes the import of the Profibus DP configuration. After that, further 
parameter settings for the master take place and the I/O map can be established.

Downloading a 
Profibus DP 
Configuration to 
Concept

To import, proceed as follows:

Step Action

1 Select the Import... command button.
Response: The Select Import File standard window is opened.

2 Enter the path of the previously generated *.CNF file and exit the dialog with OK.
Response: The transfer of the *.CNF file is displayed in the Import Status 
dialog.

3 Close the dialog after the transfer (100%).
Response: The imported configuration is displayed in the CRP-811-00 
(Profibus DP)  dialog.
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Dialog 
Representation

Following the import of the configuration, the dialog looks like this (view scrolled all 
the way to the left): 

Cut

CRP-811-00 (Profibus DP)

Master

Cancel HelpOK

Delete

Bus address: Slot: 7 Delete

Copy

Parameters...

Paste

Poll

1

Module In Ref

170 DNT 110 10  11

Bus-Adr.

 100081 

170 BDM 344 00/01 10016112

170 DNT 110 10  13

 100177 

170 DNT 110 10  14

 100193 

170 DNT 110 10  15

 100209 

170 DNT 110 10  16

 100465 

 

Module

1

 

 

1

 

1

 

1

 

1

 

In Type Out Type

Import... Presettings

Out Ref

 

000081

000161

 

 

 

000177

 

000193

 

 

 

 

 

 

 

 

 

Out End

 

000160

000176

 

 

 

000192

 

000448

 

 

 

 

 

 

 

 

 

In End

 

100160

100176

 

100192

 

100208

 

100464

 

100480

Parameters...

Slave

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL
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Following the import of the configuration, the dialog looks like this (view scrolled all 
the way to the right): 

Note: In the Slave range, the Parameters... command button is used for 
displaying slave parameters. The slave modules are, however, parameterized in 
SyCon (see SyCon software user manual).

CRP-811-00 (Profibus DP)

Cancel HelpOK Poll
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Parameterizing 
the Master

To parameterize the master, proceed as follows:

Step Action

1 In the Master range, select the Parameters... command button.
Response: The DP Master Parameters dialog is opened.
Dialog Representation 

2 Accept the defaults, as shown in the figure above, or redefine them. 

3 Close the dialog using OK. 
Response: You return to the CRP-811-00 (Profibus DP) dialog.

Cancel HelpOK

DP-Master-Parameter

1Bus-Address

12 MBaudBaudrate

100Max. Diag. inputs

32Max. Diag. lengths

467Live character 3x:
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Setting I/O 
References

To set the I/O references proceed as follows:

Step Action

1 Select the command button Preset. ....
The Preset dialog is opened.
Dialog Representation 

2 Accept the defaults, as shown in the figure above, or redefine them. 

3 Close the dialog using OK. 
Response: You return to the CRP-811-00 (Profibus DP) dialog, in which the 
defined reference ranges have automatically been entered.

Cancel HelpOK

Presetting

Input Refs

1x 1

3x 1

I/O assignment
Output Refs

0x 1

4x 1

Diag Ref

3x 1



Configuration examples

840 USE 493 00 September 2001 789

Dialog 
Representation

After the I/O references have been set the dialog looks like this (view scrolled all the 
way to the left): 

Cut
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After the I/O references have been set the dialog looks like this (view scrolled all the 
way to the right): 

CRP-811-00 (Profibus DP)
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E.7 Quantum-Example - Peer Cop

At a glance

Introduction In this chapter the configuration of Peer Cop is described step by step.

What’s in this 
section?

This section contains the following topics:

Topic Page

Generals to Peer Cop 792

Configuration of Peer Cop 793

Global data transfer 795

Specific data transfer 797
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Generals to Peer Cop

Introduction Peer Cop is a data exchange service provided by the Modbus Plus network. As an 
overview, imagine that every Modbus Plus network segment (max. 64 nodes) has a 
global memory, i.e. a certain number of global variables can be read by every node 
connected to the same segment. The total amount of global variables depends on 
the number. of connected (and active) nodes, every node can provide up to 32 
words (16 bit) to the global memory. Only the 32 words provided by a node can be 
written by the same node, all other nodes have read only access to these variables. 
So by definition, there is a maximum of 64 * 32 words of global memory available to 
a Modbus Plus network segment. Nodes connected to different (through bridges or 
gateways) segment cannot share global memory.
When a PLC provides 32 words of global memory it does so by assigning holding 
registers for broadcast, and when the PLC wants to read global variables provided 
by another Peer Cop node,  assigning holding registers to receive them. These 
registers are called Global Input (from other nodes) and Global Output (what this 
node provides) get updated cyclically (in case of a PLC after every scan).

To pass Routing 
Paths

Actually every Modbus Plus node has its own communication processor (the so 
called Peer processor), in addition to the processor that controls the node specific 
work (in case of a PLC: solving user logic). 
This leads to some routing paths the global data has to pass to traverse from one 
node to the other:
l From the data provider (e.g. user logic) to the local (most times embedded peer 

processor).
l From the local peer processor to the other peer processors (this takes the token 

cycle time of the Modbus Plus network segment, that depends directly on the 
number of connected nodes).

l From the peer processor of the data receiver to the data receiver itself, (that is 
usually the user logic in the receiver PLC).

The actual update time depends on the speed of the Modbus Plus network segment 
and (that’s the big time consumer) the scan times of the data provider and the data 
receiver.
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Send directly But the sharing of global memory is just the first part of the full Peer Cop service. 
Since the gobal memory architecture requires a setup (or configuration) for both 
communication partners, there is another subservice to communicate directly with 
rather than Configure nodes. This service is somewhat like a master to slave 
communication, where the master knows what data to send and the slave expects 
data in a fixed layout and uses this data in a fixed manner (like Terminal I/O). The 
limit of data that can be sent from the master to the slave is also 32 words. This 
mode is not global data, since it is sent from one node directly and explicitly to one 
other node. The sender specifies this as specific output and the receiver as specific 
input (this specification is hardwired on nonintelligent modules like Terminal I/O). 
The specific output and input words are also assigned to holding registers when a 
PLC makes use of this Peer Cop service.
Since both, global and specific data transfer, depend on scan time of the PLC’s 
which provide and use this data in their logic, there is no big performance difference 
with the transfer from one holding register to the other registers.

Configuration of Peer Cop

Define Peer Cop 
functionality

Before configure a Peer Cop you must activate the check box Peer Cop in the dialog 
box Select Extensions.

Note: Since every PLC can be connected to up to 3 different Modbus Plus network 
segments, you can setup Peer Cop for every connection separately (remember 
Peer Cop is reduced to one segment, it doesn’t work through bridges).
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Peer Cop 
settings

To configure a Peer Cop, proceed with the following steps:

Step Action

1 In the window PLC Configuration with the menu command Config. Extensions 
→ Peer Cop open the dialog box Peer Cop.

2 Assume the default value 100 in the text field Expansion Size:.
Note: This text field is just a space of memory (in words) that gets reserved for 
future changes (in offline mode) that shall not cause the necessity for a complete 
download (this is especially importent for direct application setup at a plant).

3 Select the option button Link 0 (CPU) in the area Go To.

4 Assume the default value 500 in the text field Health timeout (msec.):.
Note: The Health timeout value has the same meaning as it has in the I/O map 
for local and remote I/O.

5 Select the option button Hold on timeout in the area Last value.
Representation of the dialog: 

Peer Cop

Cancel HelpOK

Expansion Size: 100

Last value

Hold on timeout

Clear on timeout

Global

Input...

Output...

Specific

Input...

Output...

Go To

Link 1 [Head Slot ?]

Link 0 [CPU]

Health timeout [msec.]: 500

Link 2 [Head Slot ?]

0

0
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Global data transfer

Global Input For Global Input proceed as follows:

Step Action

1 For global data transfer open the dialog box Gobal Input by clicking the 
command button Input... in the area Global.

2 Select node 10 in the list box of the left side of the dialog box.

3 Enter the Destination register, the index, the length and the Bin/BCD Code in the 
text field of the dialog box, as shown in the figure.
Representation of the dialog box: 

Result: The holding register 400040 gets the first word of global output data of 
node 10, therefore this is global input data for this PLC. If the length value is 
higher, lets say 2, register 400041 would get the second word of global output 
data of node 10. The index value declares with what word the assignment shall 
start, in this case with the first word. The BIN/BCD column gives you the choice 
of getting the global data formatted either into the usual binary format or into 
binary coded decimals.
The index value may not be higher than 32, since every node can provide a 
maximum of 32 word only for global output data. The lenght value may also not 
be higher than 32 for the same reason.

4 Close the dialog box Global Input with the command button OK.

Global Input

(1-64)

7
8
9
10*
11
12

14
15
16

Clear Subfields

Cancel HelpOK

Range:

Subfield

1

2

3

4

5

6

7

8

400001-401872

400040

1-32

Index

1

Length

1

1-32

Bin/BCD

BIN

13

Dest. Ref.
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Global Output For Global Output proceed as follows:

Step Action

1 Open the dialog box Gobal Output by clicking the command button Output... in 
the area Global.

2 Enter the Source register, the length and the Bin/BCD Code in the text field of 
the dialog box, as shown in the figure.
Representation of the dialog box: 

3 Close the dialog box Global Output with the command button OK.

Global Output

Cancel HelpOK

Range:

Dest. Node

All Nodes

300001-300512

300020

Length

10

1-32

Bin/BCD

BIN

Source Ref.
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Specific data transfer

Specific Input For Specific Input proceed as follows:

Step Action

1 For specific data transfer open the dialog box Specific Input by clicking the 
command button Input... in the area Specific.

2 Enter the Destination register, the length and the Bin/BCD Code in the text field 
of the dialog box, as shown in the figure.
Representation of the dialog box: 

Result: If node 10 has declared some specific output, which gets delivered with 
every token cycle on the Modbus Plus network segment (which is usually faster 
than the updating by the controller’s user logic), that gets sent to holding register 
400040. And if it is more than one word, it gets stored in the following holding 
register, up to 400019 in this example. The formatting can also be either binary 
or binary coded decimals.

3 Close the dialog box with the command button OK.

Specific Input

Cancel HelpOK

Range: 400001-401872 1-32

Source Dest. Ref. Length Bin/BCD

1

2

3

4

5

6

7

8

9

10 400040 20 BIN

11

12
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Specific Output For Specific Output proceed as follows:

Step Action

1 Open the dialog box Specific Output by clicking the command button Output... 
in the area Specific.

2 Enter the Destination Reference register, the length and the Bin/BCD Code 
option in the text field of the dialog box, as shown in the figure.
Representation of the dialog box: 

Result: The values or registers 300030 to 300032 will be sent to node 20 (Target 
Source) in binary format.

3 Close the dialog box with the command button OK.

Specific Output

Cancel HelpOK

Range: 300001-300512 1-32

Dest. Node Source Ref. Length Bin/BCD

13

14

15

16

17

18

19

20

21

22

300030 3 BIN

23

24
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E.8 Compact Example

Editing Local Drop

Introduction This section describes the configuration of the first (local) drop.
When editing the first (local) drop the modules must be set with their I/O references 
before the individual modules can be parameterized.

Compact controller 

Note: The communication module MVB258A is parameterized in the TCN tool 
(Train Communication Network). A parameterization file (binary file) is generated 
and imported into the Concept parameter dialog.
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC Selection dialog is opened.

2 Select the Compact PLC family and a PC-E984-258. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.
Dialog Representation 

4 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

144

Drop

1

Head setup... 

Go To Lokal/RIO

Delete Insert 

Copy Paste 

Compact I/O

Type
Supervision

3

In bits

0

Out bits

0

Status Edit

Edit…

Cut 

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
TSX Compact Drop dialog:

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 In the Modules column, select the MVB258A module.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Dialog 
Representation Local TSX Compact Drop).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference of the available address range (In End or Out 
End column) is entered automatically.
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Dialog 
Representation

Following module mapping and I/O reference specification, the dialog looks like this: 

Input bits:

Local TSX Compact Drop

Drop

Cancel HelpOK

Module Detected In Ref

CPU   1-1

Delete

Modules:

Module

16

Copy 

Params

Rack-Slot In End

 

Out Ref

 

Out End

 

Description

TSX COMPACT

CPU   1-2    TSX COMPACT

MVB258A  3000011-3 300001 400001 400001 MVB Controller w/RS232

...   1-4     

...   1-5     

DEP214/254  1000012-1 100016   DC 16-IN 12-60V

DEP2x6/2x7  1000172-2 100032   DC 16-IN

DAP210   2-3  000001 000008 AC 8-OUT 115/230V 

DAP208/258   2-4  000009 000016 8-OUT 24..110VDC/24

...   2-5     

ADU206/256  3000653-1 300069   Analog 4 In

DAU2x2   3-2  400002 400003 An Out 2 ch Volt or Cu

...   3-3     

...   3-4     

Poll 

7

Previous Next 

NoneASCII Port No.:

Cut Paste Delete

16Output bits:Input bits:
Output bits:
Status table:

128
64
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Parameter-
ization of 
Modules

To parameterize the individual modules proceed as follows in the Local TSX 
Compact Drop dialog:

Step Action

1 From the Rack Slot column, select line 1-3.
Response: The 1-3 text box has a dark background, i.e. the MVB258A module 
has been selected for editing.
Note: The CPU module is not parameterized.

2 Select the Params command button.
Response: The AS-BMVB258A dialog is opened.

3 Select the Select command button.
Response: The Select MVB Import File dialog is opened.

4 Set the path of the parameterization file generated in the TCN tool, and exit the 
dialog using OK.
Response: The selected parameterization file is displayed in the text box in the 
AS-BMVB258A dialog.

5 Select the Do Import command button.
Response: The project data of the parameterization file is transferred to 
Concept and displayed in the lower list box.
Dialog Representation 

6 Exit the dialog using OK.

7 Repeat steps 1 to 2 for all the modules in the example.
Note: The modules are sometimes parameterized differently. Help with this can 
be obtained from the corresponding help texts in the parameter dialog.

AS-BMVB258A

Cancel HelpOK

Select...

001:0000 0000 0000 0000 0000 0000 0000 0000

*.mv1

009:0000 0000 0000 0000 0000 0000 0000 0000
017:0000 0000 0000 0000 0000 0000 0000 0000
025:0000 0000 0000 0000 0000 0000 0000 0000

Start import

Project:

Version:

Generation Date:

Traffic Store:

SW Version:

Device address:

1

157

7

24/12/96

test examp.tool
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E.9 Atrium Example – INTERBUS Controller

Introduction

Overview This Chapter contains the step-by-step process for the configuration of an 
INTERBUS controller with Atrium (PC based).

What’s in this 
section?

This section contains the following topics:

Topic Page

General Information 805

INTERBUS Export Settings in CMD 805

Editing Local Drop 806

Editing Remote Drop (Importing INTERBUS Configuration) 810
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General Information

Introduction The configuration of the INTERBUS is done using the PHÖNIX software CMD. It is 
initially stored as a file (*.SVC). This generated file is loaded into Concept and is 
visible in the I/O map of the configurator.
Before the INTERBUS nodes are imported, set up the first drop (Atrium I/O) with the 
CPU board (180-CCO-121-01 and 180-CCO-241-01) and the INTERBUS master 
(CRP-660-00). A maximum of two INTERBUS masters may be inserted. The 
diagnosis of the field bus can take place in the CRP-660-00 register in Concept.

INTERBUS Export Settings in CMD

Introduction The CMD tool (Configuration Monitoring and Diagnostic tool) is used to configure the 
INTERBUS. For information about this, refer to the corresponding chapter in the 
Phoenix user manual.

Preconditions The serial interface of the host computer and the diagnostic interface of a PC104 
board must be linked with a V24 cable.

Implementing 
Export Settings

Before you import the configuration into Concept, carry out the following settings in 
the CMD tool:

Step Action

1 Select Configuration → Controller Board → Data Type....

2 Select IBS PC104 SC-T and confirm the selection using OK.

3 Select File → Operating State....
Response: The Operating State dialog is opened.

4 Activate the Configuration (Online) option button and exit the dialog using OK.

5 Under Configuration → Controller Board → Control select the command 
Activate Configuration Frame. Confirm with Yes.
Response: A configuration frame is generated.

6 Select Configuration → Configuration Frame → Read Again.
Response: The configuration is read into the frame.

7 Under Configuration → Parameterization Memory → Write ASCII File select 
the command INTERBUS Data (*.SVC)....
Response: The INTERBUS data is stored in a file.

8 Enter the directory and the file name in the open dialog and confirm using OK.

9 Select File → Save As....
Response: The INTERBUS project is saved.
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Editing Local Drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of all drops. 

When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set forindividual modules.
Atrium –INTERBUS Controller 

1 Host computer for Concept and CMD

2 V24 cable

3 PC104 board on a standard AT board

4 INTERBUS configuration

Note: For an error free transfer of the INTERBUS configuration, it should be 
ensured that sufficient memory is available. To optimise the storage allocation 
open the PLC Memory Partition dialog (PLC Configuration → PLC Memory 
Partition).

1

2 INTERBUS INTERBUS INTERBUS

3

4

C
C
O

C
R
P

MB+
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the Atrium PLC family and a 180-CCO-121-01. Using OK return to the 
PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Enter a 7 in RIO Slot and quit the dialog using OK.
Response: The CRP-93x-00 module is automatically inserted in the I/O map (in 
slot 7) of the selected drop. In the Go To list box, the Local/RIO (Slot 7) network 
link is displayed.

5 Select the last line in the table.
Select the Insert command button.
Response: The second drop is entered in the Type column.
Note: The number of INTERBUS masters to be inserted is limited to two drops.
Dialog display 

6 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for

Cancel HelpOK

Drop

1

Go To 

Delete Insert 

Copy Paste 

Atrium I/O

Type
Supervision 

3

In bits

0

Out bits

0

Status Edit

Edit…

2 Interbus S 3 0 0 Edit…

To insert at the end of the list, select this line

Cut 

144

Local/RIO

Time
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Setting I/O 
References

In the Local Atrium Drop dialog the INTERBUS master CRP-660-00 is 
automatically entered in the I/O map.
For the specification of the I/O references, enter the start references in the In Ref. 
and Out Ref columns. After the start reference has been entered, the end reference 
of the available address range of the module is automatically displayed.

Dialog display 

Note: Discrete input references have the prefix 1 (e.g. 100001), coil references 
have the prefix 0 (e.g. 000001), input register references have the prefix 3 (e.g. 
300001) and output register references have the prefix 4 (e.g. 400001).

Input bits:

Local Atrium I/O I/O Station

Drop

Cancel HelpOK

Module Detected In Ref

CCO-12000   1

Delete

Modules:

Module

480

Copy 

Parameter...

Slot In End

 

Out Ref

 

Out End

CRP-660-00  300001 2 300030 400001 

...  3

...   4     

Poll 

2

Previous Next 

NoneASCII Port No.:

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

480
32

 

 

400002 

Atrium Board
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Set Module 
Parameters

To set parameters for the INTERBUS master proceed in the following way in the 
Local Atrium Drop dialog:

Editing Remote 
Drop

To edit the remote drop open the INTERBUS Drop 2 dialog. This dialog is reached 
via the I/O map dialog by pressing the Edit... command button in the second drop. 
(INTERBUS).

Step Action

1 In the Slot column, select line 2.
Response: The 2 text box has a dark background, i.e. the CRP-660-00 module 
has been selected for editing.
Note: Parameters are not set for CCO-12000 module.

2 Select the Params command button.
Response: The CRP-660-00 dialog is opened.

3 Press the option buttons as shown in the following figure and exit the dialog using 
OK.
Note: Help with setting parameters is obtained via the dialog’s help text.
Dialog display 

CRP 660 00

Cancel HelpOK

Output timeout status

Set to zero Retain previous value

Addressing mode

MSB left (IBS) MSB right (984)

IBS Start behavior

Compl. config. necessaryPart. config. allowed
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Editing Remote Drop (Importing INTERBUS Configuration)

Introduction This section describes the import of the INTERBUS configuration. The assignment 
of I/O references takes place in the import dialog before the transfer of the 
configuration file is performed.

Atrium –INTERBUS Controller 

1 Host computer for Concept and CMD

2 V24 cable

3 PC104 board on a standard AT board

4 INTERBUS configuration

Note: The module parameters are set in the CMD tool (see CMD tool user 
manual), because the imported modules are not recognized in Concept.

1

2 INTERBUS INTERBUS INTERBUS

3

4
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Setting I/O 
References

To specify the address ranges proceed as follows in the INTERBUS Drop 2 dialog:

Step Action

1 Select the Import... command button.
Response: The Import IBS Configuration dialog is opened.

2 Check the Overwrite IBS Drop box.
Response: The Do I/O Mapping check box becomes available.

3 Check the Do I/O Mapping check box.
Response: The Digital Module in 3x/4x Range check box and the Input 3x 
and Output 4x text boxes become available.

4 Uncheck the Digital Module in 3x/4x Range check box.
Response: The Input 1x and Output 0x text boxes become available.

5 Enter the value 100 in the Input 3x and Output 4x text boxes.
Response: The 3x and 4x address ranges of the imported module begin with the 
start references 300100 and 400100.
Note: The 1x and 0x address ranges retain the default value 1, i.e. these address 
ranges begin with the start references 100001 and 000001.
Dialog display 

6 Exit the dialog with OK.
Response: The Select Import File dialog is opened.

7 Enter the path of the configuration file *.SVC.
Select OK.
Response: The Dialog Import Status dialog is opened, the file transfer starts, 
and the import status is displayed.

8 Following the transfer (100%), close the dialog.
Response: The imported INTERBUS configuration is displayed in the 
INTERBUS Drop 2 dialog in the I/O map.

Cancel HelpOK

Import IBS configuration

Overwrite IBS Drop

Do I/O mapping

Options
Input

1x 1

3x 100

Output

0x 1

4x 100
Map Discretes to 3x/4x

Start refs. For I/O assignment
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Dialog display Following the import of the INTERBUS configuration, the dialog looks like this: 

Input bits:

Interbus 8 I/O St. 2

Drop

Cancel HelpOK

Module Detected In Ref

BK-012-00   1

Delete

Modules:

Module

0

Copy 

Parameter...

No. In End

 

Out Ref

 

Out End Description

DIO-003-16  100001 2 100016 000001 

DIO-011-16  1000173 000017

DI-130-16  100033 4 100048    

AD-065-64   5  400100 400103  

DO-129-16  6 000033 000048 

BK-052-00  7   

AIO-067-64  300100 8 300103 400104  

PCP-203-00   9  

DI-002-16  100049 10 100064    

DO-001-16  11 000049 

DIO-003-16  100065 12 100080 000065

...   13     

...   14     

Poll 

12

Previous Next 

NoneASCII Port No.:

Cut Paste Delete

16Output bits:Input bits:
Output bits:
Status table:

144
206

000032 

 

000016 

100032

400107 

000064 

000080 
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E.10 Momentum Example - Remote I/O Bus

Introduction

Overview This Chapter contains the step-by-step process for the configuration of a remote I/
O bus (Momentum).

What’s in this 
section?

This section contains the following topics:

Topic Page

General Information 814

Editing local drop 814

Example 10 – Editing Remote Drops (I/O Bus) 818
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General Information

Introduction TSX Momentum is a modular system. Bus adapters (e.g. 170 INT 110 00) and CPU 
adapters (e.g. 171-CCC-760-10-IEC) work in conjunction with an I/O unit as 
independent modules. In order to function properly, each I/O unit must be equipped 
with an adapter.

Editing local drop

Introduction This section describes the configuration of the first (local) drop. The processing 
sequence begins first of all with the definition of all drops. 
When editing the first (local) drop the modules must be set with their I/O references 
before parameters can be set forindividual modules.
Momentum – remote controller with I/O bus 

1 Host Computer

2 I/O unit e.g. 170-AAI-030-00

3 Interface adapter

4 CPU adapter e.g. 171-CCC-760-10-IEC

5 I/O bus interface e.g. 172-PNN-210-22

6 Bus adapter e.g. 170-INT-110-00

7 I/O unit e.g. 170-AMM-090-00

1

MB+

2 3 4 5 6 7



Configuration examples

840 USE 493 00 September 2001 815

Defining Drops To define drops proceed as follows in the PLC Configuration window:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the PLC family Momentum and CPU 171-CCC-760-10-IEC. Use OK 
return to the PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the last line in the table.
Select the Insert command button.
Response: The second drop is entered in the Type column.
Note: Only one I/O bus can be configured.
Dialog display 

5 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

I/O Map

Reserve for expansion:

Cancel HelpOK

144

Drop

1

DeletePaste 

Momentum I/O

Type Supervision In bits

0

Out bits

0

Status Edit

....

2 I/O bus 0 0 ....

Time
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 Select from the column Modules, the moduleAAI-030-00.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Momentum 
drop).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.

Note: With this addressing the 8 measurements of the AAI-030-00 are to be found 
in the words 300001-300008. The parameters are in the words 400001 and 
400002.

Input bits:

Local Momentum Drop

Drop

Cancel HelpOK

Module Detected In Ref

AAI 030 00  300001 

Delete

Modules:

Module

0

Copy 

Params

In End

300008 

Out Ref

400001 

Out End Description

   

 

Poll 

1

Cut Paste Delete

0Output bits:Input bits:
Output bits:
Status table:

0
0

 

400002 

 

I/O BASE, ANALOG-8CH DI
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Set Module 
Parameters

To set parameters for the module proceed as follows in the Local Momentum Drop 
dialog:

Editing Remote 
Drops (I/O bus)

To edit the remote drop open the RIO I/O Bus Drop dialog. This dialog is reached 
via the I/O Map dialog by pressing the Edit... command button in the second drop 
(I/O bus).

Step Action

1 Select the Params command button.
Response: The 170-DDI-353-00 dialog is opened.

2 Select the signal conditions for the input and output channels from the list boxes 
and exit the dialog using OK.
Note: Help with this can be obtained from the corresponding help text in the 
parameter dialog.
Response: The parameter settings are automatically allocated to the addresses 
400001 and 400002.
Dialog display 

3 Exit the dialog using OK.
Response: You return automatically to the I/O Map dialog.

Input selection

DisableChannel 1:

 Channel 2:

DisableChannel 3:

DisableChannel 4:

Disable
-10 V to + 10 V
+/-5V and +/-20mA

Cancel HelpOK

Parameter words

Word 1: 4444 Word 2: 4444

170 AAI 030 00

1..5V and 4..20mA

DisableChannel 5:

DisableChannel 6:

DisableChannel 7:

DisableChannel 8:

Disable
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Example – Editing Remote Drops (I/O Bus)

Introduction This section describes the configuration of the Momentum I/O bus. The drop has 
already been defined in Editing the First (local) Drop (See Editing local drop, p. 814).
When editing the I/O bus the modules must be specified with their I/O references 
before the individuals modules can be parameterized.
Momentum – remote controller with I/O bus 

1 Host Computer

2 I/O unit e.g. 170-AAI-030-00

3 Interface adapter e.g. 172-PNN-210-22

4 CPU adapter e.g. 171-CCC-760-10-984

5 I/O bus interface

6 Bus adapter e.g. 170-INT-110-00

7 I/O unit e.g. 170-AMM-090-00

1

MB+

2 3 4 5 6 7
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Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
TSX Compact Drop dialog:

Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 Select from the column Modules, the module AMM-090-00.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 Repeat steps 1 to 3 for all the modules in the example (see Local Quantum 
Drop dialog representation).

5 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.

Note: With this addressing, the 4 measurements of the AMM-090-00 are to be 
found in the words 300009-300013. The parameters are in the words 400009-
400013.

Input bits:

RIO I/O Bus Drop

Drop

Cancel HelpOK

Module Detected In Ref

AMM-090-00  300009 1

Delete

Modules:

Module

80

Copy 

Params

No. In End

300013 

Out Ref

400003 

Out End Description

...   2  

...  3

Poll 

1

Cut Paste Delete

80Output bits:Input bits:
Output bits:
Status table:

80
80

 

400007 

 

Analog 4 Ch 4 - 20

Used I/O points: 80
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Set Module 
Parameters

To set parameters for the module proceed as follows in the RIO I/O Bus Drop 
dialog:

Step Action

1 Select column No. line 1.
Response: The 1 text box has a dark background, i.e. the AMM-090-00 module 
has been selected for editing.

2 Select the Params command button.
Response: The 170-AMM-090-00 dialog is opened.

3 Select the signal states for the input and output channels from the list boxes and 
exit the dialog using OK.
Note: Help with this can be obtained from the help text in the parameter dialog.
Response: The parameter settings are automatically allocated to the addresses 
400009-400013.
Dialog display 

Abbrechen HilfeOK

Eingangs-Auswahl

1..5V oder 4..20mA

Parameter-Worte

Wort 1:

Kanal 1:

1..5V oder 4..20mAKanal 2:

1..5V oder 4..20mAKanal 3:

1..5V oder 4..20mAKanal 4:

Ausgangs-Auswahl

SperrenKanal 1 Ausgang:

 Kanal 1 Rückfall:

SperrenKanal 2 Ausgang:

Ausgang auf ZeroKanal 2 Rückfall:

Sperren
+0mA bis +20mA
-10 V bis + 10 V

AAAA Wort 2: 0044

170 AMM 090 00
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E.11 Momentum Example - Ethernet Bus System

Introduction

Overview This chapter contains step-by-step instructions for the configuration of an Ethernet 
bus system with Momentum.

What’s in this 
section?

This section contains the following topics:

Topic Page

Configure Ethernet 822

Network Configuration in Different Operating Systems 823

Editing local drop 833

Online-Verbindung herstellen 836
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Configure Ethernet

Preconditions To configure an Ethernet bus system, the following preconditions must be fulfilled:
l PCI network cards in the host computer
l Installation of the network card driver
l Setting Ethernet interface parameters
l Addressing the M1 Ethernet CPU

Installing the PCI 
network card

For a link to an Ethernet bus system an Ethernet interface located on a PCI network 
card must be available in the host computer. This card can be upgraded in PCs, as 
long as a PCI slot is available. Information about this can be found in the computer 
manufacturer’s user manual.

Network 
configuration

Network configurations for different operating systems are given in section Network 
Configuration in Different Operating Systems, p. 823.

Installing Drivers Following the installation of the PCI network card the drivers, which come with the 
network card, must be installed. 
To proceed further, the IP address of the network card is required (it may be 
necessary to contact network administrator).

Addressing the 
M1 Ethernet CPU

The M1 Ethernet CPU does not have an IP address when supplied, and must 
therefore be determined in the Ethernet / I/O Scanner dialog. The address for the 
gateway and Subnet Mask is also determined in this dialog.
The IP address can be assigned via the system administrator or the BOOTP server.

After addressing, saving to Flash is recommended (Online Control Panel → Flash 
Program...), so that the settings are not lost in case of a power outage.

Note: It is important to ensure that the IP address has not already been assigned 
to another device. Double addressing causes an unforeseeable function in the 
network.
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Network Configuration in Different Operating Systems

Network 
configuration in 
Win 98

Declare this IP address in the operating system as follows:

Step Action

1 Select Start → Settings → Control Panel → Network.
Response: The Network dialog box is opened.
Dialog display 

2 Select the register Configuration.
Select the network connection TCP/IP.

Identification Access control

Network

CancelOK

Client for Microsoft networks

Primary Network Logon:

The Microsoft TCP/IP protocol serves to create 
Internet and WAN links

Description

File and printer enabling…

Add… Remove Properties

The following network components are installed:

Client for Microsoft networks
DEC Etherworks 3 (All ISA versions)
TCP/IP
File and printer enabling for Microsoft networks

Configuration
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3 Select the Properties command button.
Response: The TCP/IP Properties dialog is opened.
Dialog display 

4 Select the register IP Address and make the following settings.
Response: The programming device is then registered for network operation 
with the IP address.

Step Action

TCP/IP Properties

CancelOK

?

Advanced

This computer can automatically be assigned an IP address

Links NetBIOS DNS Configuration

Gateway WINS Configuration IP address

If IP addresses are not automatically assigned in the network
get an address from your
network administrator and enter it below.
 

Automatically assign IP address

Determine IP address:

IP Address:

Subnet Mask:
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Computer 
Identification in 
Win 98/NT

The information is used to identify the computer in the network:

Step Action

1 Select Start → Settings → Control Panel → Network.
Response: The Network dialog box is opened.

2 Select the register Identification.
Enter the computer name, the name of the workgroup and a short description of 
the computer.
Dialog display 

3 Exit the dialog using OK.

Network

CancelOK

Configuration Access controlIdentification

SG6191Computer name:

de.accWorkgroup:

Dell OptiPlex XL 5100Description:

Using the following information, the computer is 
identified in the network. Enter the 
computer name, the name of the workgroup and a short 
description of the computer.
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Network 
configuration in 
Win NT

Declare this IP address in the operating system as follows:

Step Action

1 Select Start → Settings → Control Panel → Network.
Response: The Network dialog box is opened.
Dialog display 

Network (View Mode)

Cancel

?

Identification

Close

Using the following information, the computer is identified in the network.
 

SG POOLComputer Name:

SG.OADomain:

Services Protocols Network Card
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2 Select the register Protocols.
Dialog display 

Select the network connection TCP/IP Protocol.

Step Action

Network (View Mode)

Cancel

?

Identification

Close

Network protocols:

Services Protocols Network Card

TCP/IP protocol

Add... UpdateRemove Properties...

Member of

TCP/IP stands for Transport Control Protocol / Internet Protocol. The
standard protocol for long distance networks (WANs = Wide Area Networks), which
allow communication between different networks.
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3 Select the Properties command button.
Response: The Microsoft TCP/IP Properties dialog box is opened.
Dialog display 

4 Select the register IP Address and make the following settings.
Response: The programming device is then registered for network operation 
with the IP address.

Step Action

Microsoft TCP/IP Properties

Apply

?

IP address

A DHCP server can automatically assign this network card

DNS WINS address Routing

Network cards:

an IP address. Get an address from your network administrator
if an DHCP server is not available in the network.
Enter this address below.

[1] 3 Com Etherlink III-Adapter

Get IP address from a DHCP server

Enter IP Address

IP Address:

Subnet Mask:

Standard Gateway:

Options...

CancelOK
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Network 
configuration in 
Win 2000

Declare this IP address in the operating system as follows:

Step Action

1 Select Start → Settings → Network and Dial-Up Connections.
Response: The Network and Dial-Up Connections window is opened.

2 Select the LAN Connection icon.
Response: The LAN Connection status dialog box is opened.
Dialog display 

Status of LAN Connection

Close

?

General

Terminate

Status:

Duration:

Transfer rate:

Establish connection

00:12:20

100.0 MBit/s

Activity

Packages:

Received

559

DeactivateProperties

756

Sent
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3 Select the Properties command button.
Response: The LAN Connection Properties dialog box is opened.
Dialog display 

4 Select the network connection Internet Protocol (TCP/IP).

Step Action

LAN Connection Properties

Cancel

?

General

OK

Establish connection using:

3Com 3C918 integrated Fast Ethernet-Controller [3C905B-

Configure

Activated components are used by this connection:

Client for Microsoft networks

File and printer enabling for Microsoft networks

Internet Protocol (TCP/IP)

Install... Uninstall Properties

Description

TCP/IP, the standard protocol for WAN networks which
allow data to be exchanged over different, connected
networks.

Show icon in the task bar when connected
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5 Select the Properties command button.
Response: The Internet Protocol (TCP/IP) Properties dialog box is opened.
Dialog display 

6 Make the settings there.
Response: The programming device is then registered for network operation 
with the IP address.

Step Action

Internet Protocol (TCP/IP) Properties

Cancel

?

General

OK

IP settings can be assigned automatically if the
network supports this function. If not, contact your
network administrator, to get the correct IP settings.
 

Obtain IP address automatically

Use the following IP Addresses:

IP Address:

Subnet mask:

Standard gateway:

Obtain DNS server address automatically

Use the following DNS server addresses:

Preferred DNS server:

Alternative DNS server:

Advanced...
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Computer 
Identification in 
Win 2000

The information is used to identify the computer in the network:

Step Action

1 Select Start → Settings → Control Panel → System.
Response: The System Properties window is opened.

2 Select the register Network Identification.
Dialog display 

3 Select the Network ID command button.
Response: The assistant for creating a user on the network is started.
Or select the Properties command button.
Response: The Identification Changes dialog box is opened.

4 Exit the dialog using OK.

System Properties

Cancel ApplyOK

?

General Network Identification Hardware User Profile Advanced

The following information is used to identify the computers in the
network.

Computer name:

Domain:

sg4002.

SG.ENG

Click on the command button "Network Identification" to
domain and to create a local user.
 

join a Network 

Click on "Properties" to change
for a computer or to join a domain.
 

Properties

Identification
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Editing local drop

Introduction This section describes the configuration of the local I/O station (Drop). The 
processing sequence begins first of all with the definition of the drop. 
When editing the local I/O station (Drop) the I/O unit must be specified with its I/O 
references before parametering of the individual assemblies can take place.

Momentum - Ethernet Bus System 

1 Host Computer

2 Ethernet network card

3 I/O unit e.g. 170-AMM-090-00

4 CPU adapter e.g. 171-CCC-960-20-IEC

5 Hub or Switch

Note: Only particular CPUs can be used for the Ethernet bus configuration.
The following CPUs are available:
l 171 CCC 980 30
l 171 CCC 960 30
l 171 CCC 980 20
l 171 CCC 960 20

1

2 43 5
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Defining Drops To define drops proceed as follows in the PLC Configuration window:

Mapping 
Modules and 
Specifying I/O 
References

To map the modules and specify the address ranges proceed as follows in the Local 
Quantum Drop dialog:

Step Action

1 Select PLC Selection.
Response: The PLC selection dialog is opened.

2 Select the PLC family Momentum and CPU 171-CCC-960-20-IEC. Use OK 
return to the PLC Configuration window.

3 Select I/O Map.
Response: The I/O Map dialog is opened and the first drop is automatically 
entered in the table.

4 Select the drop from the Drop column.
Select the Edit... command button.
Response: You reach the module map.

Step Action

1 Select the Module → ... column.
Response: The I/O Module Selection dialog is opened.

2 From the Category column, select the <all> option.
Response: All modules are listed in the Modules column.

3 Select from the column Modules, the module AMM-090-00.
Exit the dialog with OK.
Response: The module is inserted in the I/O map.

4 In the In Ref and Out Ref columns, set the start references for the input and 
output modules.
Note: Discrete Input References have the prefix 1 (e.g. 100001), Coil 
References have the prefix 0 (e.g. 000001), Input Register References have the 
prefix 3 (e.g. 300001) and Output Register References have the prefix 4 (e.g. 
400001).
Response: The end reference (column In.End. or Out.End) of the available 
address range is automatically entered.



Configuration examples

840 USE 493 00 September 2001 835

Dialog display Following module mapping and I/O reference specification the dialog looks like this: 

Set module 
parameters

To set parameters for the individual modules, proceed as follows in the Local 
Momentum Drop dialog:

Input bits:

Local Momentum Drop

Drop

Cancel HelpOK

Module Detected In Ref

AMM 090 00  300001 

Delete

Modules:

Module

80

Copy 

Params

In End

300008 

Out Ref

400001 

Out End Description

   

 

Poll 

1

Cut Paste Delete

80Output bits:Input bits:
Output bits:
Status table:

80
80

 

400005 

 

I/O BASE, ANALOG-4CH 4-

Step Action

1 Select the Params command button.
Response: The 170-AMM-090-00 dialog is opened.

2 Select the signal states for the input and output channels from the list boxes and 
exit the dialog using OK.
Note: Help with this can be obtained from the corresponding help text in the 
parameter dialog.
Dialog display 

Abbrechen HilfeOK

Eingangs-Auswahl

1..5V oder 4..20mA

Parameter-Worte

Wort 1:

Kanal 1:

1..5V oder 4..20mAKanal 2:

1..5V oder 4..20mAKanal 3:

1..5V oder 4..20mAKanal 4:

Ausgangs-Auswahl

SperrenKanal 1 Ausgang:

 Kanal 1 Rückfall:

SperrenKanal 2 Ausgang:

Ausgang auf ZeroKanal 2 Rückfall:

Sperren
+0mA bis +20mA
-10 V bis + 10 V

AAAA Wort 2: 0044

170 AMM 090 00
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Connect online

Introduction This chapter describes how a link is created between the programming device and 
the Ethernet bus system.

Creating a link For the link between the programming device and the Ethernet bus system use the 
Concept main menu Online and proceed as follows.

Step Action

1 Select menu command Link....
Response: The Link to PLC dialog box opens.

2 From the list Protocol type select the link TCP/IP.
Response: The zone Protocol settings alters for the TCP/IP settings.

3 In the text box IP address or DNS hostname enter the IP address of the Ethernet 
network card (PCI card).
Note: Make sure that the address in Concept matches the address in Network 
settings of the operating system (See Network configuration in Win 98, p. 823).
Response: An online link exists between the programming device and the 
Ethernet bus system, and all bus nodes are displayed in the list.
Dialog display 

4 Exit the dialog using OK.

Link to PLC

Access

Display only

Cancel HelpOK

Change Configuration

Change data

Change program

Update < Back Forward >

Protocol type:
Protocol settings: TCP/IP

Modbus
Modbus Plus
TCP/IP
IEC Simulator (32-Bit)

127.0.0.1  

IP address or DNS Hostname: Bridge MB+ Index

List of nodes in Modbus Plus network:

Host adapter:
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F
Convert Projects/DFBs/Macros

Converting projects/DFBs

At a Glance The four main steps for converting projects/DFBs are as follows:

Converting EFBs

Step Action

1 Exporting projects/DFBs/macros within the earlier version of Concept, see 
Exporting project/DFB/macro (earlier version of Concept), p. 838.

2 For information on installing the new version of Concept, see Installing new 
versions of Concepts, p. 839.

3 For information on importing projects/DFBs/macros, see Importing project/DFB/
macro, p. 839.

4 For information on editing projects/DFBs/macros, see Editing the project/DFB/
macro, p. 839.

CAUTION

Risk of losing data

If user-defined EFBs are being used in the project (EFBs which have 
been created manually), the current version of the EFB toolkit must be 
used to convert them (File → Concept library…). The Concept 
converter is not able to convert user-defined EFBs.

Failure to observe this precaution can result in injury or 
equipment damage.
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Exporting 
project/DFB/
macro (earlier 
version of 
Concept)

The procedure for exporting projects/DFBs/macros is as follows:

CAUTION

Risk of losing data

The following steps must be performed in the EARLIER version of 
Concept. The new version of Concept may only be installed once all 
existing projects have been exported.

Failure to observe this precaution can result in injury or 
equipment damage.

Step Action

1 Start the Concept converter.

2 From File → Export... open the menu to select the export range.

3 Select the required export range:
l Project with used DFBs: All project information including the DFBs and data 

structures used within the project (derived data types) will be exported.
l Project with all DFBs + macros: All project information including all the 

DFBs and data structures (derived data types) will be exported.
l Project without DFBs: All project information including all data structures 

(derived data types), but excluding DFBs and macros will be exported.
l Single DFB with used DFBs/single macro: Only the selected DFB/macro 

will be exported.
Reaction: The select export data dialog box will be opened.

4 Different file extensions must be selected depending on the element to be 
exported:
l Exporting projects: From the Format list select the extension .prj.
l Exporting DFBs: From the Format list select the extension .dfb.
l Exporting macros: From the Format list select the extension .mac.

5 Select the project / DFB / macro and confirm with OK.
Reaction: The project/DFBs/macros/data structures (derived data types) will be 
contained in the current directory as an ASCII data file (.asc).

6 Quit the Concept converter with File → Quit.
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Installing new 
versions of 
Concepts

Follow the procedure described in the "Installation" chapter of the installation 
instructions.

Importing 
project/DFB/
macro

The procedure for importing projects/DFBs/macros is as follows:

Editing the 
project/DFB/
macro

Start the Concept/Concept DFB and edit the project/DFBs/macros/data structures 
in the usual way.

CAUTION

Risk of losing data

Only install the NEW version of Concept if you have performed the 
previous steps.

Failure to observe this precaution can result in injury or 
equipment damage.

Step Action

1 Start the Concept converter.

2 From File → Import... open the select import projects/DFBs/macros dialog box.

3 Select the project/DFB/macro (data file format .asc) and confirm with OK.
Reaction: The project/DFBs/macros/data structures will be contained in the 
current directory as Concept data files.

4 Quit the Concept converter with File → Quit.
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G
Concept ModConnect

At a Glance

Introduction This chapter describes how to integrate third party modules into the Concept I/O 
map and how to remove it.

What’s in this 
chapter?

This chapter contains the following Sections:

Section Topic Page

G.1 Introduction 843

G.2 Integration of Third Party Modules 844

G.3 Use of third party module in Concept 847
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G.1 Introduction

Introduction

Overview Information on hardware and I/O modules is stored in the Concept System 
Information Database (SysInfDb). This database is maintained and updated by 
Schneider and included with every Concept release.Nevertheless, Concept is able 
to support new I/O modules without having to wait for a new release. That’s where 
the ModConnect Tool comes in - it takes a textual module description (MDC) and 
adds this information into the SysInfDb. This means that supplier of a new I/O 
module, who wants this module to be available in Concept, must also deliver an 
MDC file which describes the characteristics of this module.

Once installed, the I/O modules have the same functionality as existing Schneider 
Automation modules. This includes the ability to set module parameters and to 
display an online help. 

For the installation of new modules, the third party module manufacturer has to 
supply a disk which contains a specific MDC file and the help information.

Note: The MDC file is dependent on the version of Concept so if you upgrade your 
Concept version, make sure you get also an upgraded version of your previously 
used MDC files. You will have to reinstall them.
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G.2 Integration of Third Party Modules

At a Glance

Introduction This chapter describes the procedures which have to be used in Concept 
ModConnect in order to integrate third party modules into Concept or to remove it.

What’s in this 
section?

This section contains the following topics:

Topic Page

Integrating new Modules 845

Removing Modules 846
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Integrating new Modules

Precondition The specific MDC file for the new module has to be available.

Integrating new 
Modules

For integrating new modules, proceed the following steps:

Upgrate of 
Concept

Step Action

1 For starting the application select ModConnect Tool in the Concept programm 
group.
Reaction: Concept ModConnect displays its main window. If any Modules have 
been installed, a lis of installed modules is shown.

2 Copy the MDC file and the help file supplied with module to the Concept 
installation path.

3 Select File → Open Installation File...
Reaction: A dialog for selection the specific MDC file is opened.

4 Set the correct path to the MDC file and select it (e.g. SAMPLE.MDC). Confirm 
with OK.
Reaction: The path including the name of the MDC file is now displayed in the 
Select Module dialog along with the defined modules.

5 Select the module you want to add and click Add Module or in the case of 
multiple entries click on the Add All button. You may additionally click the 
Browse button to return to the Open file dialog where you can select another 
.MDC for evaluation.

6 Click on the Close button to return to the main window.
Reaction: The main window will now be displayed with the module information 
appearing in the Imported Modules in Concept Database window. By clicking 
on the added module (to select it) the module details are shown. With Help → 
Help on Module the help of the selected module can be displayed.

7 Select File → Save Changes to save the changes data base.

8 Select File → Exit for terminating Concept ModConnect.
Reaction: The installed modules are now avaiable in the Concept I/O map (See 
Use of third party module in Concept, p. 847).

Note: The MDC-File is dependent on the version of Concept so if you upgrade your 
Concept version, make sure you get also an upgraded version of your previously 
used MDC files. You will have to reinstall them.
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Removing Modules

Removing  
Modules

For removing modules, proceed the following steps:

Step Action

1 For starting the application select ModConnect Tool in the Concept programm 
group.
Reaction: Concept ModConnect displays its main window with a list of the 
installed modules.

2 Select the module you want to remove and select File → Remove selected 
Module.
Reaction: The Confirm IOModule Removal dialog is displayed.

3 Selecting OK, causes the removal of the module from Concept. 
Reaction: The module is no longer listed in the main window of Concept 
ModConnect or in the I/O Module Selection list box of Concept.
Note: When removing modules. If the module has been used in existing Concept 
projects, the integrity of these projects will be compromised. 

4 Select File → Save Changes to save the changes data base.

5 Select File → Exit for terminating Concept ModConnect.
Reaction: The installed modules are now avaiable in the Concept I/O map (See 
Use of third party module in Concept, p. 847).
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G.3 Use of third party module in Concept

Use of Third Party Modules in Concept

Precondition The modules have to be installed according to the procedure Integrating new 
Modules, p. 845.

Insert module to 
I/O Map

To insert a module to the I/O map, proceed the following steps:

Step Action

1 Start Concept.

2 Open the configurator with Project → Configurator.

3 Open the I/O map with I/O map... → Edit....

4 Open the I/O Module Selection dialog by clicking on ... at the Module column.
Reaction: The third party modules appear in the Other column.

5 Select the module by clicking.
Reaction: A short description appear at the top of the dialog. You may press the 
Help on Module button to display the module’s help file supplied by the vendor.

6 Click on OK (or doubleclick on the module) to insert the module the the I/O map.
Reaction: The I/O Module Selection dialog is cloes and the selected module is 
inserted in the I/O map.

7 For entering the module’s parameters (if available), select the Rack-Slot column 
of the module and click on the Params button.
Reaction: The parameter screen for the selected dialog is opened.

8 Set the parameters for the module and confirm with OK.

9 Enter the input and output references for the module.

10 Confirm the I/O map with OK and save the project with File → Save project.
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H
Convertion of Modsoft Programs

At a Glance

Introduction This information provides you with the necessary process required to change 
previously generated Modsoft derived Ladder Logic programs into the Concept 
environment.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Introduction 850

How to Convert a Modsoft Program 852

Exceptions 853
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Introduction

Overview For the convertion of an existing Modsoft program to a valid Concept 984 Ladder 
Logic project the Mosdsoft Converter is used. The Modsoft Converter provides 
current Modsoft users with a migration path to the 984 Ladder Logic for Windows 
environment. The Modsoft Converter requires no previous knowledge of the 
Concept programming environment. The term project is synonymous with a Modsoft 
program.

Starting the 
Modsoft 
Converter

Windows 98, Windows 2000 or Windows NT allows you to run the program from the 
Start menu, by selecting Modsoft Converter in the Concept programm group.

The Modsoft .env 
File

For the convertion the Modsoft .env file is needed. The .env file contains all the file 
information pertaining to the Modsoft program.

The Modsoft .env file contains the following files:
l .CFG  Configuration file
l .PRG  Ladder Logic file
l .PCM  Network comments
l .PCT   Network comments
l .ASC  ASCII file
l .USL  User Loadables
l .RFD  Reference presets set by the user in the Modsoft Reference Data Editor
l .REF  Reference contents contained in the PLC, from an upload
l .RSF  Reference symbols
The convert process requires the .CFG file to be present in the .env file. If it does not 
exist, an error dialog is displayed indicating that the .env file does not reference a 
.CFG file. All other files are optional.

By forcing you to enter the Modsoft *.env filename, some of the validation is avoided 
that would otherwise be required if you were allowed to enter a *.prg and *.cfg name 
separately, i.e. Loadables (DX, User and EXE), state ram and builtin functions.

Incompatibilities Due to differences in "address calculations in the configuration table" between 
Modsoft 2.6 and Concept 2.2 or later, the same Modsoft program loaded in a PLC 
and converted using the Modsoft Converter will cause a configuration miscompare 
in certain page zero locations. This will not affect the validity of the converted 
program.
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Invalid PLC 
Types

If the Modsoft configuration file PLC type, is not legal for Concept, you are warned 
that the convert process will not continue. You then have to return to Modsoft and 
change the PLC type to one that is valid.

Handling of 
SY/MAX

SY/MAX programs converted to Modsoft file format will migrate to the Quantum PLC 
type. The Modsoft Convert utility can then bring the SY/MAX program into Concept.

Modsoft Version The Convert utility handles Modsoft file format supported in revision 2.2 or greater.

Handling of SFC 
and Macros

Modsoft does allow the user to save a Ladder Logic program that consists of 
undefined elements, and Concept needs to resolve those elements. The Modsoft 
Ladder Logic program is converted without performing any validity checks against 
the Configuration. When the Modsoft *.prg file contains either SFC or Macros the 
convert process is aborted and an Error dialog is displayed informing you to return 
to Modsoft and use Segment Status → Commands → Convert to File. This 
process expands the Macros and translates the SFC elements.

Handling of 
I/O Map

Modsoft sets a default I/O map size of 512. Concept does not, but calculates the size 
as required. Uploading a Controller that has been downloaded with Modsoft will 
cause a miscompare. You are allowed to continue.

Handling of 
References

Modsoft can have two types of reference data or none at all. There exists online 
reference data information (RAM) if you have uploaded from the PLC. There are 
also references defined using the offline Reference Data Editor. When both types of 
data exist in the .env file, the convert utility first imports the online references then 
overlays the offline reference data.
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How to Convert a Modsoft Program

Precondition For converting a Modsoft program the Modsoft .env file (See The Modsoft .env File, 
p. 850) is necessary. The .env file contains all the file information pertaining to the 
Modsoft program. Once selected the conversion takes place and you are prompted 
to a Save as dialog.

How to Convert a 
Mosdsoft 
Programm

For converting a Modsoft programm, proceed the following steps:

Step Action

1 Open the Modsoft Converter.

2 Select File →  Convert....

3 Select the drive and the directory, where to find the Modsoft .env file. (The file 
will be found in the Modsoft program directory, e.g. C:\Modsoft\Programs.)

4 Pick the file from the list.

5 Start the convertion with Convert.
Reaction:
 The convertion is started. 
l A convert progress dialog is displayed after the validity checks on the *.env 

file are performed. The first line of the dialog indicates the section currently 
being converted and the second line indicates progress as it pertains to the 
whole convert process.

l f any errors, such as Out of memory, Out of disk space or File access 
errors, occur during the convert process, an error dialog is displayed.

l An operation completed error free results in the automatic display of the Save 
as Concept project dialog). The default name of the project, displayed in the 
Save project dialog, is the *.env filename prompt. 

6 You can then change the project name and the directory in which Concept 
project will be saved. 
Reaction: If the project name selected already exists a confirmation dialog is 
displayed.
Note: Saving the Modsoft converted program as a Concept project does not 
have to be done at this time, you can still save using the File → Save project as 
menu item.
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Exceptions

Description 0x and 1x references in a Modsoft program are converted to a Located Variable with 
data type BOOL in Concept. This data type is compatible with the use of these 
references. 

However, 3x and 4x are converted to integer.

Example If you have the following defined in Modsoft:

A conversion of the above to Concept using the Convert program yields:

Note: This straight conversion precludes both Modsoft bit defination and floating 
point types.

REF BIT SYMBOL DESCRIPTOR

000001 located_0x_boolean located 0x boolean descriptor

100001 located_1x_boolean located 1x boolean descriptor

300001 /16 bit_16_of_3000001 16th bit of 300001 descriptor

400100 incoming_integer incoming integer descriptor

400200 outgoing_interger outgoing flt32 descriptor

400300 / 1 bit_1_of_400300 bit 1 of 400300 descriptor

Variable Name Data Type Address Comment

located_0x_boolean BOOL 000001 located 0x boolean descriptor

located_1x_boolean BOOL 100001 located 1x boolean descriptor

bit_16_of_3000001 INT 300001 16th bit of 300001 descriptor

incoming_integer INT 400100 incoming integer descriptor

outgoing_interger INT 400200 outgoing flt32 descriptor

bit_1_of_400300 INT 400300 bit 1 of 400300 descriptor
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I
Modsoft and 984 References

At a Glance

Introduction This chapter contains the Modsoft and 984 References.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Modsoft Keys with Concept Equivalents 856

Modsoft Function Compatibility 858
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Modsoft Keys with Concept Equivalents

Keys

Table of keys:

Note: When possible, the Ctrl key is used in place of the Modsoft Alt key.

Funtion Modsoft 2.x Key Concept Key

Normally open contact ’ or " same

Coil ( or [ same

Normally closed contacts / or \ same

Horizontal short = same

Vertical short | same

Negative transitional contact Alt+N N 

Positive transitional contact Alt+P P

Inserting a function block by name Alt+F Ctrl+F

Copy element(s) Alt+F3 Ctrl+C

Delete element(s) Alt+F4 or Del Ctrl+X or Del

Paste Alt+F5 Ctrl+V

Offset references Alt+F6 Ctrl+H

Search Alt+F7 F3

Search next Alt+F8 F6
When online in direct mode, 
Concept uses a nonmodal 
dialog with accelerators for 
search previous and search 
next.

Network comments Alt+C Ctrl+M

Goto network Alt+G Ctrl+G

Insert network Alt+I Ctrl+I

Append network Alt+A Ctrl+A

Trace Alt+T Ctrl+T

Retrace Alt+B Ctrl+B or Ctrl+T

Dx zoom Alt+Z Ctrl+D

Goto node (1,1) of active network Home same

Goto node (7,11) of active network End same

Goto first network in current segment Ctrl+Home same
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Status Line 
Values

These Concept keys change the status line display value of the currently selected 
reference:
A ASCII
H Hexidecimal
D Decimal (signed)
U Decimal (unsigned)
R Real
L Long (32 bit)
S Short (16 bit)

Goto last network in current segment Ctrl+End same

Insert equation Ins Ctrl+Q

Append - Ctrl+A 

Append equation - Ctrl+U 

Delete current network - Ctrl+K 

Copy to the clipboard - Ctrl+C

Undo - Ctrl+Z

Closing an mdi child window - Ctrl+F4

Switching to the next open mdi child 
window

- Ctrl+F6

Funtion Modsoft 2.x Key Concept Key
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Modsoft Function Compatibility

Not Supported 
Features

The following Modsoft functions are not supported in Concept:
l Macros/macro programming
l SFC (use IEC SFC instead)
l Search of comments

User Interface 
Difference

Concept is an MS-Windows based application. Modsoft is a DOS based application. 
Concept uses MS-Windows user interface standards and practices. Functions of 
Concept with 984 Ladder editor are based on the pre-existing functions of Concept.

There are no exact similarities of specific user actions required to perform Concept 
tasks as compared to Modsoft tasks. 

Constant Sweep Concept has no off line selection to set the constant sweep mode. This mode is 
available from the Online Control Panel. 

Once constant sweep has been set in the controller, you can upload the controller 
and save the project. The constant sweep settings will be retained in the project. If 
this project is downloaded, the constant sweep settings will be set.

How to Start the 
Constant Sweep

To set constant sweep before starting the controller, follow these steps:

Note: Any changes to the controller configuration cause the constant sweep 
settings to be reset, i.e, constant sweep is disabled whenever the controller 
configuration changes. Follow the steps above to reenable constant sweep.

Step Action

1 Create your configuration and program logic, offline.

2 Download your program to the controller. When the dialog appears asking Do 
you want to start the controller?"click on the No button.

3 From the Online menu, choose Online Control Panel.

4 Set the constant sweep mode and sweep time.

5 Start the controller.
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J
Presettings when using 
Modbus Plus for startup

Introduction

Overview This chapter provides a brief description of the presettings when using Modbus Plus 
for first startup.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Installing the SA85 in Windows 98/2000 860

Installing the SA85 in Windows NT 863

Installing the Modbus Plus Driver in Windows 98/2000/NT 865

Virtual MBX Driver for 16 bit application capability with Windows 98/2000/NT 866

MBX Driver for connection between ModConnect Host interface adapters and 
32 bit applications with Windows 98/2000/NT

867

Remote MBX - Driver for Remote Operation 868

Ethernet MBX - Driver for Modbus Plus Function via TCP/IP 869

Establishing the hardware connection. 871
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Installing the SA85 in Windows 98/2000

Hardware 
configuration

Carry out the following steps to set the SA85 hardware settings:

Installing Drivers Install the Virtual MBX driver and then the MBX or Remote MBX driver. 
Also see:
l Virtual MBX Driver for 16 bit application capability with Windows 98/2000/NT, 

p. 866
l MBX Driver for connection between ModConnect Host interface adapters and 32 

bit applications with Windows 98/2000/NT, p. 867
l Remote MBX - Driver for Remote Operation, p. 868

SA85 
configuration

Carry out the following steps to configure the SA85 after installing the driver:

Step Action

1 Set the Modbus node address (Modbus Plus Port Address) and the memory 
based address on the SA85 (see documentation "IBM Host Based Devices").

2 Install the SA85 as described in the "IBM Host Based Devices" documentation.

Step Action

1 Open the control panel (Start → Settings → Control Panel).

2 Select the Hardware symbol.
Response: The hardware wizard is called.

3 Select the Next command button.

4 Windows 98: Select the option Yes (recommended).
Windows 2000: Select the option Add/Troubleshoot a device.
Select the Next command button.
Response: Hardware recognition is started.

5 only Windows 98: Select the command button Next.
Response: The status of the hardware recognition is displayed.

6 only Windows 98: Select the command button Next.
Response: All hardware types found are listed.

7 Select the hardware type MBX Devices for Modicon Networks, and press 
Next.
Response: The database with driver information is installed.

8 Select the adapter SA85-000 and press Next.
Response: A memory area is automatically created.

9 Select the Next command button.
Response: The device no. and polled mode (20 ms) are automatically 
displayed.
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Win 98: Edit 
SA85 
configuration

To edit the SA85 configuration with Windows 98, carry out the following steps after 
the first configuration:

10 Select the Next command button.
Response: The software for the new hardware component is installed.

11 Select the Next command button.
Response: You will be asked to shut down the computer.

12 Click No.
Response: The adapter is configured with the presettings.

Step Action

Step Action

1 Open the control panel (Start → Settings → Control Panel).

2 Select the System symbol.
Response: The window System Properties is called.

3 Select the register card Device Manager.

4 Select the adapter SA85-000 and press Properties.
Response: The SA85-000 Adapter Properties window is opened.

5 Select the register Device Settings.

6 Make the following changes. (also see Help file LMBX9X on the driver CD.)

7 Select the register Resources, to change the memory area.

8 Exit the window by clicking OK.
Response: The changes are excepted by the system.
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Win 2000: Edit 
SA85 
configuration

To edit the SA85 configuration with Windows 2000, carry out the following steps 
after the first configuration:

Peer Cop 
functionality

Several parameter settings must be made to enable Peer Cop communication via 
the SA85 adapter. The Peer Cop function is deactivated as standard, and should 
only be released if your application requires Peer Cop communication.
To release and set parameters for Peer Cop communication, start with the first steps 
as with "Edit SA85 Configuration". In SA85-000 Adapter Properties, select the 
register Peer Cop and make your settings. 

Step Action

1 Open the control panel (Start → Settings → Control Panel).

2 Select the System symbol.
Response: The System Properties window is opened.

3 Select the register Hardware.

4 Select Device Manager....
Response: The Device Manager is opened.

5 Select Network Adapter → SA85-000.

6 Select the Properties command button.
Response: The SA85-000 Adapter Properties window is opened.

7 Select the register Device Settings.

8 Make the following changes. (also see Help file LMBX9X on the driver CD.)

9 Select the register Resources, to change the memory area.

10 Exit the window by clicking OK.
Response: The changes are excepted by the system.
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Installing the SA85 in Windows NT

Hardware 
configuration

Carry out the following steps to set the SA85 hardware settings:

Installing Drivers Install the Virtual MBX driver and then the MBX or Remote MBX driver. 
Also see:
l Virtual MBX Driver for 16 bit application capability with Windows 98/2000/NT, 

p. 866
l MBX Driver for connection between ModConnect Host interface adapters and 32 

bit applications with Windows 98/2000/NT, p. 867
l Remote MBX - Driver for Remote Operation, p. 868

SA85 
configuration

Carry out the following steps to configure the SA85 after installing the driver:

Step Action

1 Set the Modbus node address (Modbus Plus Port Address) and the memory 
based address on the SA85 (see documentation "IBM Host Based Devices").

2 Install the SA85 as described in the "IBM Host Based Devices" documentation.

Step Action

1 In the start menu, open the folder WinConX/MBXDriver (Start → Programs → 
WinConX).

2 Double-click on the symbol MBX Driver Configuration.
Response: The dialog box MBX Driver Configuration is opened.

3 In the register Device Configuration, click on the command button New.
Response: In the column Device Type, a list box is shown.

4 Select the option SA85 from the list box.
Response: The dialog box SA85 Configuration is opened.

5 Make the following settings. (also see Help file LMBX9X on the driver CD.)

6 Exit the dialog box by clicking Close.
Response: The settings are excepted by the system.
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Edit SA85 
configuration

Carry out the following steps to edit the SA85 configuration if it has already been 
configured:

Peer Cop 
functionality

Several parameter settings must be made to enable Peer Cop communication via 
the SA85 adapter. The Peer Cop function is deactivated as standard, and should 
only be released if your application requires Peer Cop communication.
To release and set parameters for Peer Cop communication, start with the first steps 
as with "Edit SA85 Configuration". In the dialog box SA85 Configuration, select the 
register Peer Cop and make your settings. 

Step Action

1 In the start menu, open the folder WinConX/MBXDriver (Start → Programs → 
WinConX).

2 Double-click on the symbol MBX Driver Configuration.
Response: The dialog box MBX Driver Configuration is opened.

3 Select SA85 in the register Device Configuration.

4 Click on the Edit command button.
Response: The dialog box SA85 Configuration is opened.

5 Make the following changes. (also see Help file LMBX9X on the driver CD.)

6 Exit the dialog box by clicking Close.
Response: The settings are excepted by the system.
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Installing the Modbus Plus Driver in Windows 98/2000/NT

Introduction In order to use the Modbus Plus communication, you must first install the 
CyberLogic MBX driver for Windows 98/2000/NT version >=4.20 (+ Service 
Release 1 for Windows 2000)
The following drivers are available on the CD "MBX Driver Suite v4.20":

Installation Carry out the following steps to install the Modbus Plus driver:

Configuration Configuration occurs automatically after installing the driver. To make changes to 
the configuration, open the dialog to be edited from the WinConX → xxx MBX 
Driver Start Menu, by double clicking on the xxx MBX Configuration Editor 
symbol.

Driver Operating system

MBX Driver MBX Driver for connection 
between ModConnect Host interface adapters 
and 32 bit applications with Windows 98/2000/
NT, p. 867

Windows 98/2000/NT

Virtual MBX Driver Virtual MBX Driver for 16 
bit application capability with Windows 98/
2000/NT, p. 866

Windows 98/2000/NT

Remote MBX Driver Remote MBX - Driver for 
Remote Operation, p. 868

Windows 98/2000/NT

Ethernet MBX Driver Ethernet MBX - Driver 
for Modbus Plus Function via TCP/IP, p. 869

Windows NT

Step Action

1 Start Windows.

2 Insert the CD "MBX Driver Suite ver. 4.20".

3 Select the Start → Execute command.

4 Enter the CD drive and :\SETUP in the command line.

5 Confirm with OK.

6 Follow the onscreen instructions.
Response: After installation the WinConX program with all installed drivers is 
created in the Start Menu.
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Virtual MBX Driver for 16 bit application capability with Windows 98/2000/NT

Introduction Installing the Virtual MBX driver guarantees the run capability of all 16 bit DOS or 
Windows 3.x NETLIB/NetBIOS compatible applications in their original binary form 
in Windows 98/2000/NT.

Preconditions In order for the Virtual MBX driver to function correctly, additional drivers must be 
installed.
The following additional drivers can be installed to enhance the Virtual MBX driver’s 
run capability:

Installation The virtual MBX driver software for Windows 98/2000 and Windows NT is included 
along with other drivers, on the CD "MBX Driver Suite ver4.20".
Installation is done by Autorun when the CD is inserted or can be started manually 
(CD drive:\SETUP.EXE). Select the driver to be installed from the main menu. You 
will then be taken through the installation step by step. The driver is then configured.

Configuration

Note: A detailed description of this driver can be found in the VMBX9X or VMBXNT 
Help file on the "MBX Driver Suite ver4.20" CD.

Driver Operating 
system

Application

MBX Windows 98/
2000/NT

Driver for Modbus Plus Host interface adapter

Remote MBX Windows 98/
2000/NT

Driver for accessing remote nodes on the Modbus 
Plus and Ethernet network

Ethernet MBX Windows NT Driver for Modbus Plus Emulation via TCP/IP

Note: To guarantee a connection to Concept (= 16-Bit-Application), in the Virtual 
MBX Driver Configuration → 16-bit Windows Applications dialog, check the 
Support 16-bit Windows Applications checkbox.
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MBX Driver for connection between ModConnect Host interface adapters and 
32 bit applications with Windows 98/2000/NT

Introduction The installation of the MBX driver guarantees the connection between the 
MODConnect Host interface adapter and 32 bit applications with Windows 98/2000/
NT. This driver also supports the program interfaces MBXAPI and NETLIB. This 
means that practically all Modbus Plus compatible software programs can be 
operated via Modbus, Modbus Plus and Ethernet networks, without having to make 
changes. This also includes 32 bit Windows 98/2000/NT applications and 16 bit old 
DOS/Windows applications.

Hardware 
support

The MBX driver operates either in Interrupt or Polled mode.
It supports the following ModConnect Host interface adapter:
l ISA
l EISA
l MCA
l PC card (PCMCIA)

Remote 
connection

The MBX driver includes the MBX Remote Server. This enables remote nodes to 
access local MBX devices (including the Host interface adapter) via any Windows 
98/2000/NT compatible network. Also see Remote MBX - Driver for Remote 
Operation, p. 868.

Installation The MBX driver software for Windows 98/2000/NT is included along with other 
drivers, on the CD "MBX Driver Suite ver4.20".
The installation is carried out by Autorun when the CD is inserted or can be manually 
started(CD drive:\SETUP.EXE). Select the driver to be installed from the main 
menu. You will then be taken through the installation step by step. The driver is then 
configured.

Note: A detailed description of the driver is included on the CD "MBX Driver Suite 
ver4.20" in the Help file LMBX9X or LMBXNT.
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Remote MBX - Driver for Remote Operation

Introduction The installation of the remote MBX driver allows remote connection of applications 
operated on remote station client nodes. Remote station access of the Modbus Plus 
network takes place using a standard LAN (Local Area Network).
This driver also unites applications that support the program interfaces MBXAPI and 
NETLIB.

Preconditions This connection is only made if your programming device is a node on the MBX 
Remote Server. Also install one of these drivers because the MBX and Ethernet 
MBX drivers include the MBX Remote Server.

Installation The remote MBX driver software for Windows 98/2000/NT is included along with 
other drivers, on the CD "MBX Driver Suite ver4.20".
The installation is carried out by Autorun when the CD is inserted or can be manually 
started(CD drive:\SETUP.EXE). Select the driver to be installed from the main 
menu. You will then be taken through the installation step by step. The driver is then 
configured.

Configuration The configuration of the remote MBX driver is presently the same as the 
configuration of the other MBX drivers. The remote MBX driver is operated as a 
remote client node, which does not require a physical host interface adapter. 
Therefore the driver configuration also includes the creation of logical devices (MBX 
Remote Client), which refer to the physical devices found on the server node.

Note: A detailed description of the driver is included on the CD "MBX Driver Suite 
ver4.20" in the Help file RMBX9X or RMBXNT.
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Ethernet MBX - Driver for Modbus Plus Function via TCP/IP

Introduction The installation can only be carried out in Windows NT.
When the Ethernet MBX driver is installed, Modbus Plus function is emulated via 
TCP/IP. This driver also supports the program interfaces MBXAPI and NETLIB. This 
means that practically all Modbus Plus compatible software programs immediately 
have access to TCP/IP based communication without having to make changes. This 
also includes 32 bit Windows 98/2000/NT applications and 16 bit old DOS/Windows 
applications.

Winsock API When using Winsock API, the Ethernet MBX driver can solve certain critical 
problems created by the Winsock interface.
For example: TCP Port 502 can only receive one process with incoming messages. 
If several applications attempt to receive unexpected messages, a conflict occurs. 
The Ethernet MBX driver eliminated this problem by acting as global dispatcher for 
these messages. When using the slave path, Concept in Modbus Plus determines 
that several (up to 256) applications refer to these unexpected messages and 
execute them simultaneously.

Note: A detailed description of the driver is included on the CD "MBX Driver Suite 
ver4.20" in the Help file EMBXNT.



Presettings for Modbus Plus

870 840 USE 493 00 September 2001

Advantage of 
using the driver

The most important advantages when using the driver via the Winsock API are:
l Changes are no longer needed for existing NETLIP/NetBIOS/MBXAPI 

compatible applications. End user and developer software investments are 
completely secured.

l Consistent management and dispatching of unexpected messages, which 
prevents overlaps between various products on the same system.

l Complete functionality of TCP/IP communication, while protecting existing 
NETLIP/NetBIOS/MBXAPI standards. 
For example: Ethernet TCP/IP communication requires a identifier address in 
the form of an IP address, and a message contains an identifier index byte. The 
Ethernet MBX driver protects this functionality.

l Working with TCP/IP communication is an advantage for software developers not 
experienced with the complicated Winsock API.

l A single program model for software developers handles communication in 
Modbus, Modbus Plus and Ethernet TCP/IP networks.

l Increased compatibility with various products. Winsock API is more oriented 
towards developer executed, TCP/IP strategies in a slightly different manner and 
can create compatibility problems in various products.

l Compatible with all MBX products. How e.g. the Virtual MBX driver for use of old 
16-bit DOS/Windows applications and the MBX driver which dispatches 
messages between Ethernet, Modbus, Modbus Plus and remote MBX nodes.

Remote 
connection

The Ethernet MBX driver includes the MBX Remote Server. This enables remote 
nodes to access local MBX devices (including Ethernet MBX devices) via any 
Windows compatible network. The remote client can be a Windows 98/2000/NT 
node with the remote MBX driver installed. Also see Remote MBX - Driver for 
Remote Operation, p. 868.

Installation The Ethernet MBX driver software for Windows NT is included along with other 
drivers, on the CD "MBX Driver Suite ver4.20".
The installation is carried out by Autorun when the CD is inserted or can be manually 
started(CD drive:\SETUP.EXE). Select the driver to be installed from the main 
menu. You will then be taken through the installation step by step. The driver is then 
configured.



Presettings for Modbus Plus

840 USE 493 00 September 2001 871

Establishing the hardware connection

Introduction

Procedure To establish the hardware connection, do the following:

Note: Please refer to the "Modbus Protocol Reference Guide" for a detailed 
description of the hardware setup.

Step Action

1 Set a unique Modbus node address for the CPU using the rotary switch on the 
back of the module.

2 Note the Modbus node address set on the CPU’s sliding cover.

3 Connect the CPU to the SA85 interface with a Modbus Plus cable.
Result: The flash interval on the CPU "Modbus +" display changes from 3 
flashes per second with a pause to 6 without a pause.
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K
Presettings when using Modbus 
for startup

Introduction

Overview The chapter provides a brief description of the presettings when using Modbus for 
startup.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Interface settings in Windows 98/2000 874

Interface Settings in Windows NT 876

Setting up the hardware connection 876

Transfer problems 877
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Interface settings in Windows 98/2000

Win 98: Interface 
setting

Carry out the following steps to set the interface in Windows 98:

Step Action

1 Select the Desktop symbol.
Response: All available objects are displayed.

2 Select the Control Panel symbol.
Response: All available objects are displayed.

3 Select the System symbol.
Response: The System Properties dialog is opened.

4 Select the register card Device Manager.

5 Select Connections (COM and LPT).
Response: The branch COM connection (COMx) and printer port (LPTx) are 
displayed.

6 Select COM connection (COMx).
Response: The Properties for COM connection (COMx) dialog is opened.

7 Select the register card Connection settings.

8 Select the Advanced... command button.
Response: The Connection settings dialog is opened.

9 Tick the check box Use FIFO buffer.
Note: Using the FIFO(First In First Out) buffer requires a serial port with 16550 
compatible UART (Universal Asynchronous Receiver Transmitter).

10 Use the slide control to change the recieve and send buffer which are both set 
to maximum size.

11 Close all dialogs with OK.
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Win 2000: 
Interface setting

Carry out the following steps to set the interface in Windows 2000:

Step Action

1 Select the Desktop symbol.
Response: All available objects are displayed.

2 Select the Control Panel symbol.
Response: All available objects are displayed.

3 Select the System symbol.
Response: The System Properties dialog is opened.

4 Select the register card Hardware.

5 Select Device Manager...
Response: The Device Manager is opened.

6 Select Connections (COM and LPT).
Response: The branch ECP Printer port (LPT1) and communication port 
(COMx) are displayed.

7 Select communication connection (COMx).
Response: The Properties for Communication connection (COMx) dialog is 
opened.

8 Select the register card Connection settings.

9 Select the Advanced... command button.
Response: The Advanced settingsCOMx dialog is opened.

10 Tick the check box Use FIFO buffer.
Note: Using the FIFO(First In First Out) buffer requires a serial port with 16550 
compatible UART (Universal Asynchronous Receiver Transmitter).

11 Use the slide control to change the recieve and send buffer which are both set 
to maximum size.

12 Close all dialogs with OK.
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Interface Settings in Windows NT

Interface setting Carry out the following steps to set the interface in Windows NT:

Setting up the hardware connection

Introduction

Procedure To establish the hardware connection, do the following:

Step Action

1 Double-click on the My Computer icon.
Response: All available objects are displayed.

2 Double-click on the Control Panel icon.
Response: All available objects are displayed.

3 Double-click on the Connections icon.
Response: The Connections dialog box is opened.

4 Select the connection to be set in the list box and click on the command button 
Settings....
Response: The COMx Settings dialog box is opened.

5 Click on the command button Extended....
Response: The Advanced Settings for COMx dialog box is opened.

6 Activate the check box FIFO activated.
Note: Using the FIFO(First In First Out) buffer requires a serial port with 16550 
compatible UART (Universal Asynchronous Receiver Transmitter).

7 Close all dialogs with OK.

Note: Please refer to the "Modbus Protocol Reference Guide" for a detailed 
description of the hardware setup.

Step Action

1 Set a unique Modbus node address for the CPU using the rotary switch on the 
back of the module.

2 Note the Modbus node address set on the CPU’s sliding cover.

3 Connect the Modbus interface CPU to the PC serial COM interface with a 
Modbus cable.



Presetting for Modbus Plus

840 USE 493 00 September 2001 877

Transfer problems

Introduction Communication errors can occur when loading the EXEC file. Communication, 
made via the COM interface with Windows, depends on several factors. These 
factors include the programming device clock speed, the communication software 
and the other programs (or applications) that are used in the system.

Check list for 
transfer 
problems

Refer to the following check list if transfer problems occur:

RTU transfer 
problems

If sporadic errors occur during data transfer, transfer cannot be carried out 
successfully with RTU mode. If this is the case, select ASCII mode. (See Quantum/
Compact/Momentum/Atrium first startup.)

Step Action

1 Check that no other applications are running in the background. Another 
application running in the background can mean that the active communication 
application in the foreground cannot receive information fast enough.

2 Check that the programming device is running at the highest possible clock 
speed. Some programming devices can prolong the lifetime of the buffer battery 
with lower speeds. Look in the documentation for you computer.

3 Use a serial connector with a 16550A Universal Asynchronous Receiver 
Transmitter (UART).  Windows uses the buffering capability of these connections 
so that Windows data transfer applications can reach higher speeds even on 
slower computers.
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L
Startup when using Modbus with 
the EXECLoader

Introduction

Overview This chapter describes loading executive data (EXEC) onto the PLC with the 
EXECLoader program.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Quantum first startup with EXECLoader 880

Compact first startup with EXECLoader 884

Momentum first startup for IEC with EXECLoader 888

Momentum first startup for LL984 with EXECLoader 893
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Quantum first startup with EXECLoader

Introduction This section describes the first startup of Quantum when used with Modbus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 880
l Define Modbus interface, p. 880
l Protocol settings, p. 881
l Select EXEC file, p. 882
l Load EXEC file, p. 882

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the Option button Modbus RTU (RS232) for the RTU transfer mode.
Select the Option button Modbus ASCII (RS232) for the ASCII transfer mode.
Note: Data transfer can only take place if you have configured the same transfer 
mode (RTU or ASCII) on the CPU (using a button on the front of the module).

2 Click on the command button Next.
Response: The dialog Modbus Target → RTU/ASCII mode is opened.

3 Use the command button COM Port Settings... to open the  dialog COM 
Properties.

4 Use the list field Connect using: to select the programming cable interface on 
the PC (default setting is COM1).

5 Use the list field Bits per second: to select the Baudrate (default is 9600).

6 Use the list field  Parity: to select the parity (default is EVEN).

7 Use the list field Stop Bits to select the Stop bits (default is 1).

8 Click on the command button OK.
Response: The dialog is closed and you return to the dialog Modbus Target → 
RTU/ASCII Mode.
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Protocol settings Carry out the following steps to set the Modbus protocol:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response:The Modbus address of the node is automatically entered in the 
textfeld Modbus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the dialog Modbus Target → RTU mode, and the 
green point disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus node should be 
made via a Modbus Plus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Direct Device, Local 
Head, Remote I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Quantum PLC 
Types, p. 950.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.



Modbus with EXECLoader

840 USE 493 00 September 2001 883

CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit Modbus display. 
The Modbus display is lit again once connection is made with Concept.
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Compact first startup with EXECLoader

Introduction This section describes the first startup of Compact when used with Modbus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 884
l Define Modbus interface, p. 884
l Protocol settings, p. 885
l Select EXEC file, p. 886
l Load EXEC file, p. 886

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the Option button Modbus RTU (RS232) for the RTU transfer mode.
Select the Option button Modbus ASCII (RS232) for the ASCII transfer mode.
Note: Data transfer can only take place if you have configured the same transfer 
mode (RTU or ASCII) on the CPU (using a button on the front of the module).

2 Click on the command button Next.
Response: The dialog Modbus Target → RTU/ASCII mode is opened.

3 Use the command button COM Port Settings... to open the dialog COM 
Properties.

4 Use the list field Connect using: to select the programming cable interface on 
the PC (default setting is COM1).

5 Use the list field Bits per second: to select the Baudrate (default is 9600).

6 Use the list field  Parity: to select the parity (default is EVEN).

7 Use the list field Stop Bits to select the Stop bits (default is 1).

8 Click on the command button OK.
Response: The dialog is closed and you return to the dialog Modbus Target → 
RTU/ASCII Mode.
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Protocol settings Carry out the following steps to set the Modbus protocol:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response:The Modbus address of the node is automatically entered in the 
textfeld Modbus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the dialog Modbus Target → RTU mode, and the 
green point disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus node should be 
made via a Modbus Plus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Direct Device, Local 
Head, Remote I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file CTSX201D.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit Modbus display. 
The Modbus display is lit again once connection is made with Concept.
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Momentum first startup for IEC with EXECLoader

Introduction This section describes the first startup of Momentum for IEC when used with 
Modbus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 888
l Define Modbus interface, p. 889
l Protocol settings, p. 890
l Select EXEC file, p. 891
l Load EXEC file, p. 891

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.
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Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 Select the Option button Modbus RTU (RS232) for the RTU transfer mode.
Select the Option button Modbus ASCII (RS232) for the ASCII transfer mode.
Note: Data transfer can only take place if you have configured the same transfer 
mode (RTU or ASCII) on the CPU (using a button on the front of the module).

2 Click on the command button Next.
Response: The dialog Modbus Target → RTU/ASCII mode is opened.

3 Use the command button COM Port Settings... to open the dialog COM 
Properties.

4 Use the list field Connect using: to select the programming cable interface on 
the PC (default setting is COM1).

5 Use the list field Bits per second: to select the Baudrate (default is 9600).

6 Use the list field  Parity: to select the parity (default is EVEN).

7 Use the list field Stop Bits to select the Stop bits (default is 1).

8 Click on the command button OK.
Response: The dialog is closed and you return to the dialog Modbus Target → 
RTU/ASCII Mode.
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Protocol settings Carry out the following steps to set the Modbus protocol:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response:The Modbus address of the node is automatically entered in the 
textfeld Modbus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the dialog Modbus Target → RTU mode, and the 
green point disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus node should be 
made via a Modbus Plus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Direct Device, Local 
Head, Remote I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Run slow flashing

COM ACT lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Run not lit

COM ACT not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit COM ACT display. 
The COM ACT display is lit again once connection is made with Concept.
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Momentum first startup for LL984 with EXECLoader

Introduction This section describes the first startup of Momentum for LL984 when used with 
Modbus.

The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 893
l Define Modbus interface, p. 894
l Protocol settings, p. 895
l Select EXEC file, p. 896
l Load EXEC file, p. 896

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Note: Loading the EXEC file for LL984 is not necessary with a new computer, since 
it is preloaded in the the CPUs Flash RAM. Loading the EXEC file for LL984 is only 
necessary if you have already loaded the EXEC file for IEC, and now wish to 
change.
You should always check to see if a new EXEC version has been released in the 
meantime.  This information and the current EXEC file can be found on our website 
at www.schneiderautomation.com. You can see the currently loaded version of the  
EXEC file in Concept using the Online → Online controller... menu command.

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.
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Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 Select the Option button Modbus RTU (RS232) for the RTU transfer mode.
Select the Option button Modbus ASCII (RS232) for the ASCII transfer mode.
Note: Data transfer can only take place if you have configured the same transfer 
mode (RTU or ASCII) on the CPU (using a button on the front of the module).

2 Click on the command button Next.
Response: The dialog Modbus Target → RTU/ASCII mode is opened.

3 Use the command button COM Port Settings... to open the  dialog COM 
Properties.

4 Use the list field Connect using: to select the programming cable interface on 
the PC (default setting is COM1).

5 Use the list field Bits per second: to select the Baudrate (default is 9600).

6 Use the list field  Parity: to select the parity (default is EVEN).

7 Use the list field Stop Bits to select the Stop bits (default is 1).

8 Click on the command button OK.
Response: The dialog is closed and you return to the dialog Modbus Target → 
RTU/ASCII Mode.
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Protocol settings Carry out the following steps to set the Modbus protocol:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response:The Modbus address of the node is automatically entered in the 
textfeld Modbus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the dialog Modbus Target → RTU mode, and the 
green point disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus node should be 
made via a Modbus Plus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Direct Device, Local 
Head, Remote I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.



Modbus with EXECLoader

896 840 USE 493 00 September 2001

Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Run slow flashing

COM ACT lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Run not lit

COM ACT not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit COM ACT display. 
The COM ACT display is lit again once connection is made with Concept.
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M
Startup when using Modbus with 
DOS Loader

Introduction

Overview This chapter describes loading executive data (EXEC) onto the PLC with the DOS 
Loader program.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Quantum first startup with DOS Loader 900

Compact first startup with DOS Loader 903

Momentum first startup for IEC with DOS Loader 906

Momentum first startup for LL984 with DOS Loader 909
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Quantum first startup with DOS Loader

Introduction This section describes the first startup of Quantum when used with Modbus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 900
l Define Modbus interface, p. 900
l Protocol settings, p. 901
l Select EXEC file, p. 901
l Load EXEC file, p. 901

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbusoption.
Response: The Modbus communication setup window is opened.

Step Action

1 Select the programming cable interface on the PC (default setting is COM1).

2 Select the Baudrate (default is 9600).

3 Select the parity (default is EVEN).

4 Select the Option button RTU - 8 Bits for the RTU transfer mode.
Select the option ASCII -7 Bits for the ASCII transfer mode.

5 Select the Stop bits (default is 1).
Note: Data transfer can only take place if you have configured the same transfer 
mode (ASCII or RTU) on the CPU (using a button on the front of the module).
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Protocol settings Carry out the following steps to set the Modbus protocol:

Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Enter in Enter PLC Address: the node address set on the CPU (using a rotary 
switch on the back of the module).

2 Select the TARGET PATH 0 option.

3 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Quantum PLC 
Types, p. 950.

3 Confirm your selection with RETURN.
Response: You return to the main menu.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Programoption.
Response: The DOS Loader is exited.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit Modbus display. 
The Modbus display is lit again once connection is made with Concept.
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Compact first startup with DOS Loader

Introduction This section describes the first startup of Compact when used with Modbus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 903
l Define Modbus interface, p. 903
l Protocol settings, p. 904
l Select EXEC file, p. 904
l Load EXEC file, p. 904

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus option.
Response: The Modbus communication setup window is opened.

Step Action

1 Select the programming cable interface on the PC (default setting is COM1).

2 Select the Baudrate (default is 9600).

3 Select the parity (default is EVEN).

4 Select the Option button RTU - 8 Bits for the RTU transfer mode.
Select the option ASCII -7 Bits for the ASCII transfer mode.

5 Select the Stop bits (default is 1).
Note: Data transfer can only take place if you have configured the same transfer 
mode (ASCII or RTU) on the CPU (using a button on the front of the module).
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Protocol settings Carry out the following steps to set the Modbus protocol:

Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Enter in Enter PLC Address: the node address set on the CPU (using a rotary 
switch on the back of the module).

2 Select the TARGET PATH 0 option.

3 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Select the *.BIN file CTSX201D.

3 Confirm your selection with RETURN.
Response: You return to the main menu.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus not lit

Modbus + fast flashing

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + fast flashing

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit Modbus display. 
The Modbus display is lit again once connection is made with Concept.
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Momentum first startup for IEC with DOS Loader

Introduction This section describes the first startup of Momentum for IEC when used with 
Modbus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 906
l Define Modbus interface, p. 906
l Protocol settings, p. 907
l Select EXEC file, p. 907
l Load EXEC file, p. 907

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus option.
Response: The Modbus communication setup window is opened.

Step Action

1 Select the programming cable interface on the PC (default setting is COM1).

2 Select the Baudrate (default is 9600).

3 Select the parity (default is EVEN).

4 Select the Option button RTU - 8 Bits for the RTU transfer mode.
Select the option ASCII -7 Bits for the ASCII transfer mode.

5 Select the Stop bits (default is 1).
Note: Data transfer can only take place if you have configured the same transfer 
mode (ASCII or RTU) on the CPU (using a button on the front of the module).
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Protocol settings Carry out the following steps to set the Modbus protocol:

Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Enter in Enter PLC Address: the node address set on the CPU (using a rotary 
switch on the back of the module).

2 Select the TARGET PATH 0 option.

3 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.

3 Confirm your selection with RETURN.
Response: You return to the main menu.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Run slow flashing

COM ACT lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Run not lit

COM ACT not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit COM ACT display. 
The COM ACT display is lit again once connection is made with Concept.
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Momentum first startup for LL984 with DOS Loader

Introduction This section describes the first startup of Momentum for LL984 when used with 
Modbus.

The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 909
l Define Modbus interface, p. 910
l Protocol settings, p. 910
l Select EXEC file, p. 910
l Load EXEC file, p. 911

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Note: Loading the EXEC file for LL984 is not necessary with a new computer, since 
it is preloaded in the the CPUs Flash RAM. Loading the EXEC file for LL984 is only 
necessary if you have already loaded the EXEC file for IEC, and now wish to 
change.
You should always check to see if a new EXEC version has been released in the 
meantime.  This information and the current EXEC file can be found on our website 
at www.schneiderautomation.com. You can see the currently loaded version of the  
EXEC file in Concept using the Online → Online controller... menu command.

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus option.
Response: The Modbus communication setup window is opened.



Modbus with DOS Loader

910 840 USE 493 00 September 2001

Define Modbus 
interface

Carry out the following steps to set the Modbus interface:

Protocol settings Carry out the following steps to set the Modbus protocol:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Select the programming cable interface on the PC (default setting is COM1).

2 Select the Baudrate (default is 9600).

3 Select the parity (default is EVEN).

4 Select the Option button RTU - 8 Bits for the RTU transfer mode.
Select the option ASCII -7 Bits for the ASCII transfer mode.

5 Select the Stop bits (default is 1).
Note: Data transfer can only take place if you have configured the same transfer 
mode (ASCII or RTU) on the CPU (using a button on the front of the module).

Step Action

1 Enter in Enter PLC Address: the node address set on the CPU (using a rotary 
switch on the back of the module).

2 Select the TARGET PATH 0 option.

3 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

LED Response

Run slow flashing

COM ACT lit (with some interruptions)

Modbus + 3x flashes with interruptions

LED Response

Run not lit

COM ACT not lit

Modbus + 3x flashes with interruptions

Note: The three flash sequence Modbus + display idicates that no communication 
is present on the bus. This is displayed on Modbus by a non-lit COM ACT display. 
The COM ACT display is lit again once connection is made with Concept.



Modbus with DOS Loader

912 840 USE 493 00 September 2001

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.
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N
Startup when using Modbus Plus 
with the EXECLoader

Introduction

Overview This chapter describes loading executive data (EXEC) onto the PLC with the 
EXECLoader.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Quantum first startup with EXECLoader 914

Compact first startup with EXECLoader 918

Atrium first startup with EXECLoader 922

Momentum first startup for IEC with EXECLoader 925

Momentum first startup for LL984 with EXECLoader 929
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Quantum first startup with EXECLoader

Introduction This section describes the first startup of Quantum when used with Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 914
l Define SA85 adapter, p. 914
l Protocol settings, p. 915
l Select EXEC file, p. 916
l Load EXEC file, p. 916

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the option button Modbus Plus.

2 Click on the command button Next.
Response: The Modbus Plus Target dialog is opened.

3 Select from the list Devices Online: the adapter address you set when installing 
the SA85 in the CONFIG.SYS file (Parameter /n). 
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus Plus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response: The Modbus address of the node is automatically entered in the 
textfeld In the text field Modbus Plus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the Modbus Plus Target dialog, and the green point 
disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus network node 
should be made via a Modbus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Local Head, Remote 
I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Quantum PLC 
Types, p. 950.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus not lit

Modbus + fast flashing

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Compact first startup with EXECLoader

Introduction This section describes the first startup of Compact when used with Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 918
l Define SA85 adapter, p. 918
l Protocol settings, p. 919
l Select EXEC file, p. 920
l Load EXEC file, p. 920

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the option button Modbus Plus.

2 Click on the command button Next.
Response: The Modbus Plus Target dialog is opened.

3 Select from the list Devices Online: the adapter address you set when installing 
the SA85 in the CONFIG.SYS file (Parameter /n). 
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus Plus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response: The Modbus address of the node is automatically entered in the 
textfeld In the text field Modbus Plus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the Modbus Plus Target dialog, and the green point 
disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus network node 
should be made via a Modbus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Local Head, Remote 
I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file CTSX201D.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Ready lit

Run slow flashing

Modbus not lit

Modbus + fast flashing

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Atrium first startup with EXECLoader

Introduction This section describes the first startup of Atrium when used with Modbus Plus. The 
hardware requirements for loading EXEC files can be seen in the "Modicon TSX 
Atrium" manual.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 922
l Define SA85 adapter, p. 922
l Protocol settings, p. 923
l Select EXEC file, p. 924
l Load EXEC file, p. 924

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the option button Modbus Plus.

2 Click on the command button Next.
Response: The Modbus Plus Target dialog is opened.

3 Select from the list Devices Online: the adapter address you set when installing 
the SA85 in the CONFIG.SYS file (Parameter /n). 
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus Plus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response: The Modbus address of the node is automatically entered in the 
textfeld In the text field Modbus Plus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the Modbus Plus Target dialog, and the green point 
disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus network node 
should be made via a Modbus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Local Head, Remote 
I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Atrium PLC Types, 
p. 952.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration + program must be reloaded on the PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.



Modbus Plus with EXECLoader

840 USE 493 00 September 2001 925

Momentum first startup for IEC with EXECLoader

Introduction This section describes the first startup of Momentum for IEC when used with 
Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 925
l Define SA85 adapter, p. 925
l Protocol settings, p. 926
l Select EXEC file, p. 927
l Load EXEC file, p. 927

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the option button Modbus Plus.

2 Click on the command button Next.
Response: The Modbus Plus Target dialog is opened.

3 Select from the list Devices Online: the adapter address you set when installing 
the SA85 in the CONFIG.SYS file (Parameter /n). 
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus Plus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response: The Modbus address of the node is automatically entered in the 
textfeld In the text field Modbus Plus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the Modbus Plus Target dialog, and the green point 
disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus network node 
should be made via a Modbus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Local Head, Remote 
I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Run slow flashing

COM ACT not lit

Modbus + fast flashing

LED Response

Run not lit

COM ACT not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Momentum first startup for LL984 with EXECLoader

Introduction This section describes the first startup of Momentum for LL984 when used with 
Modbus Plus.

The first startup is subdivided into 5 main sections:
l Start EXECLoader, p. 929
l Define SA85 adapter, p. 929
l Protocol settings, p. 930
l Select EXEC file, p. 931
l Load EXEC file, p. 931

Start 
EXECLoader

The procedure for launching EXECLoaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Note: Loading the EXEC file for LL984 is not necessary with a new computer, since 
it is preloaded in the the CPUs Flash RAM. Loading the EXEC file for LL984 is only 
necessary if you have already loaded the EXEC file for IEC, and now wish to 
change.
You should always check to see if a new EXEC version has been released in the 
meantime.  This information and the current EXEC file can be found on our website 
at www.schneiderautomation.com. You can see the currently loaded version of the  
EXEC file in Concept using the Online → Online controller... menu command.

Step Action

1 Open the Concept start menu.
Response: All installed Concept programs are displayed as symbols.

2 Click on the symbol with the identifier EXECLoader.
Response: The EXECLoader program is started.

3 Click on the command Next, as soon as you have read the information on the 
page.
Response: The dialog Communication Protocol is opened.

Step Action

1 Select the option button Modbus Plus.

2 Click on the command button Next.
Response: The Modbus Plus Target dialog is opened.

3 Select from the list Devices Online: the adapter address you set when installing 
the SA85 in the CONFIG.SYS file (Parameter /n). 
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Step Action

1 Click on the command button Scan.
Response: The nodes on the Modbus Plus network are read and displayed 
graphically in the left window. A green point in the graphic indicates that the CPU 
is in RUN mode. To stop the CPU continue as described in step 3.

2 Double-click on the read network node in the graphical display.
Response: The Modbus address of the node is automatically entered in the 
textfeld In the text field Modbus Plus Address.

3 Click the right mouse button in the left window.
Response: A context menu with individual PLC commands is opened.

4 If the "Run" display is lit on the CPU, stop the program using the command Stop 
PLC.
Response: A message window appears where you can click OK to confirm 
stopping the CPU.

5 Click the command button OK, to confirm stopping the CPU.
Response: You return to the Modbus Plus Target dialog, and the green point 
disappears from the graph.

6 Activate the check box Bridge, if the connection to the Modbus network node 
should be made via a Modbus network using a Modbus bridge.

7 Press the appropriate Option button for your system (PLC, Local Head, Remote 
I/O Drop).

8 Click on the command button Next.
Response: The Operation dialog is opened.
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Select EXEC file Carry out the following steps to select the EXEC file:

Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Step Action

1 Press the Option button Transfer EXEC to Device.

2 Click on the command button Browse....
Response: The  Concept directory is opened in a standard window.

3 Double-click on the DAT directory.
Response: All available*.BIN files are displayed.

4 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.
Response: The selected *.BIN file is displayed in File name: text field.

5 Click on the command button Open.
Response: You return to the dialog Operation, and the path to the selected 
*.BIN file is displayed in the Filename text field.

6 Click on the command button Next.
Response: The dialog File and Device Info is opened. Information is provided 
here about the selected *.BIN file and also about the PLC.

7 Click on the command button Next.
Response: The Summary dialog is opened. This gives you an overview of the 
settings made for you to check.

Step Action

1 Click on the command button Transfer.
Response: A message box appears warning you that all data available on the 
PLC will be lost, and the configuration and program must be reloaded on the 
PLC.

2 Click on the command button Yes, to continue the transfer.
Response: The Progress dialog is opened. This gives information about the 
progress of the transfer in a progress bar and text.

3 Click Close once the transfer is complete.
Response: The dialog is closed, and you return to the dialog Summary.

4 Click on the command button Close, to close the EXECLoader.
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CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

LED Response

Run slow flashing

COM ACT not lit

Modbus + fast flashing

LED Response

Run not lit

COM ACT not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.



840 USE 493 00 September 2001 933

O
Startup when using Modbus Plus 
with DOS Loader

Introduction

Overview This chapter describes loading executive data (EXEC) onto the PLC with the DOS 
Loader program.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

Quantum first startup with DOS Loader 934

Compact first startup with DOS Loader 937

Atrium first startup with DOS Loader 940

Momentum first startup for IEC with DOS Loader 943

Momentum first startup for LL984 with DOS Loader 946
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Quantum first startup with DOS Loader

Introduction This section describes the first startup of Quantum when used with Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 934
l Define SA85 adapter, p. 934
l Protocol settings, p. 935
l Select EXEC file, p. 935
l Load EXEC file, p. 936

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus Plusoption.
Response: The Modbus Plus communication setup window is opened.

Step Action

1 Select the adapter address you set when installing the SA85 in the CONFIG.SYS 
file (Parameter /n). 

2 Confirm your selection with RETURN.
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Enter in Enter First Routing Path: the node address set on the CPU (using a 
rotary switch on the back of the module).

2 Confirm the entry with RETURN.
Response: The option Enter second Routing Path: appears.

3 Acknowledge the option with RETURN.
Response: The window for selecting the TARGET PATH appears.

4 Select the TARGET PATH 1 option.

5 Enter in Enter Software Interrupt -> the Interrupt (5c or 5d) selected in the 
CONFIG.SYS file.

6 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Quantum PLC 
Types, p. 950.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

LED Response

Ready lit

Run slow flashing

Modbus not lit

Modbus + fast flashing

LED Response

Ready lit

Run not lit

Modbus not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Compact first startup with DOS Loader

Introduction This section describes the first startup of Compact when used with Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 937
l Define SA85 adapter, p. 937
l Protocol settings, p. 938
l Select EXEC file, p. 938
l Load EXEC file, p. 939

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus Plus option.
Response: The Modbus Plus communication setup window is opened.

Step Action

1 Select the adapter address you set when installing the SA85 in the CONFIG.SYS 
file (Parameter /n). 

2 Confirm your selection with RETURN.
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Enter in Enter First Routing Path: the node address set on the CPU (using a 
rotary switch on the back of the module).

2 Confirm the entry with RETURN.
Response: The option Enter second Routing Path: appears.

3 Acknowledge the option with RETURN.
Response: The window for selecting the TARGET PATH appears.

4 Select the TARGET PATH 1 option.

5 Enter in Enter Software Interrupt -> the Interrupt (5c or 5d) selected in the 
CONFIG.SYS file.

6 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Select the *.BIN file CTSX201D.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Atrium first startup with DOS Loader

Introduction This section describes the first startup of Atrium when used with Modbus Plus. The 
hardware requirements for loading EXEC files can be seen in the "Modicon TSX 
Atrium" manual.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 940
l Define SA85 adapter, p. 940
l Protocol settings, p. 941
l Select EXEC file, p. 941
l Load EXEC file, p. 942

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus Plus option.
Response: The Modbus Plus communication setup window is opened.

Step Action

1 Select the adapter address you set when installing the SA85 in the CONFIG.SYS 
file (Parameter /n). 

2 Confirm your selection with RETURN.
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Enter in Enter First Routing Path: the node address set on the CPU (using a 
rotary switch on the back of the module).

2 Confirm the entry with RETURN.
Response: The option Enter second Routing Path: appears.

3 Acknowledge the option with RETURN.
Response: The window for selecting the TARGET PATH appears.

4 Select the TARGET PATH 1 option.

5 Enter in Enter Software Interrupt -> the Interrupt (5c or 5d) selected in the 
CONFIG.SYS file.

6 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Atrium PLC Types, 
p. 952.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Momentum first startup for IEC with DOS Loader

Introduction This section describes the first startup of Momentum for IEC when used with 
Modbus Plus.
The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 943
l Define SA85 adapter, p. 943
l Protocol settings, p. 944
l Select EXEC file, p. 944
l Load EXEC file, p. 945

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus Plusoption.
Response: The Modbus Plus communication setup window is opened.

Step Action

1 Select the adapter address you set when installing the SA85 in the CONFIG.SYS 
file (Parameter /n). 

2 Confirm your selection with RETURN.
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Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Enter in Enter First Routing Path: the node address set on the CPU (using a 
rotary switch on the back of the module).

2 Confirm the entry with RETURN.
Response: The option Enter second Routing Path: appears.

3 Acknowledge the option with RETURN.
Response: The window for selecting the TARGET PATH appears.

4 Select the TARGET PATH 1 option.

5 Enter in Enter Software Interrupt -> the Interrupt (5c or 5d) selected in the 
CONFIG.SYS file.

6 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

LED Response

Run slow flashing

COM ACT not lit

Modbus + fast flashing

LED Response

Run not lit

COM ACT not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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Momentum first startup for LL984 with DOS Loader

Introduction This section describes the first startup of Momentum for LL984 when used with 
Modbus Plus.

The first startup is subdivided into 5 main sections:
l Start DOS Loader, p. 946
l Define SA85 adapter, p. 947
l Protocol settings, p. 947
l Select EXEC file, p. 947
l Load EXEC file, p. 948

Start DOS Loader The procedure for launching DOS Loaders is as follows:

Note: Loading the EXEC file for LL984 is not necessary with a new computer, since 
it is preloaded in the the CPUs Flash RAM. Loading the EXEC file for LL984 is only 
necessary if you have already loaded the EXEC file for IEC, and now wish to 
change.
You should always check to see if a new EXEC version has been released in the 
meantime.  This information and the current EXEC file can be found on our website 
at www.schneiderautomation.com. You can see the currently loaded version of the  
EXEC file in Concept using the Online → Online controller... menu command.

Step Action

1 If the CPU display "Run" is lit, stop the program with Concept (in main menu 
Online).
Response: The "Run" display is no longer lit; the "Ready" is now lit.

2 Open the directory DAT (CONCEPT\DAT).

3 Double-click on the file LOADER.EXE.
Response: The installation program for the Executive file (EXEC) is started.

4 Select the option Communication Parameters.
Response: The dialog box Communication setup is opened.

5 Select the Modbus Plus option.
Response: The Modbus Plus communication setup window is opened.
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Define SA85 
adapter

Carry out the following steps to define the LAN address set in the CONFIG.SYS file:

Protocol settings Carry out the following steps to set the Modbus Plus protocol settings:

Select EXEC file Carry out the following steps to select the EXEC file:

Step Action

1 Select the adapter address you set when installing the SA85 in the CONFIG.SYS 
file (Parameter /n). 

2 Confirm your selection with RETURN.

Step Action

1 Enter in Enter First Routing Path: the node address set on the CPU (using a 
rotary switch on the back of the module).

2 Confirm the entry with RETURN.
Response: The option Enter second Routing Path: appears.

3 Acknowledge the option with RETURN.
Response: The window for selecting the TARGET PATH appears.

4 Select the TARGET PATH 1 option.

5 Enter in Enter Software Interrupt -> the Interrupt (5c or 5d) selected in the 
CONFIG.SYS file.

6 Select the ACCEPT CHANGES option.
Response: You return to the main menu.

Step Action

1 Select the option File Selection.
Response: The File Selection window is opened.

2 Click on the *.BIN file that corresponds to your CPU and the desired 
programming language. See the table Loading Firmware for Momentum PLC 
Types, p. 951.

3 Confirm your selection with RETURN.
Response: You return to the main menu.
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Load EXEC file Carry out the following steps to load the EXEC file in the CPU flash RAM:

CPU display 
during transfer

During transfer the CPU display is as follows:

CPU display after 
transfer

After transfer the CPU display is as follows:

Creating the 
software 
connection

Carry out the steps given in chapter Creating a Project, p. 43.

Step Action

1 Select the option Load File To PLC.
Response: The Loading Process window is opened, and the warning "The 
PROGRAM contents of the device being loaded could be lost after loading a new 
Executive. The CONTENTS stored in the Micro H H P will always be lost after 
loading a new Executive. Would you like to continue (Y/N) ? N" is displayed.

2 Acknowledge the warning with Y.
Response: The message "Node failed to enter normal mode" appears.

3 The DOWNLOAD PROGRESS window appears which shows the transfer rate.
Response: After the transfer is complete, the message "Download Operation 
Successful" appears.

4 Confirm the message with RETURN.
Response: You return to the main menu.

5 Select the Exit Program option.
Response: The DOS Loader is exited.

LED Response

Run slow flashing

COM ACT not lit

Modbus + fast flashing

LED Response

Run not lit

COM ACT not lit

Modbus + fast flashing

Note: If you recieve an error message, close Concept and start the 
BDRESET.EXE file (in the \Concept directory) to reset the SA85. Then start again 
from the first step.
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P
EXEC files

Loading Firmware

At a Glance You obtain the PLC types of the different firmware by loading the EXEC files (*.BIN).
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Loading 
Firmware for 
Quantum PLC 
Types

Assigning the EXEC files:

Loading 
Firmware for 
Quantum LL984 
Hot Standby 
Operation

The Quantum CPUs not ending in X or S can be used for the LL984-Hot Standby 
operation. A special EXEC file must be downloaded onto the CPU for this. The 
loadable for LL984 Hot Standby (CHS_208.DAT) is automatically installed by the 
system.

140 CPU Q186Vxxx
(IEC+LL984)

Q486Vxxx
(IEC+LL984)

Q58VxxxD
(IEC+LL984)

Q5RVxxxD
(IEC+LL984)

QIECVxxx
(IEC only) *

IEC Memory
(kByte)

113 02 X
(LL984 only)

- - - -

113 02S - - - - X max. 150

113 02X X
(LL984 only)

- - - -

113 03 X - - - - max. 136

113 03S - - - - X max. 379

113 03X X - - - - max. 136

213 04 X - - - - max. 305

213 04S - - - - X max. 610

213 04X X - - - - max. 305

424 0x - X - - - max. 465

424 0xX - X - - - max. 465

434 12 - - X - - max. 890

534 14 - - X - - max. 2550

434 12A
(Redesigned 
CPU)

- - - X - max. 890

534 14A
(Redesigned 
CPU

- - - X - max. 2550

Note: * After the QIECVxxx.BIN EXEC file is loaded the EMUQ.EXE loadable must 
be loaded in Concept in the Loadables (PLC Configuration → Loadables...) 
dialog box.
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Loading 
Firmware for 
Quantum IEC Hot 
Standby 
Operation

The CPUs 140 CPU 434 12 and 140 CPU 534 14 can also be used for IEC Hot 
Standby. A special EXEC file must be downloaded onto the CPU for this. The 
loadables for IEC Hot Standby (IHSB196.EXE and CHS_208.DAT) are 
automatically installed by the system. 

Loading 
Firmware for 
Quantum 
Equation Editor

The Quantum CPUs not ending in X or S can be used for the LL984- equation editor. 
A special EXEC file must be downloaded onto the CPU flash for this. This EXEC file 
is not part of the Concept delivery range but can be obtained via the internet at 
www.schneiderautomation.com.

Loading 
Firmware for 
Momentum PLC 
Types

Assigning the EXEC files for Momentum PLC type (CPU 171 CCC 7x0 x0):

Assigning the EXEC files for Momentum PLC type (CPU 171 CCC 9x0 x0):

Assigning the EXEC files for Momentum PLC type (CPU 171 CCS 7x0 x0):

The stripped EXEC of the M1 supports up to a maximum of 44 I/O modules.

171 CCC M1Vxxx
(LL984 only)

M1IECxxx
(IEC only)

IEC Memory
(kByte)

760 10-984 X -

760 10-IEC - X 256

780 10-984 X -

780 10-IEC - X 256

171 CCC M1EVxxx
(LL984 only)

M1EWIxxx
(IEC only)

IEC Memory
(kByte)

960 20-984 X -

960 30-984 X -

960 30-IEC - X 220

980 20-984 X -

980 30-984 X -

980 30-IEC - X 220

171 CCS M1Vxxx
(LL984 only)

M1IECxxx
(IEC only)

IEC Memory
(kByte)

700 10 X -

700/780 00 X -

760 00-984 X -

760 00-IEC - X 160
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Loading 
Firmware for 
Compact PLC 
Types

The CTSXxxxD.BIN EXEC file must be downloaded onto the CPU flash for all 
Compact CPUs. 

Loading 
Firmware for 
Atrium PLC 
Types

A special EXEC file must be downloaded onto the CPU flash for each Atrium CPU 
(see table below).

180 CCO EXEC File

121 01 AI38Vxxx.BIN

241 01 AI58Vxxx.BIN

Note: No EXEC file needs to be downloaded for the 180 ASP 26x xx (SoftPLC) 
CPU.
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Q
Settings in the CONCEPT.INI

Introduction

Overview This chapter contains the settings that can be carried out in the CONCEPT.INI file.

What’s in this 
chapter?

This chapter contains the following topics:

Topic Page

General information on the Concept INI file 954

INI Print Settings 955

INI Settings for the Register Address Format, for Variable Storage and for 
Defining the Project Name

956

INI Settings for Global DFBs [Path] [Upload] 957

Representation of Internal Data in the INI File 959

INI Settings for the LD Section 959

INI-Settings for Online Animation [Colors] 960
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General information on the Concept INI file

Introduction Software settings can be specified in the Concept INI file. Settings generated by the 
program are also stored in the INI file. The INI file initially contains defaults that can 
subsequently be changed.

Where is the 
CONCEPT.INI file 
situated?

After the installation of Concept, the CONCEPT.INI file can be found in the Windows 
directory.

Editing the INI 
File

Various settings are given (exception: path information) and divided into several 
keywords. The lines that begin with a semicolon (;) represent comments or explain 
the subsequent setting. 
To edit the INI file, only change the lines without semicolons (;) or insert a new line 
after the comment, in which to specify the path. Then save the modified file.

Note: Changes in the INI file are only accepted after Concept/DFB Editor/
Converter is restarted.
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INI Print Settings [Print]

Printing FBD 
Sections

Defining default page break values for FBD sections:

Printing LD 
Sections

Defining default page break values for LD sections:

Printing SFC 
Sections

Defining default page break values for SFC sections:

Setting Description

DX_FBD_PORTRAIT= Specify portrait width (default value at delivery = 75)

DY_FBD_PORTRAIT= Specify portrait height (default value at delivery = 100)

DX_FBD_LANDSCAPE= Specify landscape width (default value at delivery = 100)

DY_FBD_LANDSCAPE= Specify landscape height (default value at delivery = 50)

Setting Description

DX_LD_PORTRAIT= Specify portrait width (default value at delivery = 70)

DY_LD_PORTRAIT= Specify portrait height (default value at delivery = 35)

DX_LD_LANDSCAPE= Specify landscape width (default value at delivery = 105)

DY_LD_LANDSCAPE= Specify landscape height (default value at delivery = 18)

Setting Description

DX_SFC_PORTRAIT= Specify portrait width (default value at delivery = 11)

DY_SFC_PORTRAIT= Specify portrait height (default value at delivery = 20)

DX_SFC_LANDSCAPE= Specify landscape width (default value at delivery = 15)

DY_SFC_LANDSCAPE= Specify landscape height (default value at delivery = 11)
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INI Settings for the Register Address Format, for Variable Storage and for 
Defining the Project Name

Defining the 
Register 
Address Format 
[Common]

Specifying the register address format (e.g. 4x reference):

Defining Variable 
Storage 
[Common]

Store variables in file:

Determining the 
Permissibility of 
Digits in Project 
Names 
[Common]

Determining the permissibility of digits in project names:

Setting Description

AddrStyle=0 0 = 400001 (default)

AddrStyle=1 1 = 4:00001 (separator)

AddrStyle=2 2 = 4:1 (compact)

AddrStyle=3 3 = QW00001 (IEC)

Setting Description

ExportVariables=1 After a project has been downloaded and saved, all 
variables are stored in a file. This file is called *.VAR and is 
found in the "Project directory" → VAR → *.VAR. All 
variables and their attributes are shown in this file.

ExportVariables=0 Additional storage of variables in a file does not take place.

Setting Description

ProjectPrefixDigit=1 Project names that begin with a digit are permitted.

ProjectPrefixDigit=0 Project names that begin with a digit are not permitted.
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INI Settings for Global DFBs [Path] [Upload]

Defining the Path 
for Global DFBs 
and Help Files 
[Path]

Defining paths:

Defining the 
Storage of Global 
DFBs during 
Upload

Defining a new directory for global DFBs:

Setting Description

GlobalDFBPath= Specify path for global DFBs.

HelpPath= Specify paths for help files.

Setting Description

PreserveGlobalDFBs=1 During the upload process, a GLB directory for the global 
DFBs is created in the project directory. By doing this, 
existing global DFBs in the Concept DFB directory will not 
be overwritten.
Advantage: No impact on other projects, as the global 
DFBs in these projects are not overwritten.
Disadvantage: Multiple copies of global DFBs.
Note: Also read the sections entitled How are Global DFBs 
Stored?, p. 958 and How are Global DFBs Read?, p. 958.

PreserveGlobalDFBs=0 During the upload process, global DFBs are downloaded 
into the Concept DFB directory. Different versions of 
duplicated DFBs are recognized and overwritten after being 
queried.
Advantage: Only one copy of global DFBs for several 
projects.
Disadvantage: Existing global DFBs whose versions differ 
from the uploaded DFBs are overwritten. This can cause 
other projects to be inconsistent in certain circumstances.
Note: Also read the sections entitled How are Global DFBs 
Stored?, p. 958 and How are Global DFBs Read?, p. 958.
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How are Global 
DFBs Stored?

Storage of global DFBs depends on the settings in the INI file: 

How are Global 
DFBs Read?

When a project is opened, the system looks for DFBs in the following order:

Only the global DFBs from one directory are used, i.e. if step 1 is unsuccessful, then 
step 2 follows, step 3 is only performed if neither of the first two are successful.

If a project... then the global DFBs are...

is newly created, and no new DFB path has 
been defined in the INI file,

stored in the x:\CONCEPT\DFB directory.

is newly created, and a new DFB path has 
been defined in the INI file,

stored in the DFB directory defined in the path.

is uploaded, and the following settings exist 
in the INI file:
- the [Path] option 
"GlobalDFBPath=x:\DFB",
- the [Upload] option 
"PreserveGlobalDFBs=0",

stored in the DFB directory defined in the path 
(x:\DFB).

is uploaded, and the following settings exist 
in the INI file:
- the [Path] option 
"GlobalDFBPath=x:\DFB",
- the [Upload] option 
"PreserveGlobalDFBs=1",

stored in the project’s GLB directory.
Note: The GLB directory is always used first, as 
soon as the "PreserveGlobalDFBs=1" [Upload] 
option is specified.

Step Description

1 The project directory is searched for an existing GLB directory.

2 The relevant settings are checked in the INI file.
For example:
[Path]: GlobalDFBPath=x:\DFB
[Upload]: PreserveGlobalDFBs=0
In this example, the DFB directory of the path defined is searched for global 
DFBs.

3 The DFB directory under x:\CONCEPT\DFB is searched.
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Representation of Internal Data in the INI File

Representation 
of Internal Data

The following keywords appear in the INI file and contain internal data according to 
specific Concept applications:
l [Debug]
l [Configurator]
l [Search]
l [Registration]
l [Register]

INI Settings for the LD Section

Defining the 
Contact 
Connection

Defining the contact connection to the power rail:

Defining the 
Number of 
Columns/Fields

Defining the number of columns/fields (only available when editing with keys):

Setting Description

ExtendedAutoConnect=0 Only the contacts from the first column in the LD editor are 
automatically connected to the power rail.

ExtendedAutoConnect=1 The contacts from the first and second columns in the LD 
editor are automatically connected to the power rail.

Setting Description

AutowrapColumn=51 The section contains 51 columns/fields by default. It is 
possible to set from 2 to 51 columns/fields.
When the last column/field is reached, the following objects 
are automatically placed in the next lines. When this 
happens, a link with the previous lines is established, i.e. the 
objects are generated within a common rung.
Note: Since with automatic line breaking, the objects that 
follow are placed in the second column/field, it is 
recommended that you set the contact connection to the 
power rail as ExtendedAutoConnect=0.
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INI-Settings for Online Animation [Colors]

Line Width Defining the line width of connections in FBD and LD and for objects in LD:

Setting Description

AnimationSize= Setting the width of the lines. The default 
setting is 1. It can be set from 1 to 10.
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Glossary

Active Window The window, which is currently selected. Only one window can be active at any 
given time. When a window is active, the color of the title bar changes, so that it is 
distinguishable from the other windows. Unselected windows are inactive.

Actual 
Parameters

Current connected Input / Output Parameters.

Addresses (Direct) addresses are memory ranges in the PLC. They are located in the State 
RAM and can be assigned Input/Output modules.
The display/entry of direct addresses is possible in the following formats:
l Standard Format (400001)
l Separator Format (4:00001)
l Compact format (4:1)
l IEC Format (QW1)

ANL_IN ANL_IN stands for the "Analog Input" data type and is used when processing analog 
values. The 3x-References for the configured analog input module, which were 
specified in the I/O component list, are automatically assigned data types and 
should therefore only be occupied with Unlocated Variables.

ANL_OUT ANL_OUT stands for the "Analog Output" data type and is used when processing 
analog values. The 3x-References for the configured analog input module, which 
were specified in the I/O component list, are automatically assigned data types and 
should therefore only be occupied with Unlocated Variables.

ANY In the above version "ANY" covers the BOOL, BYTE, DINT, INT, REAL, UDINT, 
UINT, TIME and WORD elementary data types and related Derived Data Types.

A
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ANY_BIT In the above version "ANY_BIT" covers the BOOL, BYTE and WORD data types.

ANY_ELEM In the above version "ANY_ELEM" covers the BOOL, BYTE, DINT, INT, REAL, 
UDINT, UINT, TIME and WORD data types.

ANY_INT In the above version "ANY_INT" covers the DINT, INT, UDINT and UINT data types.

ANY_NUM In the above version "ANY_NUM" covers the DINT, INT, REAL, UDINT and UINT 
data types.

ANY_REAL In the above version "ANY_REAL" covers the REAL data type.

Application 
Window

The window containing the workspace, menu bar and the tool bar for the application 
program. The name of the application program appears in the title bar. An 
application window can contain several Document windows. In Concept the 
application window corresponds to a Project.

Argument Synonymous with Actual parameters.

ASCII-Mode The ASCII (American Standard Code for Information Interchange) mode is used to 
communicate with various host devices. ASCII works with 7 data bits.

Atrium The PC based Controller is located on a standard AT board, and can be operated 
within a host computer in an ISA bus slot. The module has a motherboard (requiring 
SA85 driver) with two slots for PC104 daughter-boards. In this way, one PC104 
daughter-board is used as a CPU and the other as the INTERBUS controller.

Backup file 
(Concept-EFB)

The backup file is a copy of the last Source coding file. The name of this backup file 
is "backup??.c" (this is assuming that you never have more than 100 copies of the 
source coding file). The first backup file has the name "backup00.c". If you have 
made alterations to the Definitions file, which do not cause any changes to the EFB 
interface, the generation of a backup file can be stopped by editing the source 
coding file (Objects → Source). If a backup file is created, the source file can be 
entered as the name.

B
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Base 16 literals Base 16 literals are used to input whole number values into the hexadecimalsystem. 
The base must be denoted using the prefix 16#. The values can not have any signs 
(+/-). Single underscores ( _ ) between numbers are not significant.

Example
16#F_F or 16#FF (decimal 255) 
16#E_0 or 16#E0 (decimal 224)

Base 2 literals Base 2 literals are used to input whole number values into the dualsystem. The base 
must be denoted using the prefix 2#. The values can not have any signs (+/-). Single 
underscores ( _ ) between numbers are not significant.

Example
2#1111_1111 or 2#11111111 (decimal 255) 
2#1110_0000 or 2#11100000 (decimal 224)

Base 8 literals Base 8 literals are used to input whole number values into the octosystem. The base 
must be denoted using the prefix 8#. The values can not have any signs (+/-). Single 
underscores ( _ ) between numbers are not significant.

Example
8#3_77 or 8#377 (decimal 255) 
8#34_0 or 8#340 (decimal 224)

Binary 
Connections

Connections between FFB outputs and inputs with the data type BOOL.

Bitsequence A data element, which consists of one or more bits.

BOOL BOOL stands for the data type "boolean". The length of the data element is 1 bit 
(occupies 1 byte in the memory). The value range for the variables of this data type 
is 0 (FALSE) and 1 (TRUE).

Bridge A bridge is a device, which connects networks. It enables communication between 
nodes on two networks. Each network has its own token rotation sequence - the 
token is not transmitted via the bridge.

BYTE BYTE stands for the data type "bit sequence 8". Entries are made as base 2 literal, 
base 8 literal or base 16 literal. The length of the data element is 8 bits. A numerical 
value range can not be assigned to this data type.
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Clipboard The clipboard is a temporary memory for cut or copied objects. These objects can 
be entered in sections. The contents of the clipboard are overwritten with each new 
cut or copy.

Coil A coil is a LD element which transfers the status of the horizontal short on its left 
side, unchanged, to the horizontal short on its right side. In doing this, the status is 
saved in the relevant variable/direct address.

Compact format 
(4:1)

The first digit (the Reference) is separated from the address that follows by a colon 
(:) where the leading zeros are not specified.

Constants Constants are Unlocated variables, which are allocated a value that cannot be 
modified by the logic program (write protected).

Contact A contact is a LD element, which transfers a status on the horizontal link to its right 
side. This status comes from the boolean AND link of the status of the horizontal link 
on the left side, with the status of the relevant variable/direct address. A contact 
does not change the value of the relevant variable/direct address.

Data transfer 
settings

Settings which determine how information is transferred from your programming 
device to the PLC.

Data Types The overview shows the data type hierarchy, as used for inputs and outputs of 
functions and function blocks. Generic data types are denoted using the prefix 
"ANY".
l ANY_ELEM

l ANY_NUM
ANY_REAL (REAL)
ANY_INT (DINT, INT, UDINT, UINT)

l ANY_BIT (BOOL, BYTE, WORD)
l TIME

l System Data types (IEC Extensions)
l Derived (from "ANY" data types)

C

D
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DCP I/O drop A remote network with a super-ordinate PLC can be controlled using a Distributed 
Control Processor (D908). When using a D908 with remote PLC, the super-ordinate 
PLC considers the remote PLC as a remote I/O drop. The D908 and the remote PLC 
communicate via the system bus, whereby a high performance is achieved with 
minimum effect on the cycle time. The data exchange between the D908 and the 
super-ordinate PLC takes place via the remote I/O bus at 1.5Mb per second. A 
super-ordinate PLC can support up to 31 D908 processors (addresses 2-32).

DDE (Dynamic 
Data Exchange)

The DDE interface enables a dynamic data exchange between two programs in 
Windows. The user can also use the DDE interface in the extended monitor to 
invoke their own display applications. With this interface, the user (i.e. the DDE 
client) can not only read data from the extended monitor (DDE server), but also write 
data to the PLC via the server. The user can therefore alter data directly in the PLC, 
while monitoring and analyzing results. When using this interface, the user can 
create their own "Graphic Tool", "Face Plate" or "Tuning Tool" and integrate into the 
system. The tools can be written in any language, i.e. Visual Basic, Visual C++, 
which supports DDE. The tools are invoked, when the user presses one of the 
buttons in the Extended Monitor dialog field. Concept Graphic Tool: Configuration 
signals can be displayed as a timing diagram using the DDE connection between 
Concept and Concept Graphic Tool.

Declaration Mechanism for specifying the definition of a language element. A declaration usually 
covers the connection of an identifier to a language element and the assignment of 
attributes such as data types and algorithms.

Definitions file 
(Concept-EFB)

The definitions file contains general descriptive information on the selected EFB and 
its formal parameters.

Derived Data 
Type

Derived data types are data types, which are derived from Elementary Data Types 
and/or other derived data types. The definition of derived data types is found in the 
Concept data type editor.
A distinction is made between global data types and local data types.

Derived Function 
Block (DFB)

A derived function block represents the invocation of a derived function block type. 
Details of the graphic form of the invocation can be found in the "Functional block 
(instance)". In contrast to the invocation of EFB types, invocations of DFB types are 
denoted by double vertical lines on the left and right hand side of the rectangular 
block symbol.
The body of a derived function block type is designed using FBD language, LD 
language, ST language, IL language, however, this is only the case in the current 
version of the programming system. Furthermore, derived functions can not yet be 
defined in the current version.
A distinction is made between local and global DFBs.
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Device Address The device address is used to uniquely denote a network device in the routing path. 
The address is set on the device directly, e.g. using the rotary switch on the back of 
the modules.

DFB Code The DFB code is the section’s DFB code, which can be executed. The size of the 
DFB code is mainly dependant upon the number of blocks in the section.

DFB instance 
data

The DFB instance data is internal data from the derived function block used in the 
program.

DINT DINT stands for the data type "double length whole number (double integer)". 
Entries are made as integer literal, base 2 literal, basis 8 literal or base 16 literal. The 
length of the data element is 32 bits. The value range for variables of this datatype 
reaches from -2 exp (31) to 2 exp (31) -1.

Direct 
Representation

A method of displaying variables in the PLC program, from which the assignment to 
the logical memory can be directly - and indirectly to the physical memory - derived.

Document 
Window

A window within an application window. Several document windows can be open at 
the same time in an application window. However, only one document window can 
ever be active. Document windows in Concept are, for example, sections, the 
message window, the reference data editor and the PLC configuration.

DP (PROFIBUS) DP = Remote Peripheral

Dummy An empty file, which consists of a text heading with general file information, such as 
author, date of creation, EFB designation etc. The user must complete this dummy 
file with further entries.

DX Zoom This property enables the user to connect to a programming object, to monitor and, 
if necessary change, its data value.

EFB code The EFB code is the section’s EFB code, which can be executed. In addition the 
used EFBs count in DFBs.

Elementary 
functions/
function blocks 
(EFB)

Identifier for Functions or Function blocks, whose type definitions are not formulated 
in one of the IEC languages, i.e. whose body for example can not be modified with 
the DFB editor (Concept-DFB). EFB types are programmed in "C" and are prepared 
in a pre-compiled form using libraries.

E
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EN / ENO (Enable 
/ Error signal)

If the value of EN is equal to "0" when the FFB is invoked, the algorithms that are 
defined by the FFB will not be executed and all outputs keep their previous values. 
The value of ENO is in this case automatically set to "0". If the value of EN is equal 
to "1", when the FFB is invoked, the algorithms which are defined by the FFD will be 
executed. After the error-free execution of these algorithms, the value of ENO is 
automatically set to "1". If an error occurs during the execution of these algorithms, 
ENO is automatically set to "0". The output behavior of the FFB is independent of 
whether the FFBs are invoked without EN/ENO or with EN=1. If the EN/ENO display 
is switched on, it is imperative that the EN input is switched on. Otherwise, the FFB 
is not executed. The configuration of EN and ENO is switched on or off in the Block 
Properties dialog box. The dialog box can be invoked with the Objects → 
Properties... menu command or by double-clicking on the FFB.

Error If an error is recognized during the processing of a FFB or a step (e.g. unauthorized 
input values or a time error), an error message appears, which can be seen using 
the Online → Event Viewer... menu command. For FFBs, the ENO output is now 
set to "0".

Evaluation The process, through which a value is transmitted for a Function or for the output of 
a Function block during Program execution.

FFB (Functions/
Function blocks)

Collective term for EFB (elementary functions/function blocks) and DFB (Derived 
function blocks)

Field variables A variable, which is allocated a defined derived data type with the key word ARRAY 
(field). A field is a collection of data elements with the same data type.

FIR Filter (Finite Impulse Response Filter) a filter with finite impulse answer

Formal 
parameters

Input / Output parameters, which are used within the logic of a FFB and led out of 
the FFB as inputs/outputs.

Function (FUNC) A program organization unit, which supplies an exact data element when 
processing. a function has no internal status information. Multiple invocations of the 
same function using the same input parameters always supply the same output 
values. Details of the graphic form of the function invocation can be found in the 
"Functional block (instance)". In contrast to the invocation of the function blocks, 
function invocations only have a single unnamed output, whose name is the same 
as the function. In FBD each invocation is denoted by a unique number via the 
graphic block, this number is automatically generated and can not be altered.

F
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Function block 
(Instance) (FB)

A function block is a program organization unit, which correspondingly calculates the 
functionality values that were defined in the function block type description, for the 
outputs and internal variable(s), if it is invoked as a certain instance. All internal 
variable and output values for a certain function block instance remain from one 
function block invocation to the next. Multiple invocations of the same function block 
instance with the same arguments (input parameter values) do not therefore 
necessarily supply the same output value(s).
Each function block instance is displayed graphically using a rectangular block 
symbol. The name of the function block type is stated in the top center of the 
rectangle. The name of the function block instance is also stated at the top, but 
outside of the rectangle. It is automatically generated when creating an instance, 
but, depending on the user’s requirements, it can be altered by the user. Inputs are 
displayed on the left side of the block and outputs are displayed on the right side. 
The names of the formal input/output parameters are shown inside the rectangle in 
the corresponding places.
The above description of the graphic display is especially applicable to the function 
invocation and to DFB invocations. Differences are outlined in the corresponding 
definitions.

Function Block 
Dialog (FBD)

One or more sections, which contain graphically displayed networks from Functions, 
Function blocks and Connections.

Function block 
type

A language element, consisting of: 1. the definition of a data structure, divided into 
input, output and internal variables; 2. a set of operations, which are performed with 
elements of the data structure, when a function block type instance is invoked. This 
set of operations can either be formulated in one of the IEC languages (DFB type) 
or in "C" (EFB type). A function block type can be instanced (invoked) several times.

Function 
Number

The function number is used to uniquely denote a function in a program or DFB. The 
function number can not be edited and is automatically assigned. The function 
number is always formed as follows: .n.m

n = section number (current number)
m = Number of the FFB object in the section (current number)
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Generic Data 
Type

A data type, which stands in place of several other data types.

Generic literals If the literal’s data type is not relevant, simply specify the value for the literal. If this 
is the case, Concept automatically assigns the literal a suitable data type.

Global Data Global data are Unlocated variables.

Global derived 
data types

Global derived data types are available in each Concept project and are occupied in 
the DFB directory directly under the Concept directory.

Global DFBs Global DFBs are available in each Concept project. The storage of the global DFBs 
is dependant upon the settings in the CONCEPT.INI file.

Global macros Global macros are available in each Concept project and are occupied in the DFB 
directory directly under the Concept directory.

Groups (EFBs) Some EFB libraries (e.g. the IEC library) are divided into groups. This facilitates EFB 
location especially in expansive libraries.

Host Computer Hardware and software, which support programming, configuring, testing, operating 
and error searching in the PLC application as well as in a remote system application, 
in order to enable source documentation and archiving. The programming device 
can also be possibly used for the display of the process.

G
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I/O Map The I/O and expert modules from the various CPUs are configured in the I/O map.

Icon Graphical representation of different objects in Windows, e.g. drives, application 
programs and document windows.

IEC 61131-3 International standard: Programmable Logic Controls - Part 3: Programming 
languages.

IEC Format 
(QW1)

There is an IEC type designation in initial position of the address, followed by the 
five-figure address.
l %0x12345 = %Q12345
l %1x12345 = %I12345
l %3x12345 = %IW12345
l %4x12345 = %QW12345

IEC name 
conventions 
(identifier)

An identifier is a sequence of letters, numbers and underscores, which must begin 
with either a letter or underscore (i.e. the name of a function block type, an instance, 
a variable or a section). Letters of a national typeface (i.e.: ö,ü, é, õ) can be used, 
except in project and DFB names.
Underscores are significant in identifiers; e.g. "A_BCD" and "AB_CD" are 
interpreted as two separate identifiers. Several leading and multiple successive 
underscores are not allowed.
Identifiers should not contain any spaces. No differentiation is made between upper 
and lower case, e.g. "ABCD" and "abcd" are interpreted as the same identifier.
Identifiers should not be Keywords.

IEC Program 
Memory

The IEC memory consists of the program code, EFB code, the section data and the 
DFB instance data.

IIR Filter (Infinite Impulse Response Filter) a filter with infinite impulse answer

Initial step The first step in a sequence. A step must be defined as an initial step for each 
sequence. The sequence is started with the initial step when first invoked.

Initial value The value, which is allocated to a variable when the program is started. The values 
are assigned in the form of literals.

I
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Input bits 
(1x references)

The 1/0 status of the input bits is controlled via the process data, which reaches from 
an input device to the CPU.

Input parameter 
(Input)

Upon invocation of a FFB, this transfers the corresponding argument.

Input words (3x 
references)

An input word contains information, which originates from an external source and is 
represented by a 16 bit number. A 3x register can also contain 16 sequential input 
bits, which were read into the register in binary or BCD (binary coded decimal) 
format. Note: The x, which follows the initial reference type number, represents a 
five-figure storage location in the user data memory, i.e. the reference 300201 
signifies an input word at the address 201 in the State RAM.

Input/output 
marker bits (0x 
references)

An input/output marker bit can be used to control real output data using an output 
unit of the control system, or to define one or more discrete outputs in the state RAM. 
Note: The x, which follows the initial reference type number, represents a five-figure 
storage location in the user data memory, i.e. the reference 000201 signifies an 
output or marker bit at the address 201 in the State RAM.

Instance Name An identifier, which belongs to a certain function block instance. The instance name 
is used to clearly denote a function block within a program organization unit. The 
instance name is automatically generated, but it can be edited. The instance name 
must be unique throughout the whole program organization unit, and is not case 
sensitive. If the name entered already exists, you will be warned and you will have 
to choose another name. The instance name must comply with the IEC name 
conventions otherwise an error message appears. The automatically generated 
instance name is always formed as follows: FBI_n_m

FBI = Function Block Instance
n = section number (current number)
m = Number of the FFB object in the section (current number)

Instancing Generating an Instance.

Note: The x, which follows the initial reference type number, represents a five-
figure storage location in the user data memory, i.e. the reference 100201 signifies 
an output or marker bit at the address 201 in the State RAM.
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Instruction (IL) Instructions are the "commands" of the IL programming language. Each instruction 
begins on a new line and is performed by an operator with a modifier if necessary, 
and if required for the current operation, by one or more operands. If several 
operands are used, they are separated by commas. A character can come before 
the instruction, which is then followed by a colon. The commentary must, where 
available, be the last element of the line.

Instruction 
(LL984)

When programming electrical controls, the user should implement operation-coded 
instructions in the form of picture objects, which are divided into a recognizable 
contact form. The designed program objects are, on a user level, converted to 
computer usable OP codes during the download process. The OP codes are 
decoded in the CPU and processed by the firmware functions of the controller in a 
way that the required control is implemented.

Instruction (ST) Instructions are the "commands" of the ST programming language. Instructions 
must be concluded by semicolons. Several instructions can be entered in one line 
(separated by semicolons).

Instruction list 
(IL)

IL is a text language according to IEC 1131, which is shown in operations, i.e. 
conditional or unconditional invocations of Functions blocks and Functions, 
conditional or unconditional jumps etc. through instructions.

INT INT stands for the data type "whole number (integer)". Entries are made as integer 
literal, base 2 literal, basis 8 literal or base 16 literal. The length of the data element 
is 16 bits. The value range for variables of this datatype reaches from -2 exp (15) to 
2 exp (15) -1.

Integer literals Integer literals are used to input whole number values into the decimalsystem. The 
values can have a preceding sign (+/-). Single underscores ( _ ) between numbers 
are not significant.

Example
-12, 0, 123_456, +986

INTERBUS (PCP) The new INTERBUS (PCP) I/O drop type is entered into the Concept configurator, 
to allow use of the INTERBUS PCP channel and the INTERBUS process data pre-
processing (PDV). This I/O drop type is assigned the INTERBUS switching module 
180-CRP-660-01.
The 180-CRP-660-01 differs from the 180-CRP-660-00 only in the fact that it has a 
clearly larger I/O range in the control state RAM.

Invocation The process, through which an operation is carried out.
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Jump Element of the SFC language. Jumps are used to skip zones in the sequence.

Keywords Keywords are unique combinations of characters, which are used as special 
syntactical components, as defined in Appendix B of the IEC 1131-3. All keywords 
which are used in the IEC 1131-3 and therefore in Concept, are listed in Appendix 
C of the IEC 1131-3. These keywords may not be used for any other purpose, i.e. 
not as variable names, section names, instance names etc.

Ladder Diagram 
(LD)

Ladder Diagram is a graphic programming dialog according to IEC1131, which is 
optically oriented to the "rung" of a relay contact plan.

Ladder Logic 984 
(LL)

The terms Ladder Logic and Ladder Diagram refer to the word Ladder being 
executed. In contrast to a circuit diagram, a ladder diagram is used by electrotech-
nicians to display an electrical circuit (using electrical symbols), which should show 
the course of events and not the existing wires, which connect the parts with each 
other. A usual user interface for controlling the actions of automation devices 
permits a Ladder Diagram interface, so that electrotechnicians do not have to learn 
new programming languages to be able to implement a control program.
The structure of the actual Ladder Diagram enables the connection of electric 
elements in such a way that generates a control output, which is dependant upon a 
logical power flow through used electrical objects, which displays the previously 
requested condition of a physical electrical device.
In simple form, the user interface is a video display processed by the PLC 
programming application, which sets up vertical and horizontal grid, in which 
programming objects are classified. The diagram contains the power grid on the left 
side, and when connected to activated objects, the power shifts from left to right.

Landscape Landscape means that when looking at the printed text, the page is wider than it is 
high.

J

K
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Language 
Element

Every basic element in one of the IEC programming languages, e.g. a step in SFC, 
a function block instance in FBD or the initial value of a variable.

Library Collection of software objects, which are intended for re-use when programming 
new projects, or even building new libraries. Examples are the libraries of the 
Elementary function block types.
EFB libraries can be divided up into Groups.

Link A control or data flow connection between graphical objects (e.g. steps in the SFC 
Editor, function blocks in the FBD Editor) within a section, represented graphically 
as a line.

Literals Literals are used to provide FFB inputs, and transition conditions etc using direct 
values. These values can not be overwritten by the program logic (read only). A 
distinction is made between generic and standardized literals.
Literals are also used to allocate a constant, a value or a variable an initial value. 
Entries are made as base 2 literal, base 8 literal, basis 16 literal, integer literal, real 
literal or real literal with exponent.

Local derived 
data types

Local derived data types are only available in a single Concept project and the local 
DFBs and are placed in the DFB directory under the project directory.

Local DFBs Local DFBs are only available in a single Concept project and are placed in the DFB 
directory under the project directory.

Local Link The local network is the network, which connects the local nodes with other nodes 
either directly or through bus repeaters.

Local macros Local macros are only available in a single Concept project and are placed in the 
DFB directory under the project directory.

Local network 
nodes

The local node is the one, which is currently being configured.

Located variable A state RAM address (reference addresses 0x, 1x, 3x,4x) is allocated to located 
variables. The value of these variables is saved in the state RAM and can be 
modified online using the reference data editor. These variables can be addresses 
using their symbolic names or their reference addresses.

All inputs and outputs of the PLC are connected to the state RAM. The program can 
only access peripheral signals attached to the PLC via located variables. External 
access via Modbus or Modbus Plus interfaces of the PLC, e.g. from visualization 
systems, is also possible via located variables.
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Macro Macros are created with the help of the Concept DFB software.
Macros are used to duplicate frequently used sections and networks (including their 
logic, variables and variable declaration).
A distinction is made between local and global macros.

Macros have the following properties:
l Macros can only be created in the FBD and LD programming languages.
l Macros only contain one section.
l Macros can contain a section of any complexity.
l In programming terms, there is no difference between an instanced macro, i.e. a 

macro inserted into a section and a conventionally created section.
l DFB invocation in a macro
l Declaring variables
l Using macro-specific data structures
l Automatic transfer of the variables declared in the macro.
l Initial value for variables
l Multiple instancing of a macro in the entire program with differing variables
l The name of the section, variable names and data structure names can contain 

up to 10 different exchange marks (@0 to @9).

MMI Man-Machine-Interface

Multi element 
variables

Variables to which a Derived data type defined with STRUCT or ARRAY is allocated.
A distinction is made here between field variables and structured variables.

Network A network is the collective switching of devices to a common data path, which then 
communicate with each other using a common protocol.

Network node A node is a device with an address (1...64) on the Modbus Plus network.

Node Node is a programming cell in a LL984 network. A cell/node consists of a 7x11 
matrix, i.e. 7 rows of 11 elements.

M
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Operand An operand is a literal, a variable, a function invocation or an expression.

Operator An operator is a symbol for an arithmetic or boolean operation, which is to be carried 
out.

Output 
parameter 
(outputs):

A parameter, through which the result(s) of the evaluation of a FFB is/are returned.

Output/marker 
words (4x 
references)

An output / marker word can be used to save numerical data (binary or decimal) in 
the state RAM, or to send data from the CPU to an output unit in the control system. 
Note: The x, which follows the initial reference type number, represents a five-figure 
storage location in the user data memory, i.e. the reference 400201 signifies a 16 bit 
output or marker word at the address 201 in the State RAM.

Peer Cop The Peer Cop processes the token execution and the data flow between the Modbus 
Plus network and the PLC user logic.

PLC Memory programmable controller

Portrait Portrait means that the sides are larger than the width when printed.

Print-out Expressions consist of operators and operands.

Program The uppermost program organization unit. A program is closed on a single PLC 
download.

Program 
organization unit

A function, a function block, or a Program. This term can refer to either a type or an 
instance.

Program 
redundancy 
system (Hot 
Standby)

A redundancy system consists of two identically configured PLC machines, which 
communicate with one another via redundancy processors. In the case of a 
breakdown of the primary PLC, the secondary PLC takes over the control check. 
Under normal conditions, the secondary PLC does not take over the control function, 
but checks the status information, in order to detect errors.

O
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Project General description for the highest level of a software tree structure, which specifies 
the super-ordinate project name of a PLC application. After specifying the project 
name you can save your system configuration and your control program under this 
name. All data that is created whilst setting up the configuration and program, 
belongs to this super-ordinate project for this specific automation task.
General description for the complete set of programming and configuration 
information in the project database, which represents the source code that 
describes the automation of a system.

Project database The database in the host computer, which contains the configuration information for 
a project.

Prototype file 
(Concept-EFB)

The prototype file contains all the prototypes of the assigned functions. In addition, 
if one exists, a type definition of the internal status structure is specified.

REAL REAL stands for the data type "floating point number". The entry can be real-literal 
or real-literal with an exponent. The length of the data element is 32 bits. The value 
range for variables of this data type extends from 8.43E-37 to 3.36E+38.

Real literals Real literals are used to input floating point values into the decimal system. Real 
literals are denoted by a decimal point. The values can have a preceding sign (+/-). 
Single underscores ( _ ) between numbers are not significant.

Example
-12.0, 0.0, +0.456, 3.14159_26

Real literals with 
exponents

Real literals with exponents are used to input floating point values into the decimal 
system. Real literals with exponents are identifiable by a decimal point. The 
exponent indicates the power of ten, with which the existing number needs to be 
multiplied in order to obtain the value to be represented. The base can have a 
preceding negative sign (-). The exponent can have a preceding positive or negative 
sign (+/-). Single underscores ( _ ) between numbers are not significant. (Only 
between numbers, not before or after the decimal point and not before or after "E", 
"E+" or "E-")

R

Note: Dependent on the mathematical processor type of the CPU, different ranges 
within this permissable value range cannot be represented. This applies to values 
that are approaching ZERO and for values that approach INFINITY. In these cases 
NAN (Not A Number) or INF (INFinite will be displayed in the animation mode 
instead of a number value.
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Example
-1.34E-12 or -1.34e-12 
1.0E+6 or 1.0e+6 
1.234E6 or 1.234e6

Reference Every direct address is a reference that begins with an indicator, which specifies 
whether it is an input or an output and whether it is a bit or a word. References that 
begin with the code 6, represent registers in the extended memory of the state RAM. 
0x range = Coils 
1x range = Discrete inputs 
3x range = Input registers 
4x range = Output registers 
6x range = Register in the extended memory

Register in the 
extended 
memory 
(6x-reference)

6x references are holding registers in the extended memory of the PLC. They can 
only be used with LL984 user programs and only with a CPU 213 04 or CPU 424 02.

Remote Network 
(DIO)

Remote programming in the Modbus Plus network enables maximum performance 
when transferring data and dispenses of the need for connections. Programming a 
remote network is simple. Setting up a network does not require any additional 
ladder logic to be created. All requirements for data transfer are fulfilled via 
corresponding entries in the Peer Cop Processor.

RIO (Remote I/O) Remote I/O indicates a physical location of the I/O point controlling devices with 
regard to the CPU controlling them. Remote inp./outputs are connected to the 
controlling device via a twisted communication cable.

RTU-Mode Remote Terminal Unit 
The RTU mode is used for communication between the PLC and an IBM compatible 
personal computer. RTU works with 8 data bits.

Runtime error Errors, which appear during program processing on the PLC, in SFC objects (e.g. 
Steps) or FFBs. These are, for example, value range overflows with figures or timing 
errors with steps.

Note: The x, which follows each initial reference type number, represents a five-
figure storage location in the user data memory, i.e. the reference 400201 signifies 
a 16 bit output or marker word at the address 201 in the State RAM.



Glossary

840 USE 493 00 September 2001 979

SA85 module The SA85 module is a Modbus Plus adapter for IBM-AT or compatible computers.

Scan A scan consists of reading the inputs, processing the program logic and outputting 
the outputs.

Section A section can for example be used to describe the mode of functioning of a 
technological unit such as a motor.
A program or DFB consists of one or more sections. Sections can be programmed 
with the IEC programming languages FBD and SFC. Only one of the named 
programming languages may be used within a section at any one time.
Each section has its own document window in Concept. For reasons of clarity, it is 
however useful to divide a very large section into several small ones. The scroll bar 
is used for scrolling within a section.

Section Code Section Code is the executable code of a section. The size of the Section Code is 
mainly dependent upon the number of blocks in the section.

Section Data Section data is the local data in a section such as e.g. literals, connections between 
blocks, non-connected block inputs and outputs, internal status memory of EFBs.

Separator 
Format (4:00001)

The first digit (the reference) is separated from the five figure address that follows 
by a colon (:).

Sequence 
language (SFC)

The SFC Language Elements enable a PLC program organization unit to be divided 
up into a number of Steps and Transitions, which are connected using directional 
Links. A number of actions belong to each step, and transition conditions are 
attached to each transition.

Serial 
Connections

With serial connections (COM) the information is transferred bit by bit.

Source code file 
(Concept-EFB)

The source code file is a normal C++ source file. After executing the Library → 
Create  files menu command, this file contains an EFB-code frame, in which you 
have to enter a specific code for the EFB selected. To do this invoke the Objects → 
Source menu command.

Standard Format 
(400001)

The five figure address comes directly after the first digit (the reference).

S

Note: Data which appears in the DFBs of this section is not section data.
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Standardized 
literals

If you would like to manually determine a literal’s data type, this may be done using 
the following construction: ’Data type name’#’value of the literal’.

Example
INT#15 (Data type: integer, value: 15), 
BYTE#00001111 (Data type: byte, value: 00001111) 
REAL#23.0 (Data type: real, value: 23.0)

To assign the data type REAL, the value may also be specified in the following 
manner: 23.0. 
Entering a comma will automatically assign the data type REAL.

State RAM The state RAM is the memory space for all variables, which are accessed via 
References (Direct representation) in the user program. For example, discrete 
inputs, coils, input registers, and output registers are situated in the state RAM.

Status Bits For every device with global inputs or specific inp./outputs of Peer Cop data, there 
is a status bit. If a defined group of data has been successfully transferred within the 
timeout that has been set, the corresponding status bit is set to 1. If this is not the 
case, this bit is set to 0 and all the data belonging to this group is deleted (to 0).

Step SFC-language element: Situation, in which the behavior of a program occurs, 
regarding its inputs and outputs of those operations which are defined by the actions 
belonging to the step.

Step name The step name is used to uniquely denote a step in a program organization unit. The 
step name is generated automatically, but it can be edited. The step name must be 
unique within the entire program organization unit, otherwise an error message will 
appear. 
The automatically generated step name is always formed as follows: S_n_m

S = step 
n = section number (current number)
m = Number of the step in the section (current number)

Structured text 
(ST)

ST is a text language according to IEC 1131, in which operations, e.g. invocations 
of Function blocks and Functions, conditional execution of instructions, repetitions 
of instructions etc. are represented by instructions.

Structured 
variables

Variables to which a Derived data type defined with STRUCT (structure) is allocated.
A structure is a collection of data elements with generally different data types 
(elementary data types and/or derived data types).
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SY/MAX In Quantum control devices, Concept includes the providing of I/O-map SY/MAX-I/
O modules for remote contolling by the Quantum PLC. The SY/MAX remote 
backplane has a remote I/O adapter in slot 1, which communicates via a Modicon 
S908 R I/O System. The SY/MAX-I/O modules are executed for you for labelling and 
inclusion in the I/O map of the Concept configuration.

Template file 
(Concept-EFB)

The template file is an ASCII file with layout information for the Concept FBD Editor, 
and the parameters for code creation.

TIME TIME stands for the data type "time". The entry is time literal. The length of the data 
element is 32 bits. The value range for variables of this data type extends from 0 to 
2exp(32)-1. The unit for the TIME data type is 1 ms.

Time literals Permissable units for times (TIME) are days (D), hours (H), minutes (M), seconds 
(S) and milliseconds (MS) or combinations of these. The time must be marked with 
the prefix t#, T#, time# or TIME#. The "overflow" of the unit with the highest value is 
permissible, e.g. the entry T#25H15M is allowed.

Example
t#14MS, T#14.7S, time#18M, TIME#19.9H, t#20.4D, T#25H15M, 
time#5D14H12M18S3.5MS

Token The network "token" controls the temporary possession of the transfer right via a 
single device. The token passes round the devices in a rotating (increasing) address 
sequence. All devices follow the token rotation and can receive all the possible data 
that is sent with it.

Total IEC 
memory

The total IEC memory consists of the IEC program memory and the global data.

Traffic Cop The traffic cop is an IO map, which is generated from the user-IO map. The traffic 
cop is managed in the PLC and in addition to the user IO map, contains e.g. status 
information on the I/O stations and modules.

Transition The condition, in which the control of one or more predecessor steps passes to one 
or more successor steps along a directed link.

T
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UDEFB User-defined elementary functions/function blocks
Functions or function blocks, which were created in the C programming language, 
and which Concept provides in libraries.

UDINT UDINT stands for the data type "unsigned double integer". Entries are made as 
integer literal, base 2 literal, basis 8 literal or base 16 literal. The length of the data 
element is 32 bits. The value range for variables of this data type extends from 0 to 
2exp(32)-1.

UINT UINT stands for the data type "unsigned integer". Entries are made as integer literal, 
base 2 literal, basis 8 literal or base 16 literal. The length of the data element is 16 
bits. The value range for variables of this data type extends from 0 to (2exp 16)-1.

Unlocated 
variable

Unlocated variables are not allocated a state RAM address. They therefore do not 
occupy any state RAM addresses. The value of these variables is saved in the 
internal system and can be changed using the reference data editor. These 
variables are only addressed using their symbolic names.

Signals requiring no peripheral access, e.g. intermediate results, system tags etc., 
should be primarily declared as unlocated variables.

Variables Variables are used to exchange data within a section, between several sections and 
between the program and the PLC.
Variables consist of at least one variable name and one data type.
If a variable is assigned a direct address (reference), it is called a located variable. 
If the variable has no direct address assigned to it, it is called an unlocated variable. 
If the variable is assigned with a derived data type, it is called a multi element 
variable.
There are also constants and literals.

U
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Warning If a critical status is detected during the processing of a FFB or a step (e.g. critical 
input values or an exceeded time limit), a warning appears, which can be seen using 
the Online → Event Viewer... menu command. For FFBs, the ENO remains set to 
"1".

WORD WORD stands for the data type "bit sequence 16". Entries are made as base 2 
literal, base 8 literal or base 16 literal. The length of the data element is 16 bits. A 
numerical value range can not be assigned to this data type.

W
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Symbols
=> Assignment, 306, 354
•General information about online functions, 
517
’SFCSTEP_STATE’ variable, 223
’SFCSTEP_TIMES’ variable, 222
’Step’-variable, 223

A
Access Rights, 627, 634, 635
Action, 223
Action variable, 224
Actions

Process, 241
Activate dialogs, 86
Actual parameters

FBD, 173
LD, 201

Alias designations
step, 248
transition, 248

Alternative branch, 230
Alternative connection, 232
Animation, 495, 615, 617

General information, 555
IEC section, 556
IL, 315, 318
LL984 section, 557
Section, 555
FBD, 181
LD, 210

SFC, 252, 255
ANY Outputs, 351
Archive

DFB, 610
EFB, 610
project, 610

ASCII message editor, 499, 501, 506
Combination mode, 514
Control code, 505
Direct mode, 514
Flush (buffer), 507
Generals, 502
How to continue after getting a warning, 
513
How to Use, 510
Message Number, 511
Message text, 512
Offline mode, 514
Repeat, 508
Simulation text, 512
Spaces, 505
Text, 503
User interface, 509, 510
Variables, 504

ASCII messages, 52, 85
Assign instructions

ST, 336
Atrium - INTERBUS controller, 806, 810
Atrium configuration example

INTERBUS controller, 804

Index
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Atrium first startup
DOS Loader, 940
EXECLoader, 922
Modbus Plus, 922, 940

Available functions in OFFLINE and ONLINE 
modes, 69

B
Backplane Expander

Edit I/O Map, 92
Error handling, 93
Generals, 92

Backplane Expander Config
Configure, 91

Block call up
IL, 301
ST, 350

C
Call

FFB, 308
DFB, 300
FFB, 300

Chain jump, 229
Chain loop, 229
Change

coil, LD, 206
contact, LD, 206
FFB, FBD, 177
FFB, LD, 206

Change, set PLC password, 539
Changing signal states of a Located variable

Reference data editor, 491
Close Column

LL984, 372
Closer

LD, 192
Code generation

IL, 312
ST, 358

Code generation
FBD, 180
LD, 209

Coil
change, LD, 206
replace, LD, 206

Coil - negated
LD, 194

Coil – negative edge
LD, 195

Coil – positive edge
LD, 194

Coil - reset
LD, 195

Coil - set
LD, 195

Coils
LD, 193

Cold start, 35
Color definition

INI file, 960
Comments

Data type editor, 481
Derived data type, 481

Communication, 14
Compact configuration

RTU extension, 99
Compact configuration example

Compact controller, 799
Compact first startup

DOS Loader, 903, 937
EXECLoader, 884, 918
Modbus, 884, 903
Modbus Plus, 918, 937

Concept DFB, 389, 425
Concept ModConnect, 841

Integrating new Modules, 845
Removing modules, 846
Use of Third Party Modules in Concept, 
847

Concept PLCSIM32, 617
Concept Security, 625, 626, 627, 634, 635
Concept SIM, 615
CONCEPT.INI, 953

general, 954
LD section settings, 959
path for global DFBs, 957
path for help files, 957
print settings, 955
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project name definition, 956
reading global DFBs, 957
register address format settings, 956
representation of internal data, 959
settings for online animation, 960
storage of global DFBs during upload, 
957
variable storage settings, 956

Configuration, 63
General information, 65
Optional, 84
Unconditional, 71

Configuration example - Quantum
remote control with RIO, 735

Configuration example Atrium
INTERBUS controller, 804

Configuration example Compact
Compact controller, 799

Configuration example Momentum
remote I/O bus, 813

Configuration example Quantum
INTERBUS control, 763
Profibus DP controller, 777
Remote control with DIO, 754
Remote control with RIO (series 800), 
743
SY/MAX controller, 769
Peer Cop, 791

Configuration examples, 733
Configuration extensions, 86
Configuration in OFFLINE and ONLINE 
mode, 68

General information, 69
Configuration of Peer Cop, 793
Configuration of various network systems, 
94
Configurator

Ethernet I/O Scanner, 100
Configure

Backplane Expander Config, 91
INTERBUS, 95
RTU extension, 99
SoftPLC, 97
Ethernet, 98
Profibus DP, 96

Configure Ethernet, 822, 98

Configure INTERBUS system, 95
Configure network systems, 86, 94
Configure Profibus DP system, 96
Configure SoftPLC, 97
Connect PLC

general information, 519
Connecting IEC Simulator (32-bit), 530
Constant scan, 533
Constants, 34
Contact

change, LD, 206
replace, LD, 206
LD, 192, 193

Context help, 673
Controller status, 519
Convert

DFBs, 837
Macros, 837
Projects, 837

Converting RDE templates, 489
Convertion

Modsoft programs, 849
CPU selection for the PLC type, 73
Create

DFB, 405
Macro, 435
Program, 43
Project, 43
FFB, FBD, 176
FFB, LD, 205

Creating a program
IL, 319

Cyclical setting of variables
Reference data editor, 492

D
Data exchange between nodes on the 
Modbus Plus network, 87
Data flow, 207

FBD, 178
Data Protection, 51
Data protection in the state RAM, 88
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Data type editor, 465, 467, 468
Comments, 481
Elements, 474
Short Cut Keys, 693
Syntax, 473
key words, 475
separators, 480
use of memory, 482
Names, 479

Declaration of variables, 448
Declare

Actions, 241
Step properties, 239
transition, 246

Defining the LD contact connection
settings in the INI file, 959

Defining the number of LD columns/fields
settings in the INI file, 959

Delete
DFB, 611
Macro, 611
Project, 611

Deleting memory zones from the PLC, 535
Deleting PLC contents, 535
Derived data type, 465, 467, 468

Elements, 474
Export, 567
Syntax, 473
Comments, 481
Names, 479
global, 471
key words, 475
local, 471
separators, 480
use of memory, 482
Use, 484

Derived Function Block, 392
LD, 198
FBD, 171

DFB, 389, 392
archive, 610
call, 300
context sensitive help, 403
Create, 405
Delete, 611
Documentation, 601

FBD, 171
global, 394
invocation, 302, 351
LD, 198
local, 394
Protect, 635
Convert, 837

Diagnosis
Transition diagnosis, 260

Diagnostics viewer, 558
Dialog boxes, 668
Dialog interaction

LL984, 369
Direct addresses, 34
Document section options, 605
Documentation

Contents, 602
DFB, 601
Keywords, 608
Macro, 601
Project, 601
layout, 603

DOS Loader
Atrium first startup, 940
Compact first startup, 903, 937
Momentum first startup, 906, 909, 943, 
946
Quantum first startup, 900, 934
Startup when using Modbus, 899
Startup when using Modbus Plus, 933

Download changes, 549
Driver for 16 bit application capability with 
Windows 98/2000/NT

Virtual MBX Driver, 866
Driver for connection between ModConnect 
Host interface adapters and 32 bit 
applications with Windows 98/2000/NT

MBX-Treiber, 867
Driver for Modbus Plus Function via TCP/IP

Ethernet MBX Driver, 869
Driver for Remote Operation

Remote MBX Driver, 868
DTY, 465, 467, 468
DX Zoom

LL984, 374
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E
Edit

Actions, 241
LL984, 368, 371
SFC, 236
Step properties, 239
SFC, 235
transition, 246

Edit I/O Map
Backplane Expander, 92

Editing local drop, 736, 744, 755, 765, 770, 
806, 814, 833
Editing Networks

LL984, 373
Editing remote 800 drop, 751
Editing remote drop, 740, 748, 759, 774, 810
Editing remote drops, 818
Editors, 9
EFB

archive, 610
FBD, 169
LD, 196

Elementary Function
FBD, 169
LD, 196

Elementary Function Block
FBD, 170
LD, 197

Elements
Data type editor, 474
Derived Data Type, 474

EN
FBD, 172
LD, 200

ENO
FBD, 172
LD, 200

EQUAL, 519
Equation network

LL984, 378, 379
Equation network, Syntax and Semantics

LL984, 383
Error handling

Backplane Expander, 93

Establishing the hardware connection
Modbus Plus presettings, 871
Modbus presettings, 876

Ethernet, 530
Ethernet I/O Scanner

Configurator, 100
How to use the Ethernet / I/O Scanner, 
104

Ethernet bus system
Momentum configuration example, 821

Ethernet bus system (Momentum), 822
Ethernet MBX Driver

Driver for Modbus Plus Function via TCP/
IP, 869

Ethernet with Atrium, 99
ethernet with Momentum, 99
Ethernet with Quantum, 98
Example 

Profibus DP controller, 778
INTERBUS Controller with Atrium, 805

Example of hardware configuration
Remote control with RIO (Series 800), 
743
Compact controller, 799
Ethernet bus system, 821
INTERBUS control, 763
INTERBUS controller, 804
Profibus DP controller, 777
remote control with DIO, 754
remote control with RIO, 735
remote I/O bus, 813
SY/MAX controller, 769

Example to Peer Cop, 791
Examples of hardware configuration, 733
Exchange Marking

Macro, 430
EXEC file

CPU 424 02, 117
CPU X13 0X, 117
Momentum, 152

EXEC files, 949
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EXECLoader
Atrium first startup, 922
Compact first startup, 884, 918
Momentum first startup, 888, 893, 925, 
929
Quantum first startup, 880, 914
Startup when using Modbus, 879
Startup when using Modbus Plus, 913

Execution order
FBD, 177

Execution sequence
LD, 207
Section, 38

Export, 561
Derived Data Type, 567
PLC Configuration, 597
Section, 564
Variable, 567
general information, 563
PLC configuration, 596

Exporting located variables, 457
Expressions

ST, 324
Extended memory, 121

F
Factory Link, 594
FBD, 165

Actual parameters, 173
animation, 181
Calling a macro, 444
code generation, 180
data flow, 177, 178
Derived Function Blocks, 171
DFB, 171
EFB, 169
Elementary Function, 169
Elementary Function Block, 170
EN, 172
ENO, 172
execution order, 177
FFB, 169
Function, 169
Function Block, 170

Icon bar, 683
link, 172
loop, 178
online functions, 181
program creation, 184
Short Cut Keys, 695
Text Object, 174
UDEFB, 172
User-defined Elementary Function, 172
User-defined Elementary Function Block, 
172

FFB
Call, 308
call, 300
change, FBD, 177
change, LD, 206
create, FBD, 176
create, LD, 205
FBD, 169
insert, FBD, 176
insert, LD, 205
invocation, 302, 351, 354
LD, 196
position, 176, 205
replace, FBD, 177
replace, LD, 206

Function
FBD, 169
LD, 196

Function Block
FBD, 170
LD, 197

Function Block language, 165

G
General, 1
General information, 814

Loading a project, 547
Online functions, 517
Select process information, 543
connect PLC, 519
INTERBUS Controller, 764
INTERBUS Controller with Atrium, 805
Profibus DP Controller, 778
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General information about configuration in 
OFFLINE and ONLINE mode, 69
General information about hardware 
configuration, 65
General information about the online control 
panel, 533
General information about the PLC 
configuration, 66
General information about the reference 
data editor, 488
General to the variables editor, 448
Generals

Backplane Expander, 92
Generals to Peer Cop, 792
Generate

Project symbol, 671
Global data transfer, 795
Global derived data type, 471
Global DFB, 394
Global DFBs

defining the path, 957
INI file, 957
reading, 958
storing, 958

Global macro, 429

H
Hardware

performance, 639
Head setup, 49
Help, 673
Help files

defining the path, 957
How to use the Ethernet / I/O Scanner

Ethernet / I/O Scanner, 104

I
I/O map, 48, 81
Icon bar, 681, 682, 683, 684, 686
Icons, 679, 681, 682, 683, 684, 686, 687, 
688, 689, 690
Identifier, 244
IEC

Momentum first startup, 888, 925, 943

IEC conformity, 707
IEC Hot Standby data, 77
IEC section

Animation, 556
IL, 261

Animation, 315, 318
Block call up, 301
Code generation, 312
Creating a program, 319
Instruction, 264, 265
List of Symbols, 687
Modifier, 267
Online functionen, 318
Online functions, 314, 315
Operands, 266
Operators, 269, 276
Short Cut Keys, 693
syntax check, 311
Tag, 272

IL command
Comments, 275
Compare, 293, 294, 296
Declaration, 273
call function block, 302
Compare, 291, 292, 295
DFB invocation, 302
Function call, 308
invert, 285
Reset, 280
Set, 278
VAR...END_VAR, 273

IL operation
addition, 286
Boolean AND, 281
Boolean exclusive OR, 284
Boolean OR, 282
call DFB, 300
call function block, 300
download, 277
jump to label, 297
multiplication, 288
save, 277
subtraction, 287
division, 289
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Import, 561
PLC Configuration, 597
Section, 568, 572, 583, 584, 585
Structured variables, 590
Variables, 587, 590, 594
general information, 563
PLC configuration, 596
section, 569, 580
variables, 588

Importing INTERBUS configuration, 810
Importing Profibus DP configuration, 784
INI file, 953

general, 954
LD section settings, 959
path for global DFBs, 957
path for help files, 957
print settings, 955
project name definition, 956
reading global DFBs, 957
register address format settings, 956
representation of internal data, 959
settings for online animation, 960
storage of global DFBs during upload, 
957
variable storage settings, 956

Initial step, 221
Insert

FFB, FBD, 176
FFB, LD, 205

Install loadables, 48
Installing the EXEC file, 949
Installing the Modbus Plus driver

Windows 98/2000/NT, 865
Installing the SA85

Modbus Plus Presettings, 860, 863
Windows 98/2000, 860
Windows NT, 863

Instruction
IL, 264, 265
ST, 337

Instruction list, 261
INTERBUS control

Quantum-configuration example, 763
INTERBUS control with Atrium, 805
INTERBUS controller, 764

Atrium configuration example, 804

INTERBUS export settings in CMD, 805
Interface settings in Windows 95/98/2000

Modbus Presettings, 874
Interface settings in Windows NT

Modbus Presettings, 876
Invocation

DFB, 302, 351
FFB, 302, 351, 354

Invoke
Project, 671

J
Jump

SFC, 228

K
Key combinations, 679, 691, 692, 693, 695, 
699, 705
key words

data type editor, 475
derived data type, 475

Keys, 679, 691, 692, 693, 695, 699, 705

L
Ladder Diagram, 187
Ladder Logic 984, 363
LD, 187

actual parameters, 201
animation, 210
Calling a macro, 444
Closer, 192
code generation, 209
Coil - negated, 194
Coil – negative edge, 195
Coil – positive edge, 194
Coil - reset, 195
Coil - set, 195
Coils, 193
Contacts, 192, 193
Data flow, 207
derived function block, 198
EFB, 196
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elementary function, 196
elementary function block, 197
EN, 200
ENO, 200
Execution sequence, 207
FFB, 196
function, 196
function block, 197
Icon bar, 686
link, 200
loops, 207
online functions, 210
Opener, 192
program creation, 213
Shortcut keys, 699
Text object, 203
UDEFB, 199
user-defined elementary function, 199
user-defined elementary function block, 
199

Learn monitoring times
SFC, 257

Libraries, 8
Limitations

LL984, 366
Link

PLC, 518
FBD, 172
LD, 200

List of Symbols, 679, 687, 688
List of Tools, 679, 687, 688
Literals, 34
LL984, 363

Close Column, 372
Combination mode, 387
Dialog interaction, 369
Direct programming, 387
DX Zoom, 374
Edit, 368, 371
Editing Networks, 373
Equation network, 378, 379
Equation network, Syntax and 
Semantics, 383
List of Symbols, 688

Momentum first startup, 893, 909, 929, 
946
Navigation, 368
Online Restriction, 369
Online Search, 375
Open Column, 372
Open Row, 372
Programming modes, 387
Reference Offset, 371
Reference Zoom, 373
References, 370
Replace References, 375
Requirements, 368
Section, 365
Segement, 365
Select, 372
Short Cut Keys, 705
Subroutines, 376
Trace, 375
Undo, 371
Variables, 370

LL984 processing
speed optimized, 535

LL984 section
Animation, 557

Load reference data, 497
Loadables, 78

CPU 424 02, 123
CPU X13 0X, 123
Atrium, 158
compact, 142
CPU 434 12, 131
CPU 534 14, 131

Loading, 548
Loading a project, 546

General information, 547
Loading firmware, 949
Local derived data type, 471
Local DFB, 394
Local macro, 429
Located variables

Changing signal states in RDE, 491
Lock

Section, 39
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Loop
FBD, 178
LD, 207

M
Macro, 425, 428

Calling up from SFC, 441
Calls from FBD, 444
Calls from LD, 444
Create, 435
Delete, 611
Documentation, 601
Exchange marking, 430
context sensitive help, 433
global, 429
local, 429
Convert, 837

Maximum supervision time, 221
MBX Driver

Driver for connection between 
ModConnect Host interface adapters and 
32 bit applications with Windows 98/
2000/NT, 867

Memory
Memory optimization for Compact CPUs, 
139
Memory Optimization for Quantum CPU 
X13 0X and 424 02, 114
Optimize, 107, 111
PLC-Independent Memory Optimization, 
111
Structure, 107
memory optimization for Momentum 
CPUs, 149
memory optimization for Quantum CPU 
434 12 and 534 14, 128
optimize, 110

Memory partitions, 47
Memory statistics, 544
Menu commands, 666
Minimum configuration, 47
Minimum supervision time, 222
MMS-Ethernet

specify coupling modules, 86

Modbus
Compact first startup, 884, 903
Momentum first startup, 888, 893, 906, 
909
Quantum first startup, 880, 900
Startup with DOS Loader, 899
Startup with the EXECLoader, 879

Modbus communication, 49
Modbus network link, 522
Modbus Plus

Atrium first startup, 922, 940
Compact first startup, 918, 937
Momentum first startup, 925, 929, 943, 
946
Quantum first startup, 914, 934
Remote MBX Driver, 868
Startup with DOS Loader, 933
Startup with the EXECLoader, 913
Virtual MBX Driver, 866

Modbus Plus Bridge, 528
Modbus Plus network link, 523
Modbus Plus network node, 87
Modbus Plus preferences

installing the Modbus Plus driver in 
Windows 98/2000/NT, 865

Modbus Plus Presettings
Installing the SA85, 860, 863
Establishing the hardware connection, 
871
Startup, 859

Modbus Presettings
Interface settings in Windows 98/2000, 
874
Interface Settings in Windows NT, 876
Transfer problems, 877
Establishing the hardware connection, 
876
Startup, 873

ModConnect, 841
MODIFIED, 519
Modifier

IL, 267
Modsoft

Convertion, 849
Function compatibility, 858
References, 855



Index

xi

Momentum - Ethernet Bus System, 833
Momentum - remote controller with local 
drop, 814
Momentum configuration example

Ethernet bus system, 821
remote I/O bus, 813

Momentum first startup
DOS Loader, 906, 909, 943, 946
EXECLoader, 888, 893, 925, 929
Modbus, 888, 893, 906, 909
Modbus Plus, 925, 929, 943, 946

N
Names

Datatype editor, 479
Derived datatype, 479

Navigation
LL984, 368

Network Configuration
TCP/IP, 823

Network link
Modbus, 522
Modbus Plus, 523
TCP/IP, 530

NOT EQUAL, 519

O
Objects

SFC, 220
insert, LD, 205

Offline functions in the configurator, 69
Online, 615, 617

SFC, 251
Online animation

INI file, 960
Online Control Panel, 536, 539

general information, 533
Online diagnostics, 558

Online functions, 14, 515
IL, 318
General information, 517
IL, 314, 315
ST, 359
FBD, 181
LD, 210
SFC, 252, 255

Online functions in the configurator, 69
Online help, 673
ONLINE Operation

Presettings, 521
Online Restriction

LL984, 369
Online Search

LL984, 375
Open

Project, 671
Open Column

LL984, 372
Open Row

LL984, 372
Opener

LD, 192
Operands

IL, 266
ST, 325

Operators
IL, 269, 276
ST, 329
ST, 326

Optimize
PLC Memory, 107, 111
PLC Memory Atrium CPUs, 155
PLC Memory Compact CPUs, 139
PLC Memory Momentum CPUs, 149
PLC Memory Quantum CPU X13 0X and 
424 02, 114
PLC-Independent Memory Optimization, 
111
PLC memory, 110
PLC memory Quantum CPU 434 12 and 
534 14, 128

Optional Configuration, 84
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P
Page breaks for sections, 605
Parallel branch, 233
Parallel connection, 234
Parameterize ASCII interface, 88
Parameterize interfaces

ASCII interface, 88
Modbus interface, 88

Parameterize Modbus interface, 88
Password Protection, 625, 626, 627, 634, 
635
Path for global DFBs

settings in the INI file, 957
Path for help files

settings in the INI file, 957
Peer Cop, 87

Quantum Configuration example, 791
Peer Cop communication, 50
Performance

hardware, 639
PLC family, 639

PLC
Simulating, 613
Status, 663

PLC Configuration, 46, 47, 63
Export, 597
Import, 597
export, 596
General information, 66
icons, 689
import, 596

PLC family
performance, 639

PLC Memory, 107, 110, 111
Atrium CPUs, 155
Compact CPUs, 139
Memory Optimization for Quantum CPU 
X13 0X and 424 02, 114
Momentum CPUs, 149
Optimize, 107, 111
PLC-Independent Memory Optimization, 
111
Structure, 107

memory optimization for Quantum CPU 
434 12 and 534 14, 128
optimize, 110

PLC memory mapping, 77
PLC selection, 72
PLC state, 531, 543
Position

FFB, FBD, 176
FFB, LD, 205

Precondition for unconditional configuration, 
72
Presettings for Modbus

Startup, 873
Presettings for Modbus Plus

Startup, 859
Presettings for ONLINE operation, 521
Print

settings in the INI file, 955
Printing sections, 605
Proceed in the following way with the 
configuration, 67
Process

Actions, 241
Step properties, 239
transition, 246

Processing
program, 30
project, 30

PROFIBUS
specify coupling modules, 86

Profibus DP controller, 778
Quantum configuration example, 777

Profibus DP export settings in SyCon
example 7, 778

Program
Create, 43
Status, 663
Structure, 29
processing, 30
structure, 30

Program creating
ST, 360
FBD, 184
LD, 213

Programming, 6
Programming languages, 9
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Programming modes
LL984, 387

Programs, 34
Project

Create, 43
Delete, 611
Documentation, 601
Invoke, 671
Open, 671
Protect, 635
Structure, 29
archive, 610
processing, 30
structure, 30

Project Browser, 459
Keyboard operation, 462
Mouse operation, 462

Project name definition
settings in the INI file, 956

Project symbol
Generate, 671

Projects
Convert, 837

Protect
DFB, 635
Project, 635

Q
Quantum - INTERBUS controller, 765
Quantum - Peer Cop, 792, 793, 795, 797
Quantum - Profibus DP controller, 780
Quantum - remote controller with DIO, 755, 
759
Quantum - remote controller with RIO, 736
Quantum - remote controller with RIO (series 
800), 744
Quantum - SY/MAX controller, 770
Quantum Configuration example

Peer Cop, 791
INTERBUS control, 763
Profibus DP controller, 777
remote control with DIO, 754
remote control with RIO, 735

Remote control with RIO (series 800), 
743
SY/MAX controller, 769

Quantum first startup
DOS Loader, 900, 934
EXECLoader, 880, 914
Modbus, 880, 900
Modbus Plus, 914, 934

Quantum Profibus DP controller, 784

R
RDE, 487

converting RDE templates, 489
Cyclical setting of variables, 492
general information, 488

RDE editor
toolbar, 690

Reactivate flash save, 539
Reading global DFBs

settings in the INI file, 957
Reference data editor, 487

Changing signal states of a Located 
variable, 491
Cyclical setting of variables, 492
Replacing variable names, 497
converting RDE templates, 489
general information, 488

Reference Offset
LL984, 371

Reference Zoom
LL984, 373

References
LL984, 370

Register address format
settings in the INI file, 956

Remote control with DIO
Quantum configuration example, 754

Remote control with RIO, 740
Quantum configuration example, 735

Remote control with RIO (series 800), 748, 
751

Quantum configuration example, 743
Remote controller with I/O bus (Momentum), 
814, 818
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Remote I/O bus
Momentum configuration example, 813

Remote MBX Driver
Modbus Plus, 868

Replace
coil, LD, 206
contact, LD, 206
FFB, FBD, 177
FFB, LD, 206

Replace References
LL984, 375

Replacing variable names
Reference data editor, 497

Requirements
LL984, 368

RTU extension
Compact configuration, 99
Configure, 99

S
Save To Flash, 536
Scan

constant, 533
Scan times

single, 534
Search and Replace

Variable names and addresses, 450
Searching and pasting

variable names and addresses, 454
Searching and pasting variable names and 
Addresses, 454
Section, 38

Animation, 555
Execution sequence, 38
Export, 564
Import, 568, 572, 583, 584, 585
import, 569
LL984, 365
Lock, 39
Status, 663
import, 580

Security, 625, 626, 627, 634, 635
Segement

LL984, 365
Segment manager, 80

Select
LL984, 372

Select process information
General information, 543
Status and memory, 542

Selecting process information
Status and memory, 542

Separators
data type editor, 480
derived data type, 480

Setting up and controlling the PLC, 532
Setup and control PLC

general information, 533
SFC

’SFCSTEP_STATE’ variable, 223
’SFCSTEP_TIMES’ variable, 222
Action, 223
Action variable, 224
Actions, 241
alternative branch, 230
Alternative connection, 232
animation, 252, 255
Calling up macros, 441
Edit, 236
edit, 235
Icon bar, 684
Identifier, 244
initial step, 221
Jump, 228
Learn monitoring times, 257
Link, 228
maximum supervision time, 221
minimum supervision time, 222
Objects, 220
Online, 251
online functions, 252, 255
Parallel branch, 233
Parallel connection, 234
Short Cut Keys, 695
Step, 221
step delay time, 221
step duration, 221
Step properties, 239
string, 255
Text object, 234
transition, 225, 246
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Transition diagnosis, 260
Transition section, 226
Transition variable, 227
waiting step, 221

Short Cut Keys, 679, 691, 692, 693, 695, 
699, 705
Simple sequences, 228
Simulate

SPS, 615, 617
Simulation, 613, 615, 617
Single sweeps, 534
Special options, 89
Specific data transfer, 797
Speed optimized LL984- Processing, 535
ST, 321

Assign instructions, 336
Block call up, 350
Code generation, 358
Expressions, 324
Instructions, 337
List of Symbols, 687
Online functions, 359
Operands, 325
Operators, 326, 329
Program creation, 360
Short Cut Keys, 693
syntax check, 357

ST Command
, 334, 334
&, 334
=, 333
AND, 334
Boolean AND, 334
Boolean OR, 335
Commands, 349
ELSE, 341
ELSIF...THEN, 342
Equal to, 333
Less than, 334
Less than or equal to, 334
Not equal to, 334
OR, 335
XOR, 335

ST command
-, 331, 333
(), 330
*, 331
**, 330
+, 332
>, 333
>=, 333
Addition, 332
Assignment, 337
Call function block, 351
CASE...OF...END_CASE, 343
Complement formation, 331
Declaration, 338
Division, 332
Empty instruction, 349
EXIT, 349
Exponentiation, 330
FOR...TO...BY...DO...END_FOR, 344
FUNCNAME, 330
function invocation, 354
Greater than, 333
Greater than/Equal to, 333
IF...THEN...END_IF, 340
MOD, 332
Modulo, 332
Multiplication, 331
Negation, 331
NOT, 331
REPEAT...UNTIL...END_REPEAT, 348
Subtraction, 333
Use of parentheses, 330
VAR...END_VAR, 338
WHILE...DO...END_WHILE, 346

ST commandl
/, 332

Start behavior
variable, 35

Startup
Presettings for Modbus, 873
Presettings for Modbus Plus, 859

Startup with DOS Loader
Modbus, 899
Modbus Plus, 933
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Startup with the EXECLoader
Modbus, 879
Modbus Plus, 913

State of the PLC, 531
Status, 519
Status bar, 663
ST-Command

Boolean Exclusive OR, 335
Step, 221

alias designations, 248
Step delay time, 221
Step duration, 221
Step properties

Process, 239
Storage of global DFBs during upload

settings in the INI file, 957
String

control, 255
Structure

PLC Memory, 107
Program, 29
Project, 29, 30
program, 30

Structured text, 321
Structured variables

Import, 590
Subroutines

LL984, 376
SY/MAX Controller, 774

Quantum configuration example, 769
Symax-Ethernet

specify coupling modules, 86
Symbols, 679, 687, 688
Syntax

Data type editor, 473
Derived Data Type, 473

Syntax check
IL, 311
ST, 357

T
Tag

IL, 272
TCP/IP

Network Configuration, 823
TCP/IP network link, 530
TCP/IP-Ethernet

specify coupling modules, 86
Text Object

FBD, 174
LD, 203
SFC, 234

Tool bar, 681, 682, 683, 684, 686, 690
Tools, 15
Trace

LL984, 375
Transfer problems

Modbus Presettings, 877
Transition, 225

alias designations, 248
declare, 246
process, 246

Transition diagnosis, 260
Transition section, 226
Transition variable, 227

U
UDEFB

FBD, 172
LD, 199

Unconditional Configuration, 71
precondition, 72

Unconditional locking of a section, 494
Undo

LL984, 371
Uploading the PLC, 551
User-defined Elementary Function

FBD, 172
LD, 199

Utilities, 15
Utility program, 15
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V
Variable

Export, 567
start behavior, 35

Variable Editor
Declaration, 448
Exporting located variables, 457
Search and Replace, 450
searching and pasting, 454

Variable storage
settings in the INI file, 956

Variables, 34
ASCII message editor, 504
Import, 587, 590, 594
LL984, 370
import, 588

Variables editor, 447
General, 448

VARINOUT variables, 397
Various PLC settings, 52
Virtual MBX Driver

Modbus Plus, 866

W
Waiting step, 221
Warm start, 35
Window, 661
Window elements, 663
Window types, 662
Windows, 659

Check box, 670
Command buttons, 669
Dialog boxes, 668
Lists, 669
Menu commands, 666
Option buttons, 669
Status bar, 663
Text boxes, 669
Window, 661
Window elements, 663

Windows
window types, 662
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